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Important notices

IMPORTANT NOTICES

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt vibro-meter® (Meggitt SA) are based on information believed to be reliable, but unless otherwise 

expressly agreed in writing with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before 
using this product, you must evaluate it and determine if it is suitable for your intended application. You should also 

check our website at www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product 
drawings, user manuals, service bulletins and/or other instructions affecting the product.

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA.

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA.
Meggitt SA reserves the right to alter any part of this publication without prior notice.

EXPORT CONTROL

The information contained in this document may be subject to export control regulations of the European 
Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or 
use of any information contained in this document complies with all relevant export control regulations. ECN N/A.

COPYRIGHT

Copyright© 2000-2021 Meggitt SA.

All rights reserved.

Published and printed by Meggitt SA in Fribourg, Switzerland.

The names of actual companies and products mentioned 
herein may be the trademarks of their respective owners.

The information contained in this document is subject to change without notice. 
This information shall not be used, duplicated or disclosed, in whole or in part, 
without the express written permission of Meggitt SA (Meggitt vibro-meter®).

http://www.meggittsensing.com/energy
http://www.meggittsensing.com/energy
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PREFACE

About this manual

This manual relates to the VM600 MPS1 configuration software, from Meggitt’s vibro-meter®

product line. It explains how to install and begin using the software, and provides instructions
on configuring the system.

NOTE: This document should be read in conjunction with the following Meggitt
vibro-meter® manuals:
• VM600 machinery protection system (MPS) hardware manual.
• VM600 networking manual.

For information on the VM600 MPS2 configuration software, refer to the VM600 MPS2
configuration software for VM600 machinery protection systems (MPSs) software manual.
The VM600 MPSx software (that is, MPS1 and MPS2) includes context-sensitive offline help.
This means that the help is installed locally on the computer (when the software is installed)
and that the text that appears depends on which part of the software is being displayed at the
time.

About Meggitt and vibro-meter®

Meggitt PLC is a global engineering group, headquartered in the UK, specialising in the
design and manufacture of high-performance components and systems for aerospace and
energy markets.
The Meggitt facility in Fribourg, Switzerland, operates as the legal entity Meggitt SA (formerly
Vibro-Meter SA). vibro-meter® is a product line of Meggitt that applies our core sensing and
monitoring technologies to power generation, oil & gas and other industrial markets.
Meggitt SA produces a wide range of vibration, dynamic pressure, proximity, air-gap and
other sensors capable of operation in extreme environments, electronic monitoring and
protection systems, and innovative software for aerospace and land-based turbomachinery.

vibro-meter® products and solutions have been at the forefront of sensing and monitoring for
more than 65 years and help keep machinery and equipment working safely, reliably and
efficiently. This includes the VM600 MPS1 configuration software for VM600 machinery
protection systems (MPSs), produced for the Meggitt vibro-meter® product line.

To learn more about Meggitt Switzerland, our proud tradition of innovation and excellence,
and our solutions for energy markets and applications, visit the Meggitt vibro-meter® website
at www.meggittsensing.com/energy

Who should use this manual?
This manual is intended for operators of machinery protection systems using the VM600
MPS1 software.

http://www.meggittsensing.com/energy
http://www.meggittsensing.com/energy
http://www.meggittsensing.com/energy
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Applicability of this manual

NOTE: This manual applies to version 2.7.xxx of the VM600 MPS1 software. It reflects the
features available with version 2.7.xxx and may not be applicable to earlier or later
versions of the software.

Terminology

NOTE: The MPC4 machinery protection card is available in different versions, including a
standard version, a separate circuits version and a safety (SIL) version.

The MPC4 SIL (safety MPC4 card) was developed to permit a wider range of installation
options with a single VM600 rack, for example, condition monitoring in addition to machinery
protection. Accordingly, the MPC4 SIL does not have a VME bus interface and can only be
configured via a direct connection to the RS-232 connector on its front panel (even for a
“networked” VM600 rack), in order to reduce the possibility of corruption of its configuration.
In addition, the MPC4 SIL does not provide all of the signal processing capabilities of the
standard and the separate circuits versions of the MPC4. Refer to the VM600 MPC4
machinery protection card data sheet and VM600 machinery protection system (MPS)
hardware manual for further information.

NOTE: Previously, the VM600 MPSx software referred to all versions of the MPC4 card as
MPC4. Starting with VM600 MPSx software version 2.6, the VM600 MPSx
software makes a distinction between different versions of the MPC4 card by
referring to both the standard version and the separate circuits version of the
MPC4 card as an MPC4 and referring to the safety version of the MPC4 card as
an MPC4 SIL.

For example, when adding an MPC4 card to a VM600 rack configuration, the user must select
either:
• MPC4 – to add a standard or a separate circuits MPC4 card.
• MPC4 SIL – to add a safety MPC4 card.
This distinction continues throughout the VM600 MPSx software, where MPC4 cards are
listed as either MPC4 or MPC4 SIL.
In general, MPC4 is used in this manual to refer to all versions of the card. However, where
it is necessary to make a distinction, MPC4 is used to indicate both the standard and separate
circuits versions of the card and MPC4 SIL is used to indicate the safety version.

Related publications and documentation
For further information on the use of a VM600 machinery protection system (MPS), refer to
the following Meggitt vibro-meter® documentation:
• VM600 machinery protection system (MPS) hardware manual

(document reference MAMPS-HW/E).
• VM600 MPS2 configuration software for VM600 machinery protection systems (MPSs)

software manual (document reference MAMPS2-SW/E).
• VM600 MPC4 machinery protection card data sheet

(document reference 268-021).
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• VM600 AMC8 analog monitoring card data sheet
(document reference 268-041).

Operators of networked VM600 MPSs should also refer to the following document:
• VM600 networking manual

(document reference MAVM600-NET/E).
Operators of safety-related systems (SRSs) should also refer to the following document:
• VM600 safety manual

(document reference MAVM600-FS/E).

NOTE: To ensure that the latest version of documentation is being used, visit the Meggitt
vibro-meter® Energy website at www.meggittsensing.com/energy and check for
any updates. Alternatively, contact your local Meggitt representative.

Release notes
Before using the MPS1 software, read the Release Notes provided with the MPS1 Software
Installation Kit. The release notes are contained in a file called ReleaseNotes.pdf on the
CD. The Release Notes contain information on:
• New features of the latest version
• Resolved problems, known issues and bug fixes
• Compatibility with earlier software versions.

http://www.meggittsensing.com/energy
http://www.meggittsensing.com/energy
http://www.meggittsensing.com/energy
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SAFETY

Symbols and styles used in this manual
The following symbols are used in this manual where appropriate:

NOTE: This is an example of the NOTE paragraph style. This draws the operator’s
attention to complementary information or advice relating to the subject being
treated.

The WARNING safety symbol
THIS INTRODUCES DIRECTIVES, PROCEDURES OR PRECAUTIONARY MEASURES WHICH
MUST BE EXECUTED OR FOLLOWED. FAILURE TO OBEY A WARNING CAN RESULT IN
INJURY TO THE OPERATOR OR THIRD PARTIES.

The CAUTION safety symbol
This draws the operator's attention to information, directives or procedures
which must be executed or followed. Failure to obey a caution can result in
damage to equipment.
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1 INTRODUCTION

1.1 What is MPS1?
MPS1 is a configuration software package for VM600 machinery protection systems, from
Meggitt’s vibro-meter® product line.

1.2 Offline help
The VM600 MPSx software (MPS1) includes offline help that is installed locally on the
computer. This help provides text that relate to windows within the software. You can obtain
a help topic window by clicking the Help button on the splash screen, as shown in Figure 1-1,
or by pressing the F1 key at any time while using the software.

Choose the Show Index button on the Help Topic window to obtain a list of topics (the Help
Index window appears).
You can also access the Help Index window by choosing Contents from the Help drop-down
menu, as shown in Figure 1-2.

1.3 Tool tips
The software also includes tool tips which help the user when entering values in some fields.
If the user enters an invalid value in a field, a tool tip appears giving the range of accepted
values.

1.4 Basic operating principle of the MPC4 card
The MPC4 card can simultaneously process signals connected to the following input
channels:
• Two speed (tachometer or tacho) inputs

The user can configure Alert+ and Alert– thresholds for these inputs.
• Four measurement inputs (for measuring vibration, dynamic pressure and so on)

The user can configure Danger+, Alert+, Alert– and Danger– thresholds for these inputs.

Figure 1-1: Help button on the splash screen

Figure 1-2: Help drop-down menu
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As well as the input channels, the MPC4 also contains “processing channels” (see
Figure 1-3):
• There are four single processing channels labelled Channel 1, Channel 2, Channel 3,

and Channel 4, each providing two outputs labelled Output 1 and Output 2.
• There are two dual processing channels labelled Channels 1&2 and Channels 3&4, each

providing one output.

The flexibility of the VM600 MPS allows any measurement channel to be routed to any
processing channel(s), that is, any signal routing combination is possible. However, it is
recommended that the signals are routed as shown in Table 1-1.

Figure 1-3: Schematic showing the basic operating principles of the MPC4 card
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NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information.

1.5 Basic operating principle of the AMC8 card
The AMC8 card can simultaneously process signals connected to eight input channels.
These can be used for:
• Measuring temperature with a thermocouple (TC) or resistance temperature detector

(RTD) device.
• Measuring any other parameter (for example, flow rate, static pressure) from a system

that provides a current-based (4 to 20 mA) or voltage-based (0 to 10 V) output.
Each of those eight input channels is routed to its corresponding “processing channel” (see
Figure 1-4) These eight “single channels” are labelled Channel 1 to Channel 8 and each has
a single output.
The software allows four additional “multi-channels” to be configured. These perform
arithmetic operations on measurements made by any of the single processing channels.
These channels are labelled Multi-Channel 1 to Multi-Channel 4 and each has a single
output.
The user can configure Danger+, Alert+, Alert– and Danger– thresholds for any of the single
channels or “multi-channels”.
Unlike the MPC4 card, the AMC8 card does not support flexible routing:
• Measurement Channel 1 is routed directly to Processing Channel 1
• Measurement Channel 2 is routed directly to Processing Channel 2
• And so on. 
The only exception is that the software allows a “cold junction” temperature signal to be
routed to another channel on the card. 

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information.

Table 1-1: Recommended MPC4 card measurement channel and processing channel 
signal routing

 Measurement
channel

Processing
channel

1 1

2 2

3 3

4 4
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Repeated for 
Meas.
Channels 3 to 7

Figure 1-4: Schematic showing the basic operating principles of the AMC8 card
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2 OVERVIEW OF SYSTEM CONFIGURATION

2.1 Introduction
This section provides an overview of the steps needed to set up a VM600 machinery
protection system using the VM600 MPS1 software. Further information can be obtained
from the detailed descriptions later in this manual.

2.2 VM600 MPS configuration 
Before configuring individual cards, the user must first define the overall structure of the
machinery protection system. This provides an outline of the system (“skeleton”) to work on.
The VM600 MPS1 software uses the following configuration tree structure and hierarchy:

- Database 1

- Rack 1

- Card 1

- Card 2

- . . . .

- Card q

- Rack 2

- Card 1

- Card 2

- . . . . 

- Card r

- . . . .

- Rack m

- Database 2

- Rack 1

- Rack 2

- . . . .

- Rack p

. . . .

- Database n

The number of databases employed for the entire site must be evaluated and then these
databases must be created. The VM600 racks used in the protection system must then be
attributed to a particular database. Finally, the cards (MPC4, MPC4 SIL and/or AMC8) used
in each rack must be defined, along with the rack slot (position) that they occupy.
Once this has been done, a tree structure is available on the main window of the VM600
MPS1 Configuration Editor (VM600 MPSx software) to allow the configuration of individual
cards. The branches of the tree, with their various nodes, are shown for the MPC4 card in
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Figure 2-1, for the MPC4 SIL card in Figure 2-2 and for the AMC8 card in Figure 2-3. See
5 Creating the configuration tree for further information.

Figure 2-1: Branches of the tree structure for configuring an MPC4 card
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Figure 2-2: Branches of the tree structure for configuring an MPC4 SIL card
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Figure 2-3: Branches of the tree structure for configuring an AMC8 card
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As shown in Figure 2-3, Figure 2-1 and Figure 2-2, the image of the card displayed in the
VM600 MPS1 Configuration Editor main window (card overview page) of the VM600 MPSx
software corresponds to the type of card (MPC4, MPC4 SIL card or AMC8) in the tree
structure. The image is different for MPC4 and MPC4 SIL cards.

2.3 Configuring individual cards
Once the overall structure (“skeleton”) of the machinery protection system has been created,
the installation of the protection system can be completed by configuring each individual card
(MPC4, MPC4 SIL and/or AMC8) according to the procedures below.

2.3.1 Configuring MPC4 and MPC4 SIL cards

NOTE: The MPC4 machinery protection card is available in different versions, including
standard and separate circuits versions that are both referred to as MPC4 in the
VM600 MPSx software, and a safety (SIL) version that is referred to as MPC4 SIL
in the VM600 MPSx software.

1- Configure the input channels.
This operation is done from the Inputs branch of the tree structure (see Figure 2-1,
Figure 2-2 and Figure 2-3). This allows parameters concerning the measurement
sensors and speed sensors to be configured. These parameters include the sensor type
and tag, the sensitivity, the dynamic range and the required power supply.
See 7 Input configuration (MPC4 and MPC4 SIL) for further information.

2- Define the type of processing to be performed on each channel.
This operation is done from the Processing branch of the tree structure. This allows each
processing channel to be assigned to specific input sensors (providing signals
representing, for example, vibration, dynamic pressure and speed).
All aspects of the signal processing are defined here, including the processing function
(for example, Broad Band Absolute Bearing Vibration or Relative Shaft Vibration),
filtering characteristics and measurement units.
Sub-windows allow alarm levels to be configured for each channel. Configurable
parameters include hysteresis, delay time and latching.
See 8 Processing configuration (MPC4 and MPC4 SIL) for further information.

3- Define logical combinations of individual alarms.
This operation is optional. If required, it is done from the Alarms Logical Combination
branch of the tree structure.
See 9 Defining logical combinations of alarms (MPC4 and MPC4 SIL) for further
information.

4- Configure the output mapping parameters (attribution of relays and so on).
This operation is done from the Output Mapping branch of the tree structure.
The Discrete Outputs sub-branch allows global and individual alarms (generated by a
speed input, a signal level or a hardware or software error) to be attributed to specific
relays on the IOC and RLC cards. 
The DC Outputs sub-branch allows DC outputs on the IOC card to be configured.
See 10 Output mapping (MPC4 and MPC4 SIL) for further information.
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5- Download the configuration to the MPC4 card.
This operation is done from the Communications drop-down menu of the main window
(VM600 MPS1 Configuration Editor).
This menu allows a configuration to be sent to a specific MPC4 card, or to the whole rack,
via a network connection.
Once the protection system is running, information on measured signal levels and alarms
for each channel, as well as the hardware and software status, may also be read using
this menu.
Several windows may be opened at the same time to obtain information from several
MPC4 cards simultaneously.

6- Save the configuration to disk for future use.
This operation is done from the File drop-down menu of the main window (VM600 MPS1
Configuration Editor).

In addition, see 6 Main window menus and commands, 6.3.3 Sending a configuration to a
VM600 rack or card and 11 Communications menu (MPC4 and MPC4 SIL) for further
information.

2.3.1.1 Safety (SIL) version of the MPC4

NOTE: The MPC4 machinery protection card is available in different versions, including a
standard version, a separate circuits version and a safety (SIL) version.
The MPC4 SIL (safety MPC4 card) does not have a VME bus interface and does
not provide all of the signal processing capabilities of the standard and the
separate circuits versions of the MPC4.
Refer to the VM600 MPC4 machinery protection card data sheet and
VM600 machinery protection system (MPS) hardware manual for further
information.

NOTE: Starting with VM600 MPSx software version 2.6, the VM600 MPSx software makes
a distinction between safety MPC4 cards and other MPC4 cards by referring to the
standard version and the separate circuits version of the MPC4 card as an MPC4
and referring to the safety version of the MPC4 card as an MPC4 SIL.

Starting with VM600 MPSx software version 2.6, when an MPC4 card is being configured,
the MPS1 and MPS2 software will automatically:
• Communicate with the MPC4 card in order to identify its version: ‘standard’ or ‘separate

circuits’ (MPC4), or ‘safety’ (MPC4 SIL).
• Check the configuration in the VM600 MPSx software in order to ensure that it is

compatible with the version of MPC4 card detected (MPC4 or MPC4 SIL):
• If the configuration is compatible with the MPC4 card, then the VM600 MPS software

will download the configuration to the card.
That is, the software will send an MPC4 card configuration to an MPC4 card and it
will send an MPC4 SIL card configuration to an MPC4 SIL card.

• If the configuration is not compatible with the MPC4 card, then the VM600 MPS
software displays a message informing the user of the incompatibility and will not
download the configuration to the card.
That is, the software will not send an MPC4 card configuration to an MPC4 SIL card
and it will not send an MPC4 SIL card configuration to an MPC4 card.
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For example, in this way, a ‘safety’ MPC4 card cannot be configured with Narrow Band
(Tracking) Vibration or other non-supported processing functions.

2.3.2 Configuring AMC8 cards
1- Configure the input channels, define the processing functions and set up alarm levels

These operations are done from the Inputs/Processing branch of the tree structure (see
Figure 2-3). Various tabs can be called up.
One tab allows input parameters concerning the measurement sensors to be
configured/defined (for example, sensor type and tag, sensor output characteristics and
OK Level thresholds).
Other tabs allow various processing functions and alarm levels to be configured for each
channel. Configurable parameters include hysteresis, delay time and latching.
The four “multi-channels” can also be defined from the Inputs/Processing branch of the
tree structure, if required.
See 12 Configuring inputs and processing functions (AMC8) for further information.

2- Define logical combinations of individual alarms.
This operation is optional. If required, it is done from the Alarms Logical Combination
branch of the tree structure.
See 13 Defining logical combinations of alarms (AMC8) for further information.

3- Configure the output mapping parameters (attribution of relays and so on).
This operation is done from the Output Mapping branch of the tree structure.
The Discrete Outputs sub-branch allows global and individual alarms (generated by a
signal level or a hardware or software error) to be attributed to specific relays on the IOC
and RLC cards. 
The DC Outputs sub-branch allows DC outputs on the IOC card to be configured.
See 14 Output mapping (AMC8) for further information.

4- Download the configuration to the AMC8 card.
This operation is done from the Communications drop-down menu of the main window
(VM600 MPS1 Configuration Editor).
This menu allows a configuration to be sent to a specific AMC8 card, or to the whole rack,
via a network connection.
Once the protection system is running, information on measured signal levels and alarms
for each channel, as well as the hardware and software status, may also be read using
this menu. Several windows may be opened at the same time to obtain information from
several AMC8 cards simultaneously.

5- Save the configuration to disk for future use.
This operation is done from the File drop-down menu of the main window (VM600 MPS1
Configuration Editor).

In addition, see 6 Main window menus and commands, 6.3.3 Sending a configuration to a
VM600 rack or card and 15 Communications menu (AMC8) for further information.
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2.4 Configuring the rack
Once all cards (MPC4, MPC4 SIL and/or AMC8) have been configured, it is usually
necessary to perform additional configuration at rack level. This is to ensure that signals are
properly routed over the buses on the rack backplane and that signal conflicts are avoided.
See 16 Configuration windows at rack level for further information.
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3 INSTALLING THE SOFTWARE

3.1 Before starting

3.1.1 Items delivered
For first-time installation, you should have received the following items:
• One CD containing:

• VM600 MPS1 configuration software
• An electronic version of the software manual (*.pdf file):

VM600 MPS1 configuration software for VM600 machinery protection
system (MPSs) (document reference MAMPS1-SW/E).

• Release and installation notes (*.pdf file).
• One paper copy of the software manual:

VM600 MPS1 configuration software for VM600 machinery protection systems (MPSs)
(document reference MAMPS1-SW/E).

• One RS-232 communication cable.
For a software update, you receive only the following item:
• One CD containing:

• VM600 MPS1 configuration software
• An electronic version of the software manual (*.pdf file):

VM600 MPS1 configuration software for VM600 machinery protection
system (MPSs) (document reference MAMPS1-SW/E)

• Release and installation notes (*.pdf file).

NOTE: All original CDs should be stored in a safe place once the software installation has
been performed.

3.1.2 System requirements
The VM600 MPS1 software may be installed on most modern personal computers or laptops.
The following minimum computer configuration is required to run the software:

• Microsoft® Windows® Server 2003, Windows NT, Windows 2000, Windows XP,
Windows Vista, Windows 7 or Windows 10 operating system

• 200 MHz 32-bit (x86) processor or equivalent
• 32 MB system memory (RAM)
• At least 200 MB of hard disk space
• 16-colour VGA display
• One 9-pin serial port (RS-232)
• Ethernet or Fast Ethernet network card (TCP/IP)
• CD/DVD drive
• Optional 100 GB (or larger) backup media.
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3.2 Installation procedure

NOTE: Save your work and exit (close) all applications before beginning the installation.

The procedure below is valid for first-time installation of the VM600 MPSx software as well
as for subsequent installation of software releases.

NOTE: It is essential that you remove any previous versions of the software before
installing the new version. See 3.3 Removing an old version of the software.
Removing a previous version of the software does not remove any user-defined
databases.

1- Insert the CD containing the VM600 MPS1 software in the CD/DVD drive of your
computer.
The installation process should start automatically. If this is the case, the VM600 MPS1
InstallShield Wizard starts (the initial window of which is shown in Figure 3-1). Go to
step 5.
If the process does not start automatically, go to step 2.

2- Choose Start > Run from the Windows task bar.
3- Use the Browse function to find the executable file setup.exe in the root directory of

the CD.
4- Double-click the setup.exe file to start the VM600 MPS1 InstallShield Wizard (see

Figure 3-1).

5- Follow the instructions given by the wizard to install the software.
As part of the installation process, the wizard displays a Customer Information window
that, among other information, asks you to enter the Serial Number of your software.

Figure 3-1: Welcome window of the VM600 MPS1 InstallShield Wizard
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If you accept the default Serial Number (BASIC MPS), the VM600 MPSx software licence
is not validated and a demonstration version of the software will be installed (see
Figure 3-2). This may consist of a limited set of features.

The CD Key, which is found on the back of the product CD case, must be entered as the
Serial Number (see Figure 3-3). This is necessary to validate the VM600 MPSx software
licence.

Figure 3-2: Customer Information window showing the default Serial Number

Figure 3-3: Customer Information window showing an example valid Serial Number 
(CD Key)
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6- Define the location where the software is to be installed on the hard disk. The following
default destination folder is proposed:

C:\Program Files\VM600_MPS

An alternative folder can be chosen if desired.

NOTE: The default location for the Windows Program Files folder depends on the
operating system installed on the computer:
C:\Program Files on 32-bit versions of Windows, but
C:\Program Files (x86) on 64-bit versions of Windows.

A VM600 MPS1 icon  (shortcut) appears on the Windows desktop when the installation
is complete.

3.3 Removing an old version of the software

NOTE: Save your work and exit (close) all applications before removing an old version of
the software.

3.3.1 Precautions concerning databases 

NOTE: Removing a previous version of the software does not remove any user-defined
databases. 
However, as an extra precaution, it is recommended to make a backup copy of
your database(s) before removing any software.
This copy can later be removed after checking that the software upgrade has been
performed correctly.

Data is stored in database directories having a .db file name extension. Unless an alternative
destination folder was chosen, these directories are found in the following default folder:

C:\Program Files\VM600_MPS

NOTE: The default location for the Windows Program Files folder depends on the
operating system installed on the computer:
C:\Program Files on 32-bit versions of Windows, but
C:\Program Files (x86) on 64-bit versions of Windows.

You should make a (temporary) copy of these database directories elsewhere on your
computer. Do not put them under C:\Program Files\VM600_MPS.

3.3.2 Removing the software
Use the procedure below to remove an old version of the software before installing a newer
version:
1- Choose Add or Remove Programs from the Windows Control Panel.
2- Select Change or Remove Programs.
3- Highlight the application (VM600 MPS software) and click the Remove button.
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4 GETTING STARTED

4.1 Starting the VM600 MPS1 software
To start the VM600 MPS1 software:

1- Double-click the MPS1 icon  on your desktop.
This icon was created during the installation of the software. If for some reason it does
not appear on the desktop, click Start > Programs > VM600 MPS Software > MPS1, or
navigate to the VM600_MPS\Bin directory on the computer’s hard disk and double-click
the mps1.exe file.
The VM600 MPS1 splash screen (window) appears, as shown in Figure 4-1. 

2- Choose the working language from the drop-down menu in the top, left-hand corner of
the window, as shown in Figure 4-2. The selected language is used by default the next
time the VM600 MPS1 software is started. 

Figure 4-1: VM600 MPS1 splash screen

Figure 4-2: Language drop-down menu
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3- Click the Begin button, which is found below the Language menu. 
4- The first time that the VM600 MPSx software is run, a following dialog box similar to the

following appears:

Click Yes to launch the Database Maintenance Tool (see 6.2.3 Using the Database
Manager for details). Otherwise, click No to continue.

5- The main VM600 MPS1 Configuration Editor window appears, as shown in Figure 4-4. 

4.2 VM600 MPSx software privilege levels
As shown in Figure 4-5, the VM600 MPSx software implements a system of privileges (user
access rights) to control and limit the functionality of the software available to different levels
of user.
The VM600 MPSx software has four levels of privilege: Read, User, Master and Super. The
User, Master and Super levels are password protected in order to help prevent accidental
changes or unauthorised access to the configuration of a VM600 MPS.

NOTE: The passwords for the VM600 MPSx software privilege levels are stored on the
computer running the VM600 MPSx software.

In addition to the VM600 MPSx software’s system of privileges, a VM600 MPS containing a
CPUM card can implement additional rack security features (see 4.3 VM600 MPS rack
(CPUM) security).

Figure 4-3: Database Maintenance Tool prompt

Figure 4-4: Main window of the VM600 MPS1 Configuration Editor
(VM600 MPSx software)



Document reference MAMPS1-SW/E SOFTWARE MANUAL
Edition 12 - February 2021 VM600 MPS1 software

4 - 3

VM600 MPSx software privilege levels
GETTING STARTED

4.2.1 Selecting the privilege level
The VM600 MPSx software has four levels of privileges:
1- Read

This read-only level provides the lowest level of privileges and the highest level of
protection. It is the default level granted when the VM600 MPSx software is started and
no password is required for access.
With Read-level privileges, configuration information can be read but it cannot be
changed. This information includes outputs, system status, system identification and
status latch data.

2- User 
This provides more privileges than the Read level. In addition to the information available
at the Read-level, files can be uploaded to a VM600 rack.

3- Master 
This provides more privileges than the User level. In addition to the information and
operations available at the User level, alarm levels and attributes can be changed.

4- Super 
This provides the highest level of privileges (that is, full access rights) and the lowest
level of protection.
With Super-level privileges, the current configuration can be modified and any changes
can be saved.

NOTE: At Read, User and Master levels, certain menu commands are unavailable (greyed
out) and therefore cannot be run.

User, Master and Super levels can be protected with passwords. See 4.2.2 Changing
privilege-level passwords and 4.2.3 Defining privilege-level passwords during the initial
installation for further information. 
The Privileges drop-down menu at the top of the main VM600 MPSx Configuration Editor
window (see Figure 4-6) is used to select the desired privilege level. Enter the appropriate
password in the dialog box that appears (see Figure 4-7, which shows an example for the
Master level).

Figure 4-5: VM600 MPSx software privilege levels

VM600 MPSx software 
privilege levels

VM600 MPS
configuration
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NOTE: All passwords are case-sensitive. For example, “user”, “User” and “USER” are
treated as three different passwords.

The current privilege level is displayed at the bottom of the VM600 MPS1 Configuration Editor
window, as shown in Figure 4-8.

NOTE: At User, Master and Super levels, the VM600 MPSx software reverts to Read level
if you do not touch the keyboard or mouse for a period of 30 minutes.

4.2.2 Changing privilege-level passwords

NOTE: Super-level privileges are required in order to be able to change passwords.

To change a privilege-level password:
1- Select Modify Passwords from the Privileges drop-down menu.
2- Enter the existing Super level password in the dialog box (similar to Figure 4-7).

Figure 4-6: Privileges drop-down menu

Figure 4-7: Dialog box to enter the Master password

Figure 4-8: Privilege level displayed a the bottom of the
VM600 MPSx Configuration Editor main window

Current privilege level
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The Modify Passwords dialog box appears (see Figure 4-9). This allows passwords for
User, Master and Super levels to be modified.

3- Type in the new password and type it in again in the Confirm field below. 

NOTE: All passwords are case-sensitive. For example, “user”, “User” and “USER” are
treated as three different passwords.

4.2.3 Defining privilege-level passwords during the initial installation
When the VM600 MPSx software is initially installed, the Super, Master and User passwords
are super, master and user, respectively (all lower-case characters). The system
administrator should redefine all three privilege-level passwords during the initial installation
of the software, using the following procedure:
1- Choose Super from the Privileges drop-down menu.

A dialog box asking for the Super password appears.
2- Type “super” (this is the default Super level password)
3- Choose Modify Passwords from the Privileges drop-down menu.

The dialog box asking for the Super password appears again.
4- Type in “super” again

The Modify Passwords dialog box appears (see Figure 4-9).
5- Type in a new Super level password, first in the New Password field and then in the

Confirm field below.
6- Type in a new Master level password, first in the New Password field and then in the

Confirm field below.
7- Type in a new User level password, first in the New Password field and then in the

Confirm field below.
8- Click the OK button to validate the new passwords.

Figure 4-9: Modify Passwords dialog box



SOFTWARE MANUAL Document reference MAMPS1-SW/E
VM600 MPS1 software Edition 12 - February 2021
4 - 6

VM600 MPS rack (CPUM) security
GETTING STARTED

4.3 VM600 MPS rack (CPUM) security
As shown in Figure 4-10, a VM600 MPS in a 19″ system rack (ABE04x) containing a CPUM
card can implement specific rack security features in order to limit the functionality of the MPS
that are available via the CPUM to Ethernet-based connections, such as the VM600 MPSx
software, the CPUM Configurator software or a Modbus TCP connection.

NOTE: See 4.4 CPUM Configurator software for further information on the
CPUM Configurator software.

The use of the CPUM security features is recommended in order to help prevent accidental
or unauthorised access to a VM600 MPS configuration and other MPS system functionality,
thereby reducing the possibility of interference in the operation of the MPS and the machinery
being monitored.

NOTE: VM600 MPSx software version 2.7 or later and a networked VM600 rack
containing a CPUM card running firmware version 077 or later are required in order
to use VM600 MPS rack (CPUM) security.

By default, the CPUM security features are disabled in order to ensure backwards
compatibility with CPUM cards running firmware version 076 or earlier.

NOTE: The passwords and settings for CPUM security are stored on the CPUM card.

The VM600 MPS rack (CPUM) security features are in addition to the VM600 MPSx
software’s system of privileges (see 4.2 VM600 MPSx software privilege levels).
For example, in a typical machinery monitoring application in a modern power-generating
station, the VM600 MPS is installed close to the machinery being monitored, which is
installed in the highest-security zone of the plant. Such security zones are usually restricted
and protected areas with physical barriers, specific access requirements and surveillance
equipment. Accordingly, only approved and cleared personnel have the physical access to a

Figure 4-10: VM600 MPS rack (CPUM) security

VM600 MPSx software 
privilege levels

CPUM access

CPUM password
validation

VM600 MPS
configuration
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VM600 MPS in a power station that is required in order to change the CPUM access setting
(CPUM access lock), one of the new CPUM security features.
The CPUM access lock prevents remote access to a VM600 MPS, effectively acting as a
hardware lock, and it is not possible to “unlock” a CPUM/VM600 remotely.

NOTE: As the CPUM access setting for a CPUM card is configured using the keys on the
front panel of the card, physical access to the CPUM card (VM600 rack) is
required.

4.3.1 Using CPUM security
VM600 MPS rack (CPUM) security consists of two levels of protection integrated in the
CPUM card: CPUM access lock and MPS password validation.
CPUM Access Lock is a CPUM access setting that can be thought of as a “hardware”
security feature that limits Ethernet-based connections to a VM600 MPS to “read only”
operations.
• When CPUM access is blocked, the MPS operations that are available are limited to read

only operations. That is, communications with the VM600 rack via Ethernet is read only,
such that it is possible to read outputs from the MPS but it is not possible to change
(commit) the configuration of a VM600 rack or to interfere in the operation of the MPS.

• When CPUM access is allowed, the MPS operations that are available depend on the
MPS password validation (see MPS Password Validation).

Physical access to the VM600 rack is required in order to change the CPUM Access Lock.

MPS Password Validation can be thought of as a “software” security feature that limits
Ethernet-based connections to a VM600 MPS to “read only” operations plus a permitted
subset of “write” operations.
• When MPS password validation is enabled, the MPS operations that are available are

limited to read only operations and certain specific write operations (“read + restricted
write”), that is, write operations which require additional authentication before being run.
For example, VM600 MPS commands such as alarm reset (AR) or changing a fieldbus
configuration. While the read only operations run as usual, the write operations require
that the correct CPUM password is entered by the user before they are run.

• When MPS password validation is disabled, all VM600 MPS operations are available.
The VM600 MPSx software and CPUM access (CPUM Access Lock: Unlocked) are required
in order to change the MPS Password Validation.

Basically, the use of CPUM access lock protects the VM600 MPS configuration and prevents
all sensitive VM600 MPS operations from being run (that is, “read only” – the highest level of
security). Like CPUM access lock, the use of MPS password validation protects the
configuration of the MPC4 cards and AMC8 cards in the VM600 rack but MPS password
validation also allows certain VM600 MPS operations to be run (that is, “read + restricted
write” – a reduced level of security). See the table on the following page for further information
on the operations permitted when CPUM security features are used.

NOTE: The CPUM access lock is a stronger protection mechanism than MPS password
validation and is used to implement the highest level of VM600 MPS rack security
(that is, with the fewest VM600 MPS operations available to the user).

Table 4-1 shows the VM600 MPS operations affected by the CPUM security features.
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Table 4-1: VM600 MPS operations affected by the CPUM security features

VM600 MPS operation
(protected by CPUM security features)

CPUM security feature

CPUM Access
Lock

MPS Password 
Validation

Committing a VM600 MPS configuration Not available Password protected

Running MPS commands via VM600 MPSx software:
• Alarm reset (AR)
• Channel inhibit (sensor bypass)
• Danger bypass (DB)
• Trip multiply (TM)
• Clear status latch

Not available Password protected

Running MPS commands via Modbus:
• Alarm reset (AR)
• Channel inhibit (sensor bypass)
• Danger bypass (DB)
• Trip multiply (TM)
• Clear status latch

Not available Available

Changing a VM600 MPS fieldbus configuration (such 
as Modbus) Not available Available

Accessing a CPUM using an Ethernet-based 
connection such as CPUM Configurator, FTP or Telnet Not available Available

Displaying VM600 MPS measurement outputs such as 
the outputs windows and plots (historical or live data) Available Available

Operation of a VM600 CMS condition monitoring 
system using cards such as the CMC16/IOC16T in the 
same VM600 rack

Available Available

Operation of a VibroSight condition monitoring system 
using cards such as the XMx16/XIO16T in the same 
VM600 rack

Available Available

MPS Password Validation security feature Not available Available

CPUM Access Lock security feature Available Available

Level of security Highest Reduced

Notes
When CPUM access is blocked (CPUM Access Lock: Locked), a VM600 MPS is limited to “read only” operations as shown 
in the CPUM Access Lock column above.
When CPUM access is allowed (CPUM Access Lock: Unlocked), MPS Password Validation can be enabled 
(MPS Password Validation: Enabled) and a VM600 MPS is limited to “read + restricted write” operations as shown in the 
MPS Password Validation column above. However, while the read only operations run as usual, the write operations require 
that the correct CPUM password is entered by the user before they are run.
When CPUM access is allowed (CPUM Access Lock: Unlocked) and MPS Password Validation is disabled 
(MPS Password Validation: Disabled), a VM600 MPS can perform all operations (“read + write”). With these settings, no 
VM600 MPS rack (CPUM) security is used, which is equivalent to using a VM600 system with VM600 MPSx software 
version 2.6 or earlier and CPUM firmware version 076 or earlier.
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Table 4-2 shows the relationship between CPUM access lock, MPS password validation and
access rights.

4.3.2 Displaying CPUM security settings
The VM600 MPSx software can be used to communicate with the CPUM card in order to read
and display the current state of the CPUM security settings.

NOTE: The VM600 MPSx software privilege level must be Master or Super in order to
access the CPUM Security command (see 4.2 VM600 MPSx software privilege
levels).

To read the CPUM security settings:
1- Click on a rack level node in the configuration tree to select it, then use the

Communications > CPUM security menu command.
Alternatively, right-click on a rack level node in the configuration tree, then click
CPUM security.

2- In the CPUM Security window that appears, under Rack Selection, in the Hostname
field, enter either the IP address of the rack (CPUM card) in dot-decimal notation or a
predefined host name. Then click the Read Security Settings button.
The CPUM Security window updates and displays, under CPUM Security Settings,
the status of the CPUM access (CPUM Access Lock) and the status of the MPS
password validation (MPS Password Validation).
The “session” information (Session Information) shows if the VM600 MPSx software is
logged on to the CPUM card, which happens either automatically upon entering the
correct CPUM password when running a VM600 MPS command or manually by using
the Log On To CPUM card button.

Table 4-2: Relationship between CPUM access lock, MPS password validation and access rights

CPUM Access
Lock

MPS Password 
Validation Access rights Notes

Locked --- Read only Highest level of security

Unlocked
Enabled with 
password not 

entered correctly
Read only

Reduced level of security

Unlocked
Enabled with 

password
entered correctly

Read +
restricted write

Unlocked Disabled Read +
write

Lowest level of security.
This is equivalent to using a VM600 
system with VM600 MPSx software 
version 2.6 or earlier and CPUM 
firmware version 076 ore earlier.
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NOTE: The fields under CPUM Security Settings are unavailable (greyed out) until
the Read Security Settings button is used to establish communications with
the CPUM card.
If the CPUM security settings change, for example, using the keys on the front
panel of the card, then the Read Security Settings button must be used to read
the security settings from the card (as the CPUM Security window does not
update automatically).

4.3.3 Allowing or blocking access to the CPUM
CPUM access is allowed by default so that the CPUM card and VM600 rack can
communicate with the VM600 MPSx software and compatibility with earlier versions of CPUM
firmware is maintained.

To block access to a CPUM card (and limit the VM600 MPS to “read only” operations):
• When CPUM access is allowed, simultaneously pressing the OUT−, SLOT− and SLOT+

keys on the front panel of the CPUM card will block access to the card, that is, the
CPUM Access Lock setting toggles from Unlocked to Locked.
To indicate that the CPUM card is locked, the DIAG LED on the front panel of the CPUM
card slowly blinks green (approximately once per second). See Table 4-3.

To allow access to a CPUM card:
• When CPUM access is blocked, simultaneously pressing the OUT−, SLOT− and SLOT+

keys on the front panel of the CPUM card will allow access to the card, that is, the
CPUM Access Lock setting toggles from Locked to Unlocked.
To indicate that the CPUM card is unlocked, the DIAG LED on the front panel of the
CPUM card shows green (continuously). See Table 4-3.

In addition, after changing the CPUM access setting, the CPUM Security window in the
VM600 MPSx software can be used to display (refresh) the CPUM security settings (by
running the Read Security Settings command).

Table 4-3: CPUM access and the behaviour of the CPUM’s DIAG LED

Behaviour of the 
CPUM’s DIAG LED Event(s)

Green (continuous) Access to the CPUM card is allowed 
(CPUM Access Lock: Unlocked)

Green blinking slowly 
(approximately once 
per second)

Access to the CPUM card is restricted 
(CPUM Access Lock: Locked).
See Table 4-1.

Green blinking quickly 
(approximately twice 
per second) for five 
seconds

The CPUM card is resetting to its default security settings. 
See 4.3.7 Resetting the CPUM security settings.
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4.3.4 Enabling and disabling MPS password validation on a CPUM
MPS password validation on a CPUM card is disabled by default so that the CPUM card can
communicate with the VM600 MPSx software and compatibility with earlier versions of CPUM
firmware is maintained.

NOTE: CPUM access must be allowed (CPUM Access Lock: Unlocked) in order to work
with MPS password validation.

To enable password validation on a CPUM card (and limit the VM600 MPS to “read +
restricted write” operations):
1- Click on a rack level node in the configuration tree to select it, then use the

Communications > CPUM security menu command.
Alternatively, right-click on a rack level node in the configuration tree, then click
CPUM security.

2- In the CPUM Security window that appears, under CPUM Security Settings, for the
MPS Password Validation field, click the Enable option.

3- In the Set CPUM Password window that appears, enter the new password and enter the
new password again to confirm it, then click OK.
The CPUM password is set, CPUM password validation is enabled, and the
CPUM Security window updates.

MPS password validation is enabled and the CPUM Security window updates.

4.3.5 Changing the password on the CPUM
To change the password used by a CPUM card for authentication:
1- In the CPUM Security window, under CPUM Security Settings, for the

CPUM Password Validation field, click the Change CPUM Password button.
2- In the Change CPUM Password window that appears, enter the old password and the

new password, and enter the new password again to confirm it, then click OK.
The CPUM password is set, CPUM password validation is enabled, and the CPUM Security
window updates.

NOTE: CPUM access must be allowed (CPUM Access Lock: Unlocked) in order to work
with MPS password validation

4.3.6 Logging on and off a CPUM
When MPS password validation on the CPUM card is used, whenever the VM600 MPSx
software is asked to perform a restricted operation (for example, Alarm Reset (AR)), the
software will prompt the user for the CPUM password before continuing.
If the correct CPUM password is used, then the VM600 MPSx software will automatically log
on to the CPUM card and perform the requested operation. When the software logs on to the
CPUM card in this way, it will remain logged on to the CPUM card in a “session” until the
CPUM Security window is used to log off from the CPUM card or the software is
closed (exited).
In a session, it is not necessary re-enter the CPUM password every time a restricted
operation is requested. However, such sessions also have a timeout of 10 minutes, so if no
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restricted command (that is, a command normally requiring a password) is run during a 10
minute period, then the session automatically logs off.
However, if an incorrect CPUM password is used, then VM600 MPSx software will not log on
to the CPUM card and the requested operation is not performed.

To manually log on to a CPUM card:
1- In the CPUM Security window, under CPUM Security Settings, for the

Session Information field, click the Log On To CPUM card button.
2- In the CPUM Login window that appears, enter the password, then click OK.
The VM600 MPSx software is logged on to the CPUM card and the CPUM Security window
updates.

To log off from a CPUM card:
1- In the CPUM Security window, under CPUM Security Settings, for the

Session Information field, click the Log Off From CPUM card button.
The VM600 MPSx software is logged off from the CPUM card and the CPUM Security
window updates.

If the CPUM security settings change, for example, using the keys on the front panel of the
card, or the VM600 MPSx software is closed (exited), any open sessions with a CPUM card
are automatically closed (logged off).

4.3.7 Resetting the CPUM security settings
If necessary, the CPUM security settings can be reset to their default values of:
• CPUM Access Lock: Unlocked
• MPS Password Validation: Disabled.
When the CPUM security settings are reset, any open sessions with the CPUM card are
automatically closed:
• Session Information: Logged off.

NOTE: Physical access to CPUM card (VM600 rack) is required in order to reset the
CPUM security settings to their default values.

To reset the CPUM security settings:
• Simultaneously press and hold the OUT−, SLOT− and SLOT+ keys on the front panel of

the CPUM card for five seconds.
To indicate that the CPUM card is reset, the DIAG LED on the front panel of the CPUM
card quickly blinks green (approximately twice per second) for five seconds. Then, the
DIAG LED resumes normal operation (continuous green when the CPUM is running
correctly and off when the CPUM is starting).

In addition, after resetting the CPUM security settings, the CPUM Security window in the
VM600 MPSx software can be used to display (refresh) the CPUM security settings (by
running the Read Security Settings command).
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4.4 CPUM Configurator software
CPUM Configurator is included with VM600 MPSx software version 2.7 or later and is copied
to the computer as part of the VM600 MPSx software installation process. Previously, CPUM
Configurator was only available from Meggitt customer support (see 17.1 Contacting us).
CPUM Configurator is a program that communicates with a CPUM card in a VM600 rack over
an Ethernet (TCP/IP) link. Basically, it provides a graphical user interface for a Telnet session
between a CPUM Configurator (Telnet client) and a CPUM card (Telnet server), and is used
primarily for configuring and managing CPUM cards / VM600 racks

NOTE: Refer to the VM600 networking manual for further information on the
CPUM Configurator software.
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5 CREATING THE CONFIGURATION TREE

5.1 Introduction
This section describes how to create the configuration tree structure. This outline of the
system (“skeleton”) of the configuration defines the overall structure of the machinery
protection system. It must be created before individual cards can be configured.
See 2.2 VM600 MPS configuration for further information.
The first step is to determine how many databases are required for the site being monitored
by the protection system and to create the databases necessary.

5.2 Creating databases
When you enter the VM600 MPS1 Configuration Editor main window for the first time after
installation, the default configuration tree structure is shown on the left of the window (see
Figure 5-1).

A single database is created by default during installation. To configure your first database,
you can choose to either reconfigure this default database or create a new database. 
There are two ways to create new databases:
• Using the Database Manager. See 6.2.3 Using the Database Manager for details.
• Using the New Database command on the Database menu. This procedure is described

below.

Figure 5-1: Main window of the VM600 MPS1 Configuration Editor
(VM600 MPSx software)
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To create a new database using the New Database command on the Database menu:
1- Switch to the Super privilege level (see 4.2.1 Selecting the privilege level).
2- Select New Database from the Database menu at the top of the main window of the

VM600 MPS1 Configuration Editor. The dialog box shown in Figure 5-2 appears. 

3- Type a name for the database in the Tag field. This name must be unique, that is, two or
more databases cannot have the same name.

4- Optionally, type a description of the database in the Description field to provide further
information. Any text entered is visible as a cue card when the mouse pointer is placed
on the icon in the configuration tree structure representing the database. 

5- Optionally, click Change Folder to modify the default folder in which the physical
database file is to be stored. Navigate to and select a different folder, then click OK to
continue.
By default, databases are created in the VM600_MPS\Configuration folder and have
a .db file name extension.

Figure 5-3 shows the appearance of the configuration tree structure when two databases
have been created. 

5.3 Adding a rack to a database
There are two methods of attributing a VM600 rack to a database. Either:

a. Choose the New Rack command from the Database drop-down menu as shown in
Figure 5-4 (a)

or

Figure 5-2: New Database dialog box

Figure 5-3: Configuration tree structure showing two new databases
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b. Alternatively, select the database name in the configuration tree structure using the
left mouse button. Then, right-click to obtain the shortcut menu shown in
Figure 5-4 (b). Choose the New Rack command.

Once the New Rack dialog box appears (Figure 5-5), type a name for the rack in the Tag field.
This name must be unique, that is, two or more racks cannot have the same name.

Optionally, some descriptive text can be entered in the Description field to provide further
information. The text you type is visible as a cue card when the mouse pointer is placed on
the icon in the configuration tree structure representing the rack.
Click OK to close the dialog box. 
If the rack contains a CPUM card, the rack’s network address can be configured at this stage.
To do this, click the rack’s name in the configuration tree structure to obtain the rack General
Information tab (see Figure 5-6). Select the CPU Present check box, then in the Hostname
field, either select a predefined host name or type the rack IP address, in dot-decimal
notation, directly (for example, 255.255.255.255).

NOTE: Refer to the VM600 networking manual for further information on networking.

If desired, text can be entered into the Description and Location fields. This operation is
optional, but these text entries can serve as useful comments for other users.
The Rack Rear Layout check boxes and the other tabs (Backplane Bus View and so on)
are described in 16 Configuration windows at rack level.

Figure 5-4: Adding a rack to a database

Method (a) Method (b)

Figure 5-5: New Rack dialog box
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5.4 Adding cards to a rack
There are three methods of attributing cards (MPC4, AMC8) to a VM600 rack:

a. Choose the Add Card to Rack command from the File drop-down menu as shown
in Figure 5-7 (a).

or

b. Alternatively, highlight the rack name in the configuration tree structure using the left
mouse button. Then, right-click to obtain the shortcut menu shown in Figure 5-7 (b).
Choose the Add Card to Rack command.

Figure 5-6: Setting up the IP address for the rack

Choose from the list the host name that corresponds to the VM600 MPS rack in question.
Alternatively, enter the IP address of the rack directly in the field.

Highlight the rack
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or

c. Drag and drop. Press and hold down the SHIFT key then click an existing card. Drag
the card to the rack and release. This creates a copy of the card.

Once the New Card dialog box appears (Figure 5-8), choose a card from the Card Type
combo box: AMC8, MPC4 or MPC4 SIL.

NOTE: The MPC4 machinery protection card is available in different versions, including a
standard version and a separate circuits version that are referred to as MPC4 in
the VM600 MPSx software, and a safety (SIL) version that is referred to as
MPC4 SIL in the VM600 MPSx software.
The MPC4 SIL (safety MPC4 card) does not have a VME bus interface and does
not provide all of the signal processing capabilities of the standard and the
separate circuits versions of the MPC4.
Refer to the VM600 MPC4 machinery protection card data sheet and
VM600 machinery protection system (MPS) hardware manual for further
information.

You must then assign a value in the Slot Number field.
Optionally, some descriptive text can be entered in the Description field to provide further
information. This operation is optional. Any text entered is visible as a cue card when the
mouse pointer is placed on the icon in the configuration tree structure representing the card.
The Import key allows a pre-existing configuration file for a card to be loaded. These files
have a .cfg file name extension.

Figure 5-7: Adding a card to a rack

Method (a) Method (b)
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Click OK to close the dialog box. 

Figure 5-9 shows a typical configuration tree structure once several cards have been
assigned to racks and databases. 

Figure 5-8: New Card dialog box

Figure 5-9: Configuration tree structure containing several databases, racks and cards
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6 MAIN WINDOW MENUS AND COMMANDS

6.1 Introduction
The appearance of the main window of the VM600 MPS1 Configuration Editor (VM600 MPSx
software) depends on what sort of element (database, rack or card) is selected in the
configuration tree structure. This also determines which drop-down menus are available.

6.2 Main window at database level (managing databases)
At database level, the VM600 MPS1 Configuration Editor main window resembles that shown
in Figure 6-1.

The General Information tab contains the following fields:

Tag Allows the database name to be changed.

Description Optionally, some descriptive text can be entered here. This text is
visible when the mouse pointer is placed on the database icon in the
configuration tree structure.

Figure 6-1: VM600 MPS1 Configuration Editor main window at database level



SOFTWARE MANUAL Document reference MAMPS1-SW/E
VM600 MPS1 software Edition 12 - February 2021
6 - 2

Main window at database level (managing databases)
MAIN WINDOW MENUS AND COMMANDS

The contents of the drop-down menus are shown in Figure 6-2. This figure also explains the
elements in the toolbar.

The Database drop-down menu contains the following choices:

New Rack Adds a new rack to the selected database.

New Database Adds a new database to the VM600 MPS1 Configuration Editor.

Consistency
Checks > Perform
Checks

Checks the validity of the files in the selected database.
See 6.2.1 Performing consistency checks for further information.

Consistency
Checks > View
Previous Results

Displays the results of the previous consistency checks for the
selected database.
See 6.2.1 Performing consistency checks for further information.

Consistency
Checks > Clear
Previous Results

Clears (deletes) the results of all previous consistency checks for
the selected database.
See 6.2.1 Performing consistency checks for further information.

Sensor Information
Editor

Starts the Sensor Information Editor program.
See 6.2.2 Using the Sensor Information Editor for further
information.

Figure 6-2: Drop-down menus and toolbar at database level

Save – save the changes to the configuration
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The Privileges drop-down menu allows one of the four privilege levels to be set and
passwords to be changed. See 4.2.1 Selecting the privilege level for further information.
The Help drop-down menu allows the offline help concerning the VM600 MPS1 software to
be accessed.

6.2.1 Performing consistency checks
Consistency checks are used to check the validity of the files in the selected database.
To perform consistency checks, choose Database > Consistency Checks > Perform
Checks.
The VM600 MPS1 software also performs consistency checks automatically whenever:
• Switching to the Super privilege level (see 4.2.1 Selecting the privilege level).
• Closing (exiting) the Database Manager utility (see 6.2.3 Using the Database Manager).

Database Manager Starts the Database Manager program.
See 6.2.3 Using the Database Manager for further information.

Refresh Database
files

Updates the version information in the selected database to the
latest release and performs any necessary updates.

Exit Exits (stops) the VM600 MPS1 Configuration Editor software.
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The Consistency Checks window is displayed, as shown in Figure 6-3.

The Consistency Checks window lists the results of a number of checks that the VM600
MPS1 software carries out on the current database:
• Verifying that read/write access is granted to all database files.
• Checking that the dbinfo.db file exists.
• Converting rack files created with previous versions of the VM600 MPSx software to the

latest version.
• Checking for file name extension mismatches in early machine files.
• Searching for blank tags in MPC and AMC configurations.
• Checking for AMC Board Level information problems due to the incorrect initialisation of

remote source channels 1 and 2 (Remote Channel Source #1 and #2).
If any errors or inconsistencies are found, the VM600 MPS1 software can automatically
perform any database updates necessary. It is strongly recommended that you perform these
updates. Click the icon on the toolbar of the Consistency Checks window to perform
automatic updates.

Figure 6-3: Consistency Checks window displaying previous results

Back to display previous results

Forward to display next results

Save currently displayed results as an HTML file

Print currently displayed results
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The VM600 MPS1 software stores the results of previous consistency checks in order to
allow you to refer to them later if necessary. You can use the following commands on the
Database > Consistency Checks menu to check the results of previous consistency
checks:
• View Previous Results

Displays the last Consistency Check file(s) created for the current database. You can
step back through earlier files by clicking the ‘Back’ button on the toolbar
(see Figure 6-3).
Alternatively, you can click the and icons on toolbar of the Consistency Checks
window to display the previous and next set of results, respectively.

• Clear Previous Results
Deletes all Consistency Check files created for the current database.
Alternatively, click the icon on the Consistency Checks window to display the previous
results.

6.2.2 Using the Sensor Information Editor
The Sensor Information Editor allows the underlying sensor list used by the VM600 MPS
Configuration Editor software to be customised and managed. More specifically, it allows the
addition, removal or modification of all types of sensors used by the Speed and Vibration
channel configuration pages in the VM600 MPS software.
When the VM600 MPSx software (MPS1 or MPS2) is being used to configure the input
channels for an MPC4 card, it uses the information provided in a sensor list file that is copied
to the computer as part of the VM600 MPS software installation process.

6.2.2.1 Background

The sensor list file provides the information that is used to populate the drop-down list boxes
and text boxes of the VM600 MPS software user interface when input channels
(Measurement Channels and Speed Channels) are being configured. The sensor list file
includes detailed information on the measurement chains (sensors/signal conditioners) for
the different sensor systems that are available from Meggitt, that is, information such as
Sensor Family, Sensor Type, Conditioner, Transmission Mode and Signal Sensitivity.
Using the Sensor Information Editor helps to make the management of VM600 MPSx
software configurations easier. For example, consider a specific measurement chain
(sensor/conditioner), used by multiple input channels, that is required to be modified.
Without the Sensor Information Editor: In each input channel tab in the VM600 MPSx
software where the measurement chain is used (Channel 1, Channel 2 and so on), the same
parameters for the sensor/conditioner must be manually edited.
With the Sensor Information Editor: The sensor/conditioner can be edited once and saved to
the sensor list file, after which the VM600 MPS software will automatically apply the changes
wherever the measurement chain is used.

6.2.2.2 Starting the Sensor Information Editor 

The Sensor Information Editor is started from the VM600 MPS software.
Click Database > Sensor Information Editor to start the Sensor Information Editor.

NOTE: To start the Sensor Information Editor, a Database must be selected in the
configuration tree of the VM600 MPS software user interface and the VM600 MPSx
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software privilege level must be Super (see 4.2 VM600 MPSx software privilege
levels).

When the Sensor Information Editor is started, the VM600 MPS software automatically
closes and when the Sensor Information Editor is closed (exited), the VM600 MPS software
is automatically restarted. This system behaviour is required in order to allow the software to
read and apply any changes that have been made to the underlying sensor list file.

6.2.2.3 Sensor Information Editor user interface

The Sensor Information Editor user interface (see Figure 6-4) consists of two panes: a
Sensor List pane (left) and a Sensor Information pane (right).

The Sensor List pane (left) is used to select a sensor/conditioner to edit, add a new
sensor/conditioner to the sensor list file and remove a sensor/conditioner from the sensor
list file:
1- Click on a sensor/conditioner in the Sensor List pane to select it.

The selected sensor/conditioner is shown against a dark background in the Sensor List
pane and the parameters for the sensor/conditioner are displayed in the Sensor
Information pane, where they can be edited.

2- Click Add New in the Sensor List pane to add a new sensor/conditioner.
The new sensor/conditioner is shown against a dark background in the Sensor List pane
and the empty parameters for the new sensor/conditioner are displayed in the Sensor
Information pane, where they can be edited.

Figure 6-4: VM600 MPS software Sensor Information Editor window
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3- Click on a sensor/conditioner in the Sensor List pane to select it, then click Remove to
remove it. The sensor/conditioner is removed from the Sensor List pane.
The Sensor Information pane (right) is used to edit the parameters for the
sensor/conditioner selected in the Sensor List pane (left).

4- Click Save to save any changes made in the Sensor Information Editor to the sensor list
file.

5- Click Exit to close (exit) the Sensor Information Editor.
The user will be prompted to save any unsaved changes in the Sensor Information Editor to
the sensor list file before the program is closed.
Click Help or press the F1 key to display the help on using the Sensor Information Editor.

6.2.2.4 Factory assigned defaults

If it becomes necessary to revert back to the default sensor list file provided by Meggitt, a
batch file included in the VM600 MPS software folder can be used.

NOTE: The default installation folder for the VM600 MPS software is
C:\Program Files\VM600_MPS

NOTE: The default location for the Windows Program Files folder depends on the
operating system installed on the computer:
C:\Program Files on 32-bit versions of Windows, but
C:\Program Files (x86) on 64-bit versions of Windows.

Reverting back to the default sensor list file will cause any changes that have been made to
the sensor list file by the user to be lost.
To revert back to the default sensor list file, use a Windows Explorer to navigate to the Bin
folder under the VM600 MPS software folder (VM600_MPS\Bin) and double-click the
sensors_factory.bat file.

6.2.3 Using the Database Manager
The Database Manager allows you to manage the databases created to contain VM600 MPS
configuration data.

6.2.3.1 Starting the Database Manager

The Database Manager is started from the VM600 MPS software.
Click Database > Database Manager to start the Database Manager.

NOTE: To start the Database Manager, a Database must be selected in the configuration
tree of the VM600 MPS software user interface and the VM600 MPSx software
privilege level must be Super (see 4.2 VM600 MPSx software privilege levels).

When the Database Manager is started, the VM600 MPS software automatically closes and
when the Database Manager is closed (exited), the VM600 MPS software is automatically
restarted. This system behaviour is required in order to allow the VM600 MPS software to
read and apply any changes that have been made to the underlying database files.
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6.2.3.2 Database Manager user interface

The Database Manager user interface (see Figure 6-5) consists of one main pane that lists
the MPS Databases used by the VM600 MPS software and buttons that provide access to
the database operations available in the VM600 MPS1 software.

6.2.3.3 Using the Database Manager

The VM600 MPS1 Database Manager provides the commands listed in Table 6-1.

Figure 6-5: Database Manager window

Table 6-1: VM600 MPS software Database Manager commands

Command Description

Copy DB Creates a copy of the selected database and adds it to the active 
database list

Move DB Moves the selected database to another location on your file system, 
and keeps it in the active database list

Delete DB Deletes the selected database and all related files and removes it from 
the active database list

Details Shows a list of all files in the selected database, their content and 
version

Help Displays offline help (that is, the help installed locally on the computer)

Add Creates a new database

Search Searches the specified drive for a valid VM600 MPS database

Disable All Disables all databases in the active database list

Enable All Enables all databases in the active database list

Save Saves changes in the active database list (applies to enabled databases 
only)

Close Closes (exits) the Database Manager window
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6.3 Managing racks
At rack level, the VM600 MPS1 Configuration Editor main window resembles that shown in
Figure 6-6.

The General Information tab contains the following fields:

If the rack contains a CPUM card, select the CPU Present check box, then select the name
of the host from the predefined list in the Hostname list box. Alternatively, type the rack’s IP
address, in dot-decimal notation, directly into the field (for example, 10.10.56.56).

Tag Allows the rack name to be entered or changed.

Description Optionally, some descriptive text can be entered here. This text is
visible when the mouse pointer is placed on the rack icon in the
configuration tree structure.
This text also appears in the Rack Summary.

Location An optional text describing the rack location can be added here. 
This text appears in the Rack Summary.

Figure 6-6: VM600 MPS1 Configuration Editor main window at rack level
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NOTE: See 11.2 Communication with a stand-alone rack (no CPUM present) and
11.3 Communication with a networked rack (CPUM present) for further
information.
Refer to the VM600 networking manual for further information on networking.

The Rack Rear Layout check boxes and the other tabs (Backplane Bus View, and so) are
described in 16 Configuration windows at rack level.

6.3.1 Drop-down menus and toolbar (with a rack selected)
The contents of the drop-down menus are shown in Figure 6-7. This figure also explains the
elements in the toolbar.

The File drop-down menu contains the following choices:

Add Card to Rack Adds a card (such as MPC4 or AMC8) to the rack highlighted by
the mouse pointer.

Dump to File Saves the rack configuration in an external file using a
comma-separated values file format (*.csv).
This facilitates subsequent data processing by external programs
such as spreadsheet software.

New Rack Adds a new rack to the database presently selected.

Delete Rack Deletes the rack highlighted by the mouse pointer.

Exit Exits (stops) the VM600 MPS1 software.

Figure 6-7: Drop-down menus and toolbar at rack level

Save – save the changes to the configuration

Send – send the rack configuration to the VM600 rack
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The Communications drop-down menu contains the following choices:

The Privileges drop-down menu allows one of the four privilege levels to be set and
passwords to be changed. See 4.2.1 Selecting the privilege level for further information.
The Help drop-down menu allows the offline help concerning the VM600 MPS1 software to
be accessed.

6.3.2 Shortcut menu (with a rack selected)
A shortcut menu is also available and is displayed when a rack-level node in the tree structure
is right-clicked.
Most of the commands available from the shortcut menu are the same as those available
from the File drop-down menu (see 6.3.1 Drop-down menus and toolbar (with a rack
selected)). However, the shortcut menu does include some rack-level commands that are not
available anywhere else.
Right-clicking on a rack provides access to the following additional commands:

Communications >
Serial Port Setup

Choose the appropriate COMx serial interface port for RS-232
communications with the cards in a stand-alone VM600 rack (not
containing a CPUM card).
The Serial Port Setup option is only available when the
CPU Present check box (see Figure 6-6) is not selected.

Read Configuration Reads the entire rack configuration from the selected rack, that is,
the general rack parameters as well as the full configuration of
each specific card in that rack.
A Rack Summary can then be obtained and printed if required.

Send Configuration Sends the entire rack configuration to the selected rack, that is, the
general rack parameters as well as the full configuration of each
specific card in that rack.
See 2.3.1.1 Safety (SIL) version of the MPC4.

CPUM Security Displays the CPUM Security window which allows the VM600
MPS rack (CPUM) security settings to be displayed and
configured.
See 4.3 VM600 MPS rack (CPUM) security.

Enable/Disable Selected Rack Select or clear the CPU Present check box in the
the General Information tab.
See 6.3 Managing racks.

CPUM Security Displays the CPUM Security window which allows
the VM600 MPS rack (CPUM) security settings to
be displayed and configured.
See 4.3 VM600 MPS rack (CPUM) security.
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6.3.3 Sending a configuration to a VM600 rack or card
A configuration can be sent to a VM600 rack at one of two levels:
• Rack level – by selecting a rack in the configuration tree then using the

Communications > Send Configuration menu bar command.
• Card level – by selecting a card (MPC4, MPC4 SIL or AMC8) in the configuration tree

then using the Communications > To AMC > Send Configuration or
Communications > To MPC > Send Configuration menu bar command as
appropriate.

When sending a configuration to a VM600 rack or card, the VM600 MPSx software prompts
the user for confirmation before continuing with the download.

NOTE: As the MPC4 SIL card does not have a VME bus interface, it cannot communicate
with a CPUM card (or any other cards) in a VM600 rack. Accordingly, an MPC4 SIL
card can only be configured via a direct connection to the RS-232 connector on its
front panel (even for a “networked” VM600 rack).
Refer to the VM600 MPC4 machinery protection card data sheet and
VM600 machinery protection system (MPS) hardware manual for further
information.

6.4 Managing MPC4 and MPC4 SIL cards (card overview page)
If an MPC4 card is selected from the configuration tree structure, an overview page for that
card is displayed in the main window (VM600 MPS1 Configuration Editor). A typical example
is shown in Figure 6-8.

Figure 6-8: VM600 MPS1 Configuration Editor main window at MPC4 card level
(card overview page)

Picture area
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The image of the card displayed in the VM600 MPS1 Configuration Editor main window (card
overview page) is different for each type of MPC4 card, that is, MPC4 or MPC4 SIL. The
image of the card shown in the picture area in Figure 6-8 corresponds to an MPC4.

The Rack Information area of the window contains the following non-editable fields:

The Station and Machine columns are reserved for the VM600 MPS2 software package.

NOTE: Refer to the VM600 MPS2 configuration software for VM600 machinery protection
systems (MPSs) software manual for further information.

Some descriptive text concerning the measurement point may be found in the Sensor
column. 
For measurement channels, this text is copied from the text entered in the Tag field of the
Processed Output tab (Processing\Channel n branch of tree structure selected).
See 8 Processing configuration (MPC4 and MPC4 SIL). 
For speed channels, this text is copied from the text entered in the Sensor Tag field
(Inputs\Speed Channels branch of tree structure selected). See 7.3 Configuring speed
channels.
A customised picture may be placed in the picture area. See 6.6 Displaying a customised
picture on the card overview page for further information.

Location Indicates the database in which the rack’s measurement data
is stored.

Rack Tag Identifies the rack in which the MPC4 card is inserted.

Slot Number Indicates the slot of the rack in which the MPC4 card is inserted.
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6.4.1 Drop-down menus and toolbar (with an MPC4 or MPC4 SIL card selected)
The contents of the drop-down menus are shown in Figure 6-9. This figure also explains the
elements in the toolbar.

Save – save the changes to the configuration

Summary – display the summary sheet for the MPC4 or MPC4 SIL card

Figure 6-9: Drop-down menus and toolbar at MPC4 and MPC4 SIL card level

Read Outputs – display the outputs window for the MPC4 or MPC4 SIL card

Refresh – refresh the information displayed in the MPC4 or MPC4 SIL card overview page

Send – send the card configuration to the MPC4 or MPC4 SIL card
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The File drop-down menu contains the following choices:

Copy Inputs Allows the Inputs already configured for an MPC4
card to be re-used elsewhere on the same MPC4
card. That is, Measurement channels 1 to 4 and
Speed Channels 1 to 2.

Copy Processings and Alarms Allows the Processings and Alarms already
configured for an MPC4 card to be re-used
elsewhere on the same MPC4 card. That is,
Processing channels 1 to 4, Dual Processing
channel 1 & 2 and Dual Processing channel 3 & 4,
including any alarms configured for the processing
channel.

Import MPC Configuration Loads an MPC4 card configuration from a
pre-existing configuration file (*.cfg). This file is
compatible with the previous Meggitt vibro-meter®

MPCC software.

Export MPC Configuration Saves an MPC4 card configuration in an external
configuration file (*.cfg). This file is compatible
with the previous Meggitt vibro-meter® MPCC
software.

Import Raw MPC Configuration Loads an MPC4 card configuration from a
pre-existing configuration file (*.cfg). 

Export Raw MPC Configuration Saves an MPC4 card configuration in an external
configuration file (*.cfg).

NOTE: See below for an explanation of the
difference between normal and raw
configuration files.

Dump to File Saves an MPC4 card configuration in an external
file using a comma-separated values file format
(*.csv).
This facilitates subsequent data processing.

Add Card to Rack Adds a new MPC4 card to the rack presently
selected.

Delete MPC Deletes the MPC4 card highlighted by the mouse
pointer.

MPCC - General Information Allows additional information used by the previous
Meggitt vibro-meter® MPCC software to be entered.
This information is displayed at the top of the
summary sheet for the MPC4 card.

Exit Exits (stops) the VM600 MPS1 software.
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6.4.1.0.1 Difference between normal and raw configuration files

Normal MPC configuration files are files that can be created using the Meggitt vibro-meter®

MPCC software, a predecessor of the VM600 MPS software packages. These can be
imported into VM600 MPSx software. Conversely, the configuration of a specific MPC4 card
can be created in VM600 MPS software and then exported, as this file is in a format that the
MPCC software understands.

The Communications drop-down menu allows principally the MPC4 configuration
information to be sent to the card and measured values to be read back from it. The
Communications menu also allows channel inhibit commands to be sent to individual MPC4
channels in order to temporarily bypass a sensor (that is, temporarily inhibit any associated
relays). See 11 Communications menu (MPC4 and MPC4 SIL) for further information on all
the menu functions.
The Privileges drop-down menu allows one of the four privilege levels to be set and
passwords to be changed. See 4.2.1 Selecting the privilege level for further information.
The Help drop-down menu allows the offline help concerning the VM600 MPS1 software to
be accessed.

6.4.2 Shortcut menu (with an MPC4 or MPC4 SIL card selected)
A shortcut menu is also available and is displayed when an MPC4 or MPC4 SIL card-level
node in the tree structure is right-clicked.
Most of the commands available from the shortcut menu are the same as those available
from the File drop-down menu (see 6.4.1 Drop-down menus and toolbar (with an MPC4 or
MPC4 SIL card selected)). However, the shortcut menu does include some MPC4 card-level
commands that are not available anywhere else.

Right-clicking on an MPC4 or MPC4 SIL card provides access to the following additional
command:

As all of the features supported by a safety MPC4 card (MPC4 SIL) are also supported by a
standard or separate circuits MPC4 card (MPC4), no configuration information is lost when
converting from an MPC4 SIL to a MPC4.
However, not all of the features supported by a standard or separate circuits MPC4 card
(MPC4) are supported by a safety MPC4 card (MPC4 SIL), so configuration information can

Using the Raw configuration file format is recommended for advanced users
only. Raw configuration files are in a format that is used and stored by the
CPUM card in its disk structure. These files are used by the CPUM to
reprogram (that is, configure) specific cards in the VM600 rack, if necessary.
Contact your Meggitt customer support representative for further
information, if required.

MPC4 <--> MPC4 SIL Conversion If a standard or separate circuits MPC4 card
(MPC4) is selected, automatically convert the
configuration to a configuration for a safety MPC4
card (MPC4 SIL).
If a safety MPC4 card (MPC4 SIL) is selected,
automatically convert the configuration to a
configuration for a standard or separate circuits
MPC4 card (MPC4).
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be lost when converting from an MPC4 to a MPC4 SIL. For example, the safety MPC4 card
(MPC4 SIL) card does not support the speed/phase reference (tachometer) input channels,
the Narrow Band (Tracking) Vibration and Smax processing functions, and it does not support
the danger bypass (DB) and trip multiply (TM) functions.
Refer to Table 7-1 in section 7.1 Different versions of the MPC4 card of the
VM600 machinery protection system (standard version) hardware manual for further
information.

Right-clicking on an MPC4 SIL card provides access to the following additional command:

As shown in Figure 6-10, when the Check MPC4 SIL Configuration command is run, the
VM600 MPS software displays a message reminding the user to review the complete system
configuration to identify any possible conflicts in the VM600 system rack.

After the Check MPC4 SIL Configuration command is run, the VM600 MPS software
Consistency Checks window lists any safety-relevant configuration errors/warnings detected
by the software for the safety MPC4 card (MPC4 SIL), as shown in Figure 6-11.
See also 6.2.1 Performing consistency checks.

Check MPC4 SIL Configuration Run a consistency check on the configuration for a
safety MPC4 card (MPC4 SIL) to ensure that it
meets the requirements for use in a safety-related
system. For example, alarms must be configured as
latching, and output relays must be configured as
normally energised (NE), that is, de-energised to
trip.

Figure 6-10: VM600 MPS1 Configuration Editor message displayed after
running the Check MPC4 SIL Configuration command
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NOTE: While the MPC4 SIL consistency check (Check MPC4 SIL Configuration
command) automatically checks the configuration of an individual safety MPC4
card (MPC4 SIL) and ensures that it meets the requirements for use in a
safety-related system, a further manual check of the complete VM600 system
configuration is required by the user in order to identify and avoid possible conflicts
from additional cards in the VM600 rack. For example, due to VM600 Raw Bus
and/or OC Bus issues.
Refer to section 1.7 Avoiding possible conflicts from additional cards in the
VM600 safety manual for further information.

Figure 6-11: Example Consistency Checks window displayed after
running the Check MPC4 SIL Configuration command
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6.5 Managing AMC8 cards (card overview page)
If an AMC8 card is selected from the configuration tree structure, a overview page for that
card is displayed in the VM600 MPS1 Configuration Editor main window. A typical example
is shown in Figure 6-12.

The Rack Information part of the window contains three non-editable fields:

The Station and Machine columns are reserved for the VM600 MPS2 software package.

NOTE: Refer to the VM600 MPS2 configuration software for VM600 machinery protection
systems (MPSs) software manual for further information.

Some descriptive text concerning the measurement point may be found in the Sensor
column. This text is copied from the text entered in the Tag field of the Input Configuration
tab (Inputs/Processing \ Channel n branch of tree structure selected). See 12 Configuring
inputs and processing functions (AMC8).
A customised picture may be placed in the picture area. See 6.6 Displaying a customised
picture on the card overview page for further information.

Location Indicates which database the rack is attributed to.

Rack Tag Identifies the rack in which the AMC8 card is inserted.

Slot Number Indicates the slot of the rack in which the AMC8 card is inserted.

Figure 6-12: VM600 MPS1 Configuration Editor main Window at AMC8 card level
(card overview page)

Picture
area
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6.5.1 Drop-down menus and toolbar (with an AMC8 card selected)
The contents of the drop-down menus are shown in Figure 6-13. This figure also explains the
elements in the toolbar.

The File drop-down menu contains the following choices:

Import Raw AMC Configuration Loads an AMC8 card configuration from a
pre-existing configuration file (*.cfg).

Export Raw AMC Configuration Saves an AMC8 card configuration in an external
configuration file (*.cfg).

Save – save the changes to the configuration

Summary – display the summary sheet for the AMC8 card

Figure 6-13: Drop-down menus and toolbar at AMC8 card level

Read Outputs – display the AMC outputs window for the AMC8 card

Refresh – refresh the information displayed in the AMC8 card overview page

Send – send the card configuration to the AMC8 card
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The Communications drop-down menu allows principally the AMC8 configuration
information to be sent to the card and measured values to be read back from it. The
Communications menu also allows channel inhibit commands to be sent to individual AMC8
channels in order to temporarily bypass a sensor (that is, temporarily inhibit any associated
relays). See 15 Communications menu (AMC8) for further information on all the menu
functions.
The Privileges drop-down menu allows one of the four privilege levels to be set and
passwords to be changed. See 4.2.1 Selecting the privilege level for further information.
The Help drop-down menu allows the offline help concerning the VM600 MPS1 software to
be accessed.

6.5.2 Shortcut menu (with an AMC8 card selected)
A shortcut menu is also available and is displayed when an AMC8 card-level node in the tree
structure is right-clicked.
The commands available from the shortcut menu are the same as those available from the
File drop-down menu (see 6.5.1 Drop-down menus and toolbar (with an AMC8 card
selected)).

6.6 Displaying a customised picture on the card overview page
The picture area on the card overview page (see Figure 6-8 or Figure 6-12) displays a bitmap
picture called image_Rack-Tag_n.bmp
where:
• Rack-Tag corresponds to the name entered in the Tag field of the rack General

Information tab (see 6.3 Managing racks). 
• n corresponds to the value entered in the Slot Number field. Note that n is an integer

between 3 and 14.
Examples of typical names are:
1- image_Rack 1_3 (For a card in Slot 3 of the rack having the tag “Rack 1”)
2- image_TESTRACK_14 (For a card in Slot 14 of the rack having the tag “TESTRACK”)

NOTE: The text entered for Rack-Tag is case-sensitive and must exactly match the text
that was entered in the Tag field (pay attention to spaces and capital letters).

Dump to File Saves an AMC8 card configuration in an external
file using a comma-separated values file format
(*.csv).
This facilitates subsequent data processing.

Add Card to Rack Adds a new AMC8 card to the rack presently
selected.

Delete AMC8 Deletes the AMC8 card highlighted by the mouse
pointer.

Exit Exits (stops) the VM600 MPS1 software.
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If image_Rack-Tag_n.bmp is not found, the picture image0.bmp (which is delivered with
the VM600 MPS1 software) is displayed instead.
To produce a customised, slot-specific picture to display in the picture area of the overview
page:
1- Size an image to 256x266 pixels (horizontally and vertically, respectively) using a

commercially available image editing package.
2- Transform it into bitmap format (.bmp).
3- Name the file image_Rack-Tag_n.bmp and place it in the \VM600_MPS\IMAGE

sub-directory on your hard drive (this already contains the file image0.bmp).
The program mps1.exe automatically calls this image when running.

6.7 Displaying configuration details for cards
A summary sheet detailing the card configuration (MPC4, MPC4 SIL or AMC8) can be
obtained by clicking the Summary button on the toolbar at the top of the card overview
page (see Figure 6-8 or Figure 6-12). A Summary Sheet window similar to that shown in
Figure 6-14 appears. This provides configuration details for all channels.
The summary sheet contains Print and Save icons in a toolbar at the top of the window.
The information on the summary sheet can be saved to hard disk as a plain text file (.txt
file name extension). This allows the summary information to be copied, printed, emailed and
so on.

Figure 6-14: Typical Summary Sheet window
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7 INPUT CONFIGURATION (MPC4 AND MPC4 SIL)

7.1 Introduction
This section describes the Inputs branch of the configuration tree structure that is visible
when an MPC4 or MPC4 SIL card is selected (see Figure 7-1). This branch allows sensor
characteristics for the four measurement channels and two speed channels to be configured. 

7.2 Configuring measurement channels

7.2.1 Configuration procedure
Select the Measurement Channels node in the configuration tree structure to obtain a
window resembling that shown in Figure 7-2. Note that the window has four tabs, allowing the
configuration of Channel 1, Channel 2, Channel 3 and Channel 4. The principle is the same
for each of these four channels.
To configure a given measurement channel input:
1- Choose the channel you want to configure (1 to 4) by clicking the appropriate tab at the

top of the window.
2- Define the type of front-end equipment used by selecting the sensor family, the sensor

type and the conditioner type:
• The Sensor Family field indicates the type of signal to acquire:

Figure 7-1: Structure of the Inputs branch of the configuration tree
structure for an MPC4 

(AC) Dynamic Input For absolute bearing vibration, dynamic pressure
measurements and so on.

(DC) Quasi-Static Input For process data, position, expansion
measurements and so on.

(ADC) Relative Vibration For measurements of signals having a mixture of AC
and DC components, for example, as provided by
proximity probes (used to measure relative shaft
vibration and shaft position).
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• Choose the sensor from the Sensor Type list.

• Choose the conditioner from the Conditioner list.
The VM600 MPS1 software automatically sets up certain fields on the tab.

To ensure measurement accuracy, enter the exact Signal Sensitivity value accord-
ing to the vibro-meter® test certificate, from Meggitt.

NOTE: If you are not using a Meggitt vibro-meter® front-end (sensor/measurement chain),
choose the Generic (non VibroMeter) option from the Sensor Family menu and
enter the specifications manually. Alternatively, select an equivalent front-end from
the list of Meggitt vibro-meter® devices.

3- Enter the sensor tag and set the Sensor Connected field to “Yes”.
4- Click the Save icon on the toolbar to save the configuration in memory.

Figure 7-2: Window for configuration of measurement channel inputs
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7.2.2 Additional information on fields
The operator should find most of the field labels self-explanatory. However, the following
explanations are given here for further information.

Sensor Tag This field allows a tag to be entered to facilitate recognition of the
sensor.
The tag is automatically copied to certain other windows (for example,
it is visible in the Signal I/P field of the Function tab when the
Processing branch of the tree structure is selected).
Default tags are applied if the user does not enter any himself. These
have the form x.y where x is the card’s slot number and y is the
channel identifier.

Sensor 
Connected

Should be set to Yes for normal operation.

Signal Dynamic This corresponds to the absolute value of the dynamic range to be
measured.
The VM600 MPS1 software provides a default value for the dynamic
range, but if the actual value for a given application is known to be
much lower, then this value should be entered here.

Sensor Power 
Supply

This field is set up automatically when Meggitt vibro-meter® sensors
and conditioners are chosen in the Sensor Type and Conditioner
fields. It should only be configured manually when the Sensor Family
field is set to Generic (for non vibro-meter® devices). 
Refer to the VM600 machinery protection system (MPS) hardware
manual for further information.

Signal 
Transmission 
Mode

This field is set up automatically when Meggitt vibro-meter® sensors
and conditioners are chosen in the Sensor Type and Conditioner
fields. It should only be configured manually when the Sensor Family
field is set to Generic (for non vibro-meter® devices).
Refer to the VM600 machinery protection system (MPS) hardware
manual for further information.

Upper OK Level, 
Lower OK Level

The OK levels are used to monitor the incoming signal for problems
arising in the front end of the measuring chain. These problems can
be due to, for example, a defective sensor or signal conditioner, a
faulty transmission line (open or short circuit). 

The OK levels are set by default when one of the Meggitt vibro-meter®

sensors is selected.
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7.3 Configuring speed channels

7.3.1 Configuration procedure
Select the Speed Channels node in the configuration tree structure to obtain a window
resembling that shown in Figure 7-3. Note that the window has two tabs, allowing the
configuration of Channel 1 and Channel 2. The principle is the same for both of these
channels.
To configure a given speed channel input:
1- Choose the channel you want to configure (1 or 2) by clicking the appropriate tab at the

top of the window.
2- Define the type of front-end equipment used by entering successively the sensor type,

the conditioner type.
The VM600 MPS1 software automatically sets up certain fields on the tab. 

NOTE: If you are not using a Meggitt vibro-meter® front-end, choose the
Generic (non Vibro-Meter) option from the Sensor Family menu and enter the
specifications manually. Alternatively, select an equivalent front-end from the list of
vibro-meter® devices.

3- Enter a name in the Sensor Tag field (or simply accept the default tag proposed by the
software).

4- If the tacho signal is obtained via the corresponding IOC (placed directly behind the
MPC4 in the rack), set the Sensor Connected field to “Local”. If it is obtained from Tacho
Bus line n, choose the appropriate option Remote Channel n (where n is a value between
1 and 6).

5- Choose the speed unit (Hz or RPM).
The speed alarm and hysteresis values are communicated to the MPC4 card in
hundredths of Hertz (that is, the format is xxx.xx Hz). Values entered in RPM are rounded
to the nearest hundredth of Hertz.

6- Select either “Rising” or “Falling” in the Edge of Detection field.
7- Enter the tacho ratio. To do this, enter the decimal value of the tacho ratio multiplied by

1000 or 10000 in the Tacho Ratio Multiplier field and enter 1000 or 10000 in the Tacho
Ratio Divider field.
Example: If the tacho ratio is 3.263, enter:

Tacho Ratio Multiplier = 3263

Tacho Ratio Divider = 1000

Wheel Teeth # (Hardware Divider) = 1.

Do not set the Multiplier, Divider or Wheel Teeth # fields to 0. The multiplier and
divider must have a value in the range 1 to 65535. The Wheel Teeth # field must have
a value in the range 1 to 255.

NOTE: If the tacho ratio is not “1”, the signal cannot be used for a phase reference, but
only for speed calculation.
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8- Configure the open collector alarm outputs. The lower half of the window allows the
following parameters to be set for the upper Alert level (A+) and lower Alert level (A−):
the alarm level, hysteresis value, alarm delay time, whether alarm enabled/disabled,
whether alarm latched/unlatched.
The signal level must be over (or under, in the case of low-level alarms) the alarm level
(including the hysteresis value) for longer than the alarm delay time before an alarm is
generated.

NOTE: The range of alarm delay values supported by the speed channels of an
MPC4 card is 0 to 60 seconds with a resolution of 0.1 second (100 milliseconds).
Correct operation cannot be guaranteed if a value outside the supported range of
alarm delay values is configured.

Figure 7-3: Window for configuration of speed channel inputs
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7.3.2 Additional information on fields
The operator should find most of the field labels self-explanatory. However, the following
explanations are given here for further information.

Sensor Tag This field allows a tag to be entered to facilitate recognition of the
sensor. The tag is automatically copied to certain other windows, for
example, it is visible in the Point column of the MPC4 card overview
page (see  6.4 Managing MPC4 and MPC4 SIL cards (card overview
page)).
Default tags are applied if the user does not enter any himself. These
have the form x.y where x is the card’s slot number and y is the
channel identifier.

Sensor
Connected

Should be set to Yes for normal operation.

Signal
Transmission
Mode

This field is set up automatically when Meggitt vibro-meter® sensors
and conditioners are chosen in the Sensor Type and Conditioner
fields. It should only be configured manually when the Sensor Family
field is set to “Generic” (for non vibro-meter® devices).
Refer to the VM600 machinery protection system (MPS) hardware
manual for further information.

Upper OK Level,
Lower OK Level

The OK levels are used to monitor the incoming signal for problems
arising in the front end of the measuring chain. These problems can
be due to, for example, a defective sensor or signal conditioner, a
faulty transmission line (open or short circuit). 

The OK levels are set by default when one of the Meggitt vibro-meter®

sensors is selected.

Tachometer
Output

Allows the user to route the speed signal onto one of the six Tacho
Bus lines.

Wheel Teeth # Number of “marks” (teeth or notches) on the circumference of the
wheel used for measuring the rotational speed.
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7.4 Copying card configurations
When configuring MPC4 and MPC4 SIL cards, copy operations are supported that allow the
Inputs or Processings and Alarms already configured for an MPC4 or MPC4 SIL card to be
re-used elsewhere on the same card.
Using the copy operations for MPC4 and MPC4 SIL card configurations helps to make the
management of VM600 MPS Software configurations easier. For example, the Inputs,
Processing (and Alarms) could be configured for one channel of the card and then re-used
as the basis for other similar channels on the same card.
The Copy Inputs command is available for operation with the Inputs of an MPC4 or
MPC4 SIL card (Measurement channels 1 to 4 and Speed Channels 1 to 2).
The Copy Processings and Alarms command is available for operation with the
Processing of an MPC4 or MPC4 SIL card (Processing channels 1 to 4, Dual Processing
channel 1 & 2 and Dual Processing channel 3 & 4) including any alarms configured for the
processing channel.
To use the copy operation commands:
• Click on an MPC4 or MPC4 SIL card level node in the configuration tree to select it, then

use the File > Copy Inputs and File > Copy Processings and Alarms menu
commands.
Alternatively, right-click on an MPC4 or MPC4 SIL card level node in the configuration
tree, then click Copy Inputs or Copy Processings and Alarms.

• Then use the copy dialog box that appears to select the Channel or Processing Channel
to copy from and the Channel or Processing Channel to copy to.

NOTE: The copy operations for MPC4 and MPC4 SIL card configurations are limited to the
same card (not between different MPC4 or MPC4 SIL cards) and work on a
channel basis, that is, the configuration of a single input channel can be copied to
another single input channel.
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8 PROCESSING CONFIGURATION (MPC4 AND MPC4 SIL)

8.1 Introduction
This section describes the Processing branch of the configuration tree structure, visible
when an MPC4 or MPC4 SIL card is selected (see Figure 8-1). This branch allows each
processing channel to be assigned to specific input sensors (for example, vibration, dynamic
pressure, speed). All aspects of the signal processing are defined here, including the
processing function (for example, Broad Band Absolute Bearing Vibration or Relative Shaft
Vibration), filtering characteristics, measurement units and alarm parameters.

NOTE: The MPC4 machinery protection card is available in different versions, including a
standard version, a separate circuits version and a safety (SIL) version.
The MPC4 SIL (safety MPC4 card) does not provide all of the signal processing
capabilities of the standard and the separate circuits versions of the MPC4.
See 8.3 Additional information on processing functions.

For an improved understanding of the possibilities offered, it is recommended to refer to the
description of the various processing functions given in the VM600 machinery protection
system (MPS) hardware manual.

8.2 Configuring a processing channel
To configure a given processing channel:
1- Select the channel you wish to configure from the Processing branch of the

configuration tree structure. This can be a single channel (Channel 1, Channel 2,
Channel 3, Channel 4) or a dual channel (Channels 1&2, Channels 3&4).
In all cases, a window resembling that shown in Figure 8-2 appears. Note that the
window has two or three tabs, depending on whether a single or dual channel is chosen:

• Function:
Used to attribute an input channel (vibration sensor / speed sensor) to the process-
ing channel.

Also used to configure the processing function and other processing parameters (for
example, filter characteristics).

Figure 8-1: Structure of the Processing branch of an MPC4 configuration tree structure
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• Processed Output (1/2):
Used to configure the measurement units, rectifier characteristics and so on.

Alarm parameters and adaptive monitoring parameters are also configured here.
For single channels, two independent outputs (Output 1 and Output 2) can be con-
figured using the Processed Output 1 and Processed Output 2 tabs, respectively.

For dual channels, one output (Output 1) can be configured using the
Processed Output 1 tab.

2- Select the Function tab. A window resembling that shown in Figure 8-2 appears.
3- Choose the desired processing function from the list available in the Function field.

For single channel processing, this list includes:
• (BBAB) Broad Band Absolute Bearing Vibration
• (NB) Narrow Band (Tracking) Vibration
• (RS) Relative Shaft Vibration
• (PS) Position
• (EC) Eccentricity
• (HE) Absolute Housing Expansion
• (SEP) Relative Shaft Expansion with Pendulum
• (BBP) Broad Band Pressure
• (QSP) Quasi-Static Pressure
• (QST) Quasi-Static Temperature
• (NBFS) Narrow Band Fixed Frequency.

For dual channel processing, this list includes:
• (SMAX) Smax
• (DHE) Differential Housing Expansion
• (RST) Relative Shaft Expansion (Shaft taper)
• (RSC) Relative Shaft Expansion (Shaft collar)
• (DQSP) Delta Quasi-Static Pressure
• (DQST) Delta Quasi-Static Temperature
• (AS) Absolute Shaft Vibration
• (DMF) Dual Mathematical Function.

NOTE: More detailed information on these functions is given in 8.3 Additional information
on processing functions

4- Choose the input sensor you want to associate with the processing channel.
To do this, select an option from the Signal Input, Speed Input or One Per Rev fields,
as appropriate. Some these fields are unavailable (dimmed) depending on the function
chosen.

5- Configure the other fields on the Function tab.
The fields visible on the tab depend on the processing function chosen.
See 8.3 Additional information on processing functions for further information.

6- Select the Processed Output 1 or Processed Output 2 tab, as appropriate. These two
tabs each give access to another three tabs named General, Alarms and Adaptive
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Monitoring. If the General tab is selected, a window resembling that shown in
Figure 8-3 appears.

NOTE: Further information on the Processed Output \ General tab is given in
8.4 Parameter fields found on the “Processed Output” tabs

7- From the Processed Output tab, select the Alarms tab to set up alarm parameters.

NOTE: Further information on the Processed Output \ Alarms tab is given in
8.5 Configuring alarms

8- From the Processed Output tab, select the Adaptive Monitoring tab to set up Direct
Trip Multiply and Adaptive Monitoring parameters.

NOTE: Further information on the Processed Output \ Adaptive Monitoring tab is
given in 8.6 Adaptive monitoring and direct trip multiply

Figure 8-2: Typical window when the “Function” tab is selected
(example for Broad Band Absolute Bearing Vibration processing function)
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8.3 Additional information on processing functions
The MPC4 machinery protection card is available in different versions, including a standard
version, a separate circuits version and a safety (SIL) version. The MPC4 SIL (safety MPC4
card) does not provide all of the signal processing capabilities of the standard and the
separate circuits versions of the MPC4.
For example, the MPC4 SIL card does not support the speed/phase reference (tachometer)
input channels, the Narrow Band (Tracking Vibration and Smax processing functions, and it
does not support danger bypass (DB) and trip multiply (TM) functions.

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual and
VM600 safety manual for further information.

Figure 8-3: Typical window when the “Processed Output” tab is selected
(example for Broad Band Absolute Bearing Vibration processing function)
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8.3.1 Broad band absolute bearing vibration
This processing function performs low-pass, band-pass and high-pass filtering. The cut-off
frequencies can be chosen in the range 0.1 to 10 kHz. The frequencies are defined at the
−0.1 dB cut-off point.
The ratio between the high and low cut-off frequencies can be set to a value of up to 500 if
there is no integration, or up to 100 with integration.

NOTE: The MPC4 card has two on-board integrators: one hardware (that is, analogue
integration using electronic circuitry) and one firmware (that is, digital integration
using a DSP). There are therefore multiple possible integration configurations:
1. No integrator
2. One integration 
3. Two integrations.
The choice is made using the Sensor Input Unit and Engineering unit
(processing output) fields:
1. Sensor Input Unit = “g” and Engineering unit = “g” =>  No integrator.
2. Sensor Input Unit = “g” and Engineering unit = “mm/s” => 1 integration (HW).
3. Sensor Input Unit = “g” and Engineering unit =”µm” => 2 integrations (HW 

and FW).

The filter slopes can be chosen in the range 6 to 60 dB/oct. The slopes for the high-pass and
low-pass filters may be set differently.

NOTE: Improved filter characteristics may be achieved for specific applications. Contact
your Meggitt representative for further information.

The Typical Function and Processed Output windows are shown in Figure 8-2 and Figure 8-3
respectively.

It is important to note that when a Broad band absolute bearing vibration (BBAB) processing
function (single-channel) is used as an input to an Absolute shaft vibration (AS) processing
function (dual-channel), there are certain configuration restrictions on the BBAB processing
in order to ensure appropriate digital integration of the measurement signal by the MPC4
card, as required by the AS processing.

NOTE: The synchronisation of signals for Absolute shaft vibration (AS) processing
requires that only digital integration is used (since analogue integration using
electronic circuitry introduces phase distortion). See also 8.3.13 Absolute shaft
vibration.

8.3.2 Narrow band (tracking) vibration
This processing function filters the signal with a constant-Q filter (Q=28) around the selected
harmonic.
It is necessary to define both the speed input and the phase reference input. This is done
using the Speed I/P and One Per Rev fields, respectively (see Figure 8-4). In order to obtain
meaningful phase information, the phase reference must provide only one pulse per
revolution.
The tracking function follows speed variations in real time. The harmonic to be processed
(1X, 2X, 3X, 4X, 1/2 X, 1/3 X) can be selected in the Harmonic to Process field.
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The calculation is restricted to a frequency band defined by the Tracking Frequency Lower
Limit and Tracking Frequency Upper Limit fields. Tracking is not be performed outside this
band.
The Sensor Original Position field allows the phase to be compensated for a given
mounting angle (possible values are 0 to 359°). This angle is subtracted from the
measurement.
For this processing function, the two Processed Output tabs are replaced by the Amplitude
and Phase tabs.
Typical Function, Amplitude and Phase tabs are shown in Figure 8-4 and Figure 8-5.

Figure 8-4: Typical “Function” window for
Narrow Band (Tracking) Vibration processing function

Figure 8-5: Typical “Amplitude” and “Phase” windows for
Narrow Band (Tracking) Vibration processing function
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8.3.3 Relative shaft vibration
This function processes the AC (0.1 to 10 kHz) and DC (0 to 1 Hz) components of a signal
coming from an “ADC” type probe (for example, a proximity probe). It can provide vibration
and gap values from a single input channel. The rectified vibration data is routed to the first
output, and the gap value to the second output.
If phase information is required, a speed channel must be named in the One Per Rev field.
The value entered in the Proximity Probe Initial Gap field is subtracted from the measured
value. The resulting gap measurements are centred around this initial (mean) position.
The Bandwidth field allows high frequencies to be filtered out if spurious spikes are present
in the raw signal. This bandwidth should be set to a value exceeding 20 times the rotational
frequency, so that the signal waveform is not disturbed by the filter. For example, if the
rotational speed is 3000 RPM, corresponding to 50 Hz, a bandwidth in excess of 1000 Hz
should be chosen. The maximum bandwidth that can be set is 10 kHz.
For this processing function, the Processed Output 1 and Processed Output 2 tabs are
replaced by the Measurement and Gap tabs, respectively.
Typical Function, Measurement and Gap tabs are shown in Figure 8-6 and Figure 8-7.

Figure 8-6: Typical “Function” tab for
Relative Shaft Vibration processing function
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8.3.4 Position
This function processes DC signals representing, for example, the position of a shaft in a
thrust bearing or the expansion of a machine element due to thermal effects.
Choose the unit in which you wish to express the position by setting the Engineering Unit
field on the Processed Output tab. (The unit can be µm, mm, mils or user-defined.)
The value in the Sensor Offset field (µA or mV) is first subtracted from the measured value.
Next, the value in the Proximity Probe Initial Gap field is subtracted from the measured
value after conversion to the physical unit. The initial gap is expressed as an integer value in
the selected engineering unit. Select microns (µm) for greatest accuracy.
If you want to reverse the sign of the measurement, select the Sensor Inverted button.
Otherwise, if you want a direct measurement (positive direction for positive voltage or
current), select the Direct Sensor button.
The Position processing function can be used in conjunction with the dual channel mode to
measure:
• Differential housing expansion (DHE)
• Relative shaft expansion (RSC) with collar
• Relative shaft expansion (RST) with single or double shaft taper.
If this is to be done, both single channels making up the dual channel pair (that is,
Channel 1 + Channel 2, or Channel 3 + Channel 4) must be configured for Position
processing.
Typical Function and Processed Output windows are shown in Figure 8-8 and Figure 8-9
respectively.

Figure 8-7: Typical “Measurement” and “Gap” windows for
Relative Shaft Vibration processing function
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Example set-up
An AE 119 transducer provides an output of 4 to 20 mA.
If a direct positive measurement is required, enter 4000 µA in the Sensor Offset field.
If you want a reversed output from the same transducer, select the Sensor Inverted button
and enter 20000 µA in the Sensor Offset field.
Enter a value in the Proximity Probe Initial Gap field corresponding to the gap when the
machine is cold (this is often around 10 mm).

Figure 8-8: Typical “Function” tab for Position processing function

Figure 8-9: Typical “Processed Output” tab for Position processing function
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8.3.5 Eccentricity
This processing function outputs the eccentricity of a shaft measured by a proximity probe.
The function extracts the peak-to-peak level at low frequency. 
The upper cut-off frequency (defined by a low-pass filter) is set to 5 Hz by default. However,
this can be configured to a value between 5 and 10 Hz if desired using the Low Pass Cut-Off
Frequency field. The filter slope is also configurable in the range 6 to 60 dB/oct.
Peak-to-Peak and Peak-to-Peak per Revolution rectifiers are available. In the case of
Peak-to-Peak per Revolution, the minimum and maximum values are recorded for each
revolution of the shaft. This option is recommended.
When Peak-to-Peak rectification is chosen, the minimum frequency considered is 2 Hz
(corresponding to a rotational speed of 120 RPM).
When Peak-to-Peak per Revolution rectification is chosen, frequencies down to DC (0 Hz)
are considered.
If strong harmonics are seen on the signal, adjust the upper cut-off frequency (using the Low
Pass Cut-Off Frequency field) in order to filter out these unwanted components and keep
only the first orders.
Typical Function and Processed Output tabs are shown in Figure 8-10 and Figure 8-11
respectively.

Figure 8-10: Typical “Function” tab for Eccentricity processing function
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8.3.6 Absolute housing expansion
This processing function is similar to the Position processing function. 

NOTE: See 8.3.4 Position for further information on fields that can be configured.
An example set-up is also provided.

Typical Function and Processed Output tabs are shown in Figure 8-12 and Figure 8-13
respectively.

Figure 8-11: Typical “Processed Output” tab for Eccentricity processing function

Figure 8-12: Typical “Function” tab for
Absolute Housing Expansion processing function
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8.3.7 Relative shaft expansion with pendulum
This processing function is similar to the Position processing function.

NOTE: See 8.3.4 Position for further information on fields that can be configured.
An example set-up is also provided.

Typical Function and Processed Output tabs are shown in Figure 8-14 and Figure 8-15
respectively.

Figure 8-13: Typical “Processed Output” tab for
Absolute Housing Expansion processing function

Figure 8-14: Typical “Function” tab for Relative Shaft Expansion
with Pendulum processing function
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8.3.8 Broad band pressure
This processing function is identical to that for Broad Band Absolute Bearing Vibration
processing, with the exception that a dynamic pressure probe must be selected in the Sensor
Type field (visible when Inputs \ Measurement Channels branch of tree structure selected). 

NOTE: See 8.3.1 Broad band absolute bearing vibration for further information on
broad-band processing.

Typical Function and Processed Output tabs are shown in Figure 8-16 and Figure 8-17
respectively.

Figure 8-15: Typical “Processed Output” tab for Relative Shaft Expansion
with Pendulum processing function

Figure 8-16: Typical “Function” tab for
Broad Band Pressure processing function
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8.3.9 Quasi-static pressure
This processing function is similar to the Position processing function (see 8.3.4 Position),
but with pressure measurement units.
A quasi-static pressure probe must first be defined. Select the Inputs \ Measurement
Channels branch of the tree structure and set the following two fields as shown:

Choose the unit in which you wish to express the pressure by setting the Engineering Unit
field on the Processed Output tab (see Figure 8-19). The unit can be mbar, bar, psi, Pa or
user-defined.
The value in the Sensor Offset field (µA or mV) is first subtracted from the measured value.
Next, the value in the Static Pressure Compensation field is subtracted from the measured
value after conversion to the physical unit. The initial (or reference) pressure is expressed as
an integer value in the selected engineering unit. Select pascals (Pa) for greatest accuracy.
If you want to reverse the sign of the measurement, select the Sensor Inverted button.
Otherwise, if you want a direct measurement (positive pressure for positive voltage or
current), select the Direct Sensor button.
Typical Function and Processed Output tabs are shown in Figure 8-18 and Figure 8-19
respectively.

Figure 8-17: Typical “Processed Output” tab for
Broad Band Pressure processing function

Sensor Family (DC) Quasi-Static Input.

Sensor Type DC P[bar].
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Figure 8-18: Typical “Function” tab
for Quasi-Static Pressure processing function

Figure 8-19: Typical “Processed Output” tab for
Quasi-Static Pressure processing function
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8.3.10 Quasi-static temperature
This processing function is similar to the Position processing function (see 8.3.4 Position),
but with temperature measurement units.
A quasi-static temperature probe must first be defined. Select the Inputs \ Measurement
Channels branch of the tree structure and set the following two fields as shown:

Choose the unit in which you wish to express the temperature by setting the Engineering
Unit field on the Processed Output tab (see Figure 8-21). The unit can be degs (C), meaning
degrees Celsius, or user-defined.
The value in the Sensor Offset field (µA or mV) is first subtracted from the measured value.
Next, the value in the Static Temperature Compensation field is subtracted from the
measured value after conversion to the physical unit. The initial (or reference) temperature is
expressed as an integer value in the selected engineering unit.
If you want to reverse the sign of the measurement, select the Sensor Inverted button.
Otherwise, if you want a direct measurement (positive temperature for positive voltage or
current), select the Direct Sensor button.
Typical Function and Processed Output tabs are shown in Figure 8-20 and Figure 8-21
respectively.

Sensor Family (DC) Quasi-Static Input.

Sensor Type DC T[°C].

Figure 8-20: Typical “Function” tab
for Quasi-Static Temperature processing function



Document reference MAMPS1-SW/E SOFTWARE MANUAL
Edition 12 - February 2021 VM600 MPS1 software

8 - 17

Additional information on processing functions
PROCESSING CONFIGURATION (MPC4 AND MPC4 SIL)

Figure 8-21: Typical “Processed Output” tab 
for Quasi-Static Temperature processing function
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8.3.11 Narrow band fixed frequency
This processing function produces a narrow-band filtered output (Q=28), where the filter
centre frequency is a user-configurable rotational speed value (this is defined in the Center
Speed in RPM field). The filtered signal can represent absolute or relative vibration, dynamic
pressure and so on.
This function can be used with the Dual Mathematical Function (see 8.3.19 Dual
mathematical function) to perform line frequency rejection.
For the Narrow Band Fixed Frequency function, the two Processed Output tabs are replaced
by a single one called Amplitude.
Typical Function and Amplitude tabs are shown in Figure 8-22 and Figure 8-23.

Figure 8-22: Typical “Function” tab for 
Narrow Band Fixed Frequency processing function

Figure 8-23: Typical “Amplitude” tab for 
Narrow Band Fixed Frequency processing function
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8.3.12 Smax 

The Smax processing function requires a dual processing channel to be used (that is,
Channels 1&2 or Channels 3&4).
It is first necessary to configure both corresponding single channels to perform the Relative
Shaft Vibration processing function.
Furthermore, for the Smax calculation to be possible, both single channels must be configured
with the same settings. These are:

For both individual channels, the bandwidth should be set to a value exceeding 20 times the
rotational frequency. For example, if the rotational speed is 3000 RPM, corresponding to
50 Hz, a bandwidth in excess of 1000 Hz should be chosen.
The product of (Sensitivity x Dynamic) must match within 1% accuracy.
If the sensitivity and range correspond, the Smax value is given with the same accuracy as
the individual process channels. If there is a mismatch of x% between the sensitivities of the
two input channels, the accuracy of the Smax result is also x%, depending on the direction of
the main axis of the S vector.
Smax is expressed in the same measurement unit as that defined for both input channels.
A True Peak rectifier function is always applied.
Typical Function and Processed Output tabs are shown in Figure 8-24 and Figure 8-25
respectively.

Sensor Connected Yes.

Sensor Sensitivity Unit Must be the same.

Signal Sensitivity Must match within 10% of accuracy.

Signal Dynamic Must match within 10% of accuracy.

Signal Transmission Mode Must be the same.

Bandwidth Must be the same.
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Figure 8-24: Typical “Function” tab for Smax processing function

Figure 8-25: Typical “Processed Output” tab for Smax processing function
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8.3.13 Absolute shaft vibration
The Absolute Shaft Vibration processing function requires a dual processing channel to be
used (that is, Channels 1&2 or Channels 3&4).
It is first necessary to configure one of the corresponding single channels to perform the
Broad Band Absolute Bearing Vibration processing function and the second single channel
to perform the Relative Shaft Vibration processing function.
Typical Function and Processed Output tabs are shown in Figure 8-26 and Figure 8-27
respectively.

Figure 8-26: Typical “Function” tab for 
Absolute Shaft Vibration processing function

Figure 8-27: Typical “Processed Output” tab for 
Absolute Shaft Vibration processing function
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As shown in Figure 8-26, the Angle between the two sensors (deg) corresponds to the
relationship (relative installation and connection) between the two sensors used to provide
the absolute shaft displacement (output from Broad Band Absolute Bearing Vibration
processing) and the relative shaft displacement (output from Relative Shaft Vibration
processing) measurements used by the Absolute Shaft Vibration processing function.
When configuring the Function tab (see Figure 8-26), the Angle between the two
sensors (deg) must be configured as follows:
• Angle between the two sensors: 0° when the sensors are installed and measure in

the same direction and have the same polarity ( ).
This is so that the Absolute Shaft Vibration is calculated as: AS = BBAB + RS
(that is, the signals must be added).

• Angle between the two sensors: 180° when the sensors are installed and measure in

opposite directions or one has reversed polarity ( ).

This is so that the Absolute Shaft Vibration is calculated as: AS = BBAB − RS
(that is, the signals must be subtracted).

For example, an Angle between the two sensors (deg) of 0° corresponds to a ‘vertical’ sensor
installation, where:
• The seismic transducer (accelerometer or velocity sensor) is installed above the

proximity transducer, ‘pointing’ up away from the shaft, that is, with the direction of
movement to provide a positive signal being up. 

• The proximity probe is installed below the seismic transducer, ‘pointing’ down towards
the shaft, that is, with the direction of movement to provide a positive signal being up.

As shown in Figure 8-27, when configuring the Processed Output tab:
• The Output Used must be configured as Yes.
• The Engineering Unit must be configured in displacement units (µm, mm or mils).
• The Rectifier Function can be configured independently of the rectifier function used for

the corresponding single-channel processing functions (BBAB and RS).

NOTE: The Rectifier Function can be configured independently as the MPC4 card
performs Absolute shaft vibration (AS) processing using the raw waveform
signals from the two processing functions (BBAB and RS) before their
respective rectification and output extraction.

The recommended Rectifier Function is RMS Scaled Peak-To-Peak.

It is also important to note that for the Absolute shaft vibration (AS) processing function, there
are configuration restrictions on the Broad Band Absolute Bearing Vibration processing
(BBAB) function used to provide the required absolute shaft displacement measurement.
This BBAB restriction is required in order to ensure appropriate digital integration of the
measurement signal by the MPC4 card, as required by the AS processing.
Accordingly, when Broad-band absolute bearing vibration (BBAB) processing using an
accelerometer is used to provide the absolute shaft displacement:
• One BBAB processed output must be configured in acceleration units (g, m/s**2 or

inch/s**2) and the other processed output must be configured in displacement units (µm,
mm or mils).
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Similarly, when Broad-band absolute bearing vibration (BBAB) processing using a velocity
sensor (or a velocity signal) is used to provide the absolute shaft displacement:
• One BBAB processing output must be configured in velocity units (mm/s or inch/s) and

the other processed output must be configured in displacement units (µm, mm or mils).
See also 8.3.1 Broad band absolute bearing vibration.

8.3.14 Differential housing expansion
The Differential Housing Expansion processing function requires a dual processing channel
to be used (that is, Channels 1&2 or Channels 3&4).
It is first necessary to configure both corresponding single channels to perform either:
• The Position processing function (see 8.3.4 Position) or
• The Absolute Housing Expansion processing function (see 8.3.6 Absolute housing

expansion)
Both single channels must perform the same processing function (that is, it is not possible to
have one processing Position and the other processing Absolute Housing Expansion).
The Sensor Inverted / Direct Sensor buttons must be configured identically for the two
single channels.
Typical Function and Processed Output tabs are shown in Figure 8-28 and Figure 8-29
respectively.

Figure 8-28: Typical “Function” tab for
Differential Housing Expansion processing function
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8.3.15 Relative shaft expansion with shaft taper
The Relative Shaft Expansion with Shaft Taper processing function requires a dual
processing channel to be used (that is, Channels 1&2 or Channels 3&4).
It is first necessary to configure both corresponding single channels to perform the Position
processing function (see 8.3.4 Position).
If a single shaft taper is used, enter the taper angle (degrees) in the First Channel Proximity
Probe Mounting Angle field. You should set the Second Channel Proximity Probe
Mounting Angle field to 0.
If a double shaft taper is used, enter the taper angles (degrees) in the First Channel
Proximity Probe Mounting Angle field and Second Channel Proximity Probe Mounting
Angle field.
The measurement polarity is positive if the shaft moves in the direction from probe 1 to
probe 2.
Typical Function and Processed Output tabs are shown in Figure 8-30 and Figure 8-31
respectively.

Figure 8-29: Typical “Processed Output” tab for 
Differential Housing Expansion processing function
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Figure 8-30: Typical “Function” tab for Relative Shaft Expansion
with Shaft Taper processing function

Figure 8-31: Typical “Processed Output” tab for Relative Shaft Expansion
with Shaft Taper processing function
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8.3.16 Relative shaft expansion with shaft collar
The Relative Shaft Expansion with Shaft Collar processing function requires a dual
processing channel to be used (that is, Channels 1&2 or Channels 3&4).
It is first necessary to configure both corresponding single channels to perform the Position
processing function (see 8.3.4 Position).
Typical Function and Processed Output tabs are shown in Figure 8-32 and Figure 8-33
respectively.

Figure 8-32: Typical “Function” tab for Relative Shaft Expansion
with Shaft Collar processing function

Figure 8-33: Typical “Processed Output” tab for Relative Shaft Expansion
with Shaft Collar processing function
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8.3.17 Delta quasi-static pressure
The Delta Quasi-Static Pressure processing function requires a dual processing channel to
be used (that is, Channels 1&2 or Channels 3&4).
It is first necessary to configure both corresponding single channels to perform the
Quasi-Static Pressure processing function. 

NOTE: See 8.3.9 Quasi-static pressure for further information on Quasi-Static Pressure
processing.

The resulting value is given by: Delta Pressure = Pressure 1 − Pressure 2
Typical Function and Processed Output tabs are shown in Figure 8-34 and Figure 8-35
respectively.

Figure 8-34: Typical “Function” tab for 
Delta Quasi-Static Pressure processing function

Figure 8-35: Typical “Processed Output” tab for 
Delta Quasi-Static Pressure processing function
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8.3.18 Delta quasi-static temperature
The Delta Quasi-Static Temperature processing function requires a dual processing channel
to be used (either Channels 1&2 or Channels 3&4).
It is first necessary to configure both corresponding single channels to perform the
Quasi-Static Temperature processing function.

NOTE: See 8.3.10 Quasi-static temperature for further information on Quasi-Static
Temperature processing.

The resulting value is given by: Delta Temperature = Temperature 1 − Temperature 2
Typical Function and Processed Output tabs are shown in Figure 8-36 and Figure 8-37
respectively.

Figure 8-36: Typical “Function” tab for 
Delta Quasi-Static Temperature processing function
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8.3.19 Dual mathematical function
The Dual Mathematical Function (DMF) requires a dual processing channel to be used (that
is, Channels 1&2 or Channels 3&4).
This processing function supports the following mathematical operations:
• RMS Sum which performs the RMS addition of two single-processing input channels:

( (Channel 1)2 + (Channel 2)2 )0.5 or ( (Channel 3)2 + (Channel 4)2 )0.5

The RMS Sum function requires that both input channels are configured with an RMS
rectifier.

• RMS Subtraction which performs the RMS subtraction of two single-processing input
channels: ( (Channel 1)2 − (Channel 2)2 )0.5 or ( (Channel 3)2 − (Channel 4)2 )0.5

The RMS Subtraction function requires that both input channels are configured with an
RMS rectifier.

NOTE: For RMS Subtraction, if (Channel 2)2 > (Channel 1)2 or
(Channel 4)2 > (Channel 3)2 then zero (0.0) is returned.

• SUM which performs the addition of two single-processing input channels:
(Channel 1 + Channel 2) or (Channel 3 + Channel 4)
The SUM function requires that both input channels are configured with the same
rectifier.

• SUBTRACTION which performs the subtraction of two single-processing input channels:
(Channel 1 − Channel 2) or (Channel 3 − Channel 4)
The SUBTRACTION function requires that both input channels are configured with the
same rectifier.

Figure 8-37: Typical “Processed Output” tab for 
Delta Quasi-Static Temperature processing function



SOFTWARE MANUAL Document reference MAMPS1-SW/E
VM600 MPS1 software Edition 12 - February 2021
8 - 30

Additional information on processing functions
PROCESSING CONFIGURATION (MPC4 AND MPC4 SIL)

• X & Y MIN which selects the smaller value from two single-processing input channels:
Minimum { (Channel 1 , Channel 2) } or Minimum { (Channel 3 , Channel 4) }
The X & Y MIN function requires that both input channels are configured with the same
rectifier.

• X & Y MAX which selects the larger value from two single-processing input channels:
Maximum { (Channel 1 , Channel 2) } or Maximum { (Channel 3 , Channel 4) }
The X & Y MAX function requires that both input channels are configured with the same
rectifier.

In general, to use Dual Mathematical Function (DMF) processing with two single-processing
input channels, both single-processing input channels (Channel 1 & 2 or Channel 3 & 4) must
be configured with:
• The same single-channel processing function.

For example, Broad Band Absolute Bearing Vibration (BBAB) or Relative Shaft
Vibration (RS).

• Engineering Units from the same family.
For example, if Channel 1 is in µm, Channel 2 can be in mils (both being units of
displacement). Similarly, if Channel 1 is in inch/s, Channel 2 can be in mm/s (both being
units of velocity).

• Rectifier Functions from the same rectifier group.
For example, RMS, RMS Scaled AVG, RMS Scaled Peak and RMS Scaled
Peak-to-Peak are all rectifier functions from the same RMS-based rectifier group.
However, the configuration does not have to be the same for both channels, for example,
Channel 1 may be configured for RMS Scaled Peak and Channel 2 for
RMS Scaled AVG.

NOTE: The Dual Mathematical Function (DMF) processing function only operates on the
first processed output from each single-channel processing.
Refer to the VM600 machinery protection system (MPS) hardware manual for
further information.

NOTE: The Dual Mathematical Function (DMF) processing function must be set to
“No Processing” in order to change the processing function for the associated
single-processing channels.
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Typical Function and Processed Output tabs are shown in Figure 8-38 and Figure 8-39
respectively.

Figure 8-38: Typical “Function” tab for Dual Mathematical Function

Figure 8-39: Typical “Processed Output” tab for Dual Mathematical Function
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8.4 Parameter fields found on the “Processed Output” tabs
Most single processing functions can have up to two outputs (Output 1 and Output 2). These
can be set independently. For example, you can select raw vibration, expressed in g, on
Output 1, and an integrated value, expressed in mm/s, on Output 2. 

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on these outputs.

If the processing function is Relative Shaft Vibration (RS), the second output is automatically
the gap value.
If the function is Narrow Band (Tracking) Vibration (NB), the second output is automatically
the phase (measured in degrees).
The description of the following fields are shown in Figure 8-3.

Tag
This field is the identifier for the selected sensor. If this field is left blank, a default tag is
inserted automatically. This has the form x.y, where x is the card slot number and y is the
channel identifier.

Output Used
If one of the two outputs is not used, set the corresponding Output Used field to No. This
disables calculation and monitoring.

Engineering Unit
This unit may be the same as defined for the input channel (in the Sensor Sensitivity Unit
field, accessible when the Inputs \ Measurement Channels branch of the configuration tree
structure is selected), or different.
If different, the data is converted automatically, that is, integration may be performed
depending on the physical unit selected.
Example:
If the Sensor Sensitivity Unit for the input channel is g, and the Engineering Unit is mm/s,
then a single integration is performed before the rectification.
It is important to note that:
• One or two integration operations are allowed for broad-band and narrow-band

processing.
• No integration is performed if the processing function is Position, Eccentricity, or any of

the dual functions.

Rectifier Function
Peak and Peak-to-Peak are the so-called “true” rectification techniques (also known as
qualifiers). These are performed in the time domain, directly on the raw signals.
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RMS-related rectification types are all based on the RMS calculation. The values are
obtained by scaling as follows: 

The multiplication factors correspond to the scaling of a sine waveform to the different kinds
of rectification.
AVG corresponds to a mean value rectification technique. It is the average of the absolute
value of a signal, whereas the RMS value represents the square root of the average of the
squared signal. The result using AVG is slightly different from the RMS value.
N/A must be selected for DC measurement types (displacement, position, gap and so on).

Rectifier Response or Decay Time
This field is used to select the response or decay time. It is context sensitive:
If the rectification type is RMS or AVG related, it corresponds to the rectification response
time. The smaller the response time becomes, the less time it takes for the measurement to
reach its value. However, the noise on the output becomes correspondingly larger. A
common response time for general use is 400 milliseconds. The response time must be
larger that the rotation period of the machine; ideally two or three times this period.
If True Peak or True Peak-to-Peak rectification is used, the decay time is asked for. The
decay time represents the time after which the output decays down to about 10% of its value,
after the input decreases to 0 (zero). Note that with this type of rectification the response time
is immediate, therefore the rectifier catches all peaks in the signal.

Full Scale Deflection
This field is used to enter the full-scale value of the output, in the units defined in the
Engineering Unit field. If the value is signed (that is, it can be positive or negative), enter
only the positive full-scale value.
Examples:
• For an output of 0 to 100 mm/s, enter 100 as the full-scale value.
• For a position value that can lie in the range −1 to +1 mm, enter 1 as the full-scale value.

Scaled Peak 1.414 x RMS value.

Scaled Peak-to-Peak 2 x 1.414 x RMS value.

Scaled AVG (Mean) 0.900 x RMS value.
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8.5 Configuring alarms

8.5.1 General
To configure alarm parameters for a given channel:
1- Select the Alarms tab from the Processed Output channel you wish to configure and a

tab resembling that shown in Figure 8-40 appears.
2- The tab allows the following parameters to be set for the Danger+, Alert+, Alert− and

Danger− thresholds:
• The alarm level.
• The hysteresis value.
• The alarm delay time.
• Whether the alarm output enabled or disabled.
• Whether the alarm status is latched or unlatched.

NOTE: Further information is given in 8.5.2 Configuring Alert and Danger parameters.

3- If the Adaptive Monitoring feature or Direct Trip Multiply feature is required, click the
Adaptive Monitoring tab to access a window resembling that shown in Figure 8-41.
Adaptive Monitoring allows dynamic alarms to be set for measurement channels. In
transient mode (for example, during machine run-up), alarms levels are modified as a
function of a parameter such as speed.
Direct Trip Multiply allows alarm parameters for measurement channels to be scaled by
a multiplication factor when the TM input on the IOC4T card is grounded. 

NOTE: Further information is given in 8.6 Adaptive monitoring and direct trip multiply.

4- If logical combinations of alarms are required, select the Alarm Logical Combination
branch of the configuration tree structure.

NOTE: Further information is given in 9 Defining logical combinations of alarms (MPC4
and MPC4 SIL).

Figure 8-40: Tab to configure the Alert and Danger parameters
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8.5.2 Configuring Alert and Danger parameters
The tab shown in Figure 8-40 is used to configure the Alert and Danger thresholds. These
alarms act on open collector outputs which can be used to switch relays.
To map an alarm to a specific relay, select the Output Mapping \ Discrete Outputs branch of
the configuration tree structure.

NOTE: Further information is given in 10 Output mapping (MPC4 and MPC4 SIL).

The following fields may be configured (see also Figure 8-40):

Level
This must be expressed in the selected output unit (Engineering Unit). See the description of
the Processed Output tab in 8.4 Parameter fields found on the “Processed Output” tabs.
The values must be entered in decreasing order from:

Hysteresis
This must also be expressed in the selected output unit (Engineering Unit).
The hysteresis value must always be positive. It is added to the A− and D− levels and
subtracted from the A+ and D+ levels internally, to give hysteresis capability to the system. It
is advised to set a hysteresis value of about 2 to 5% of the desired full scale for the output,
but the optimum value actually depends on the noise on the output.

Delay
The signal level must be over (or under, in the case of low-level alarms) the alarm level
(including the hysteresis value) for longer than the alarm delay time before an alarm is
generated.

NOTE: The range of alarm delay values supported by the measurement channels of an
MPC4 card is 0 to 60 seconds with a resolution of 0.1 second (100 milliseconds).
Correct operation cannot be guaranteed if a value outside the supported range of
alarm delay values is configured.

Enabled
Selecting this check box means the alarm output is enabled, otherwise it is disabled.

Latch
Selecting this check box means the alarm output is latched, otherwise it is unlatched.

Danger+ High to

Alert+ High to

Alert− Low to

Danger− Low
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8.6 Adaptive monitoring and direct trip multiply
The configuration of Adaptive Monitoring and Direct Trip Multiply parameters are both done
by first selecting the Adaptive Monitoring tab from the Processed Output channel you wish to
configure.

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on the Adaptive Monitoring and Direct Trip Multiply features.

8.6.1 Configuring adaptive monitoring parameters
The tab shown in Figure 8-41 is used to configure Adaptive Monitoring parameters.
Select the triggering parameter from the list available in the Adaptive Reference field. This
is usually a speed value.
Up to 10 triggering values with a corresponding multiplication factor can be defined. The
multiplication factor is applied to Alert and Danger levels.
In the example shown in Figure 8-41, the default multiplication factor of 1.0 is in effect up to
a speed of 10 Hz, Between 10 and 20 Hz, the factor is 1.5. Between 20 and 30 Hz, the factor
is 2.0, and so on.
When filling in the table, the first "From" speed value must be zero, and the first "To" speed
value must be different from zero. Otherwise, the software considers that the Adaptive
Monitoring function is not in effect.
The table should be filled in with increasing speed values (or data values). When the
maximum speed has been entered (100 Hz in the example shown in Figure 8-41), the
remaining speed values should be set to zero.
Whenever the speed is outside all the configured intervals, no multiplier is applied to the
alarms.
The check boxes in the Adaptive Alarms Enable column should normally be selected. If a
check box is cleared, the Adaptive Monitoring function is disabled for the corresponding
frequency band.
Click the Display button to obtain a graphical representation of the multiplication factor
versus speed. A example is shown in Figure 8-42.
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Figure 8-41: Tab for configuring the Adaptive Monitoring parameters

Figure 8-42: Graphical representation of the multiplication factor versus speed
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8.6.2 Configuring direct trip multiply parameters
To use this option, first click the TM: Direct Trip Multiply button. A tab resembling that
shown in Figure 8-43 appears.
The multiplication factor should be entered in the TM: Alarm Multiplier field.
All alarm levels (Alert, Danger) for this channel are multiplied by this factor when the TM
contact on the back of the IOC4T card is grounded.

NOTE: If you want to disable the Danger relays only, you can use the Danger Bypass (DB)
function. To activate this function, ground the DB contact on the back of the
IOC4T card.

Figure 8-43: Selecting the Direct Trip Multiply function
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9 DEFINING LOGICAL COMBINATIONS OF ALARMS 
(MPC4 AND MPC4 SIL)

9.1 Introduction
This section describes the Alarm Logical Combination branch of the configuration tree
structure, visible when an MPC4 or MPC4 SIL card is selected (see Figure 9-1). This branch
allows logical combinations of alarms to be defined. The VM600 MPS1 software allows eight
basic functions and four advanced functions to be configured.

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on logical combinations of alarms.

9.2 Defining a basic alarm function
To define a basic alarm function:
1- Select one of the eight Basic Functions (Basic Function 1 to Basic Function 8) from the

Alarm Logical Combination branch of the tree structure (Figure 9-1). A window
resembling that shown in Figure 9-2 appears.

2- The alarms are listed on several dialog boxes that are accessible by clicking the
appropriate tab (Figure 9-2 to Figure 9-5). Clear or select the check boxes next to the
individual alarms concerned (a check mark indicates the alarm has been selected).
The Function & Common tab (Figure 9-2) allows the user to select status-related flags
and control line flags (for example, indicating TM, DB or AR is active).

Figure 9-1: Structure of the Alarm Logical Combination branch
of the MPC4 configuration tree structure
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The tab for the single measurement channels (Figure 9-3) allows the Alert and Danger
alarms for the outputs of these channels to be selected, as well as certain status-related
information.
The tab for the dual channels (Figure 9-4) allows the Alert and Danger alarms for the dual
channels to be selected, as well as certain status-related information. Alarms for the
speed channels are also selected here.
The Diagnostics tab (Figure 9-5) allows the user to select status-related alarms that are
common to the entire MPC4 card.

3- Select the logical function (AND, OR, Voting Logic) by clicking the appropriate button on
the Function & Common tab (Logical AND, Logical OR or Voting Logic), as shown
in Figure 9-2.
If Voting Logic is selected, the Majority Parameter field appears and a value should be
entered. For example, if you have selected nine alarm check boxes and you enter the
value 3 in the Majority Parameter field, the basic alarm function signals an alarm when
any four of the nine alarms are active.

Figure 9-2: Window to select alarms for basic alarm combinations
(Function & Common tab)
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Notes:
The Invalid Output flag (Figure 9-3 and Figure 9-4) is an OR function between the following
possible alarms for a channel:
• DSP saturation error
• DSP overflow error
• Track out of range
• Track lost
• PGA saturation error
• Sensor OK system check (SOK).
Usually this error is due to incorrect configuration of the MPC4 card and can be corrected by
reconfiguring the card.

It is also important to note that when the channel inhibit function is activated for an MPC4
channel, the following flags (bits) for the channel processing are forced to a known state:
• For a measurement channel, the error bit (Err), OK system check (SOK), alarm (A+, A−)

and danger (D+, D−) flags are all forced to a normal state.
• For a speed channel, the error bit (Err), OK system check (SOK) and alarm (A+, A−) flags

are all forced to a normal state.
• For measurement channels and speed channels, the sensor bypassed (SBP) flag and

the invalid output flags are also set active (=1).

NOTE: The MPS1 and MPS2 software packages use the SBP (sensor bypassed) flag to
refer to the channel inhibit function.

When the channel inhibit function is de-activated for an MPC4 channel, there is an associated
recovery time to allow for signal stabilisation. Refer to the VM600 machinery protection
system (MPS) hardware manual for further information.

Figure 9-3: Window to select alarms for basic alarm combinations
(tab for single measurement channels)
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Figure 9-4: Window to select alarms for basic alarm combinations
(tab for speed and dual channels)

Figure 9-5: Window to select alarms for basic alarm combinations
(Diagnostics tab)
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9.3 Defining an advanced alarm function
To define an advanced alarm function:
1- Select one of the four Advanced Functions (Advanced Function 1 to Advanced

Function 4) from the Alarm Logical Combination branch of the tree structure (Figure 9-1).
A window resembling that shown in Figure 9-6 appears.

2- Clear or select the check boxes next to the basic functions concerned (a check mark
indicates the basic function has been selected).

3- Select the logical function (either AND or OR).

Figure 9-6: Window to configure advanced alarm functions
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10 OUTPUT MAPPING (MPC4 AND MPC4 SIL)

10.1Introduction
This section describes the Output Mapping branch of the configuration tree structure, visible
when an MPC4 or MPC4 SIL card is selected (see Figure 10-1).

The Output Mapping \ Discrete Outputs branch allows global and individual alarms (for
example, speed, vibration, dynamic pressure, MPC4 hardware and software status) to be
attributed to specific relays on the IOC and RLC cards. 
The Output Mapping \ DC Outputs branch allows the four DC outputs (DC OUT 1,
DC OUT 2, DC OUT 3 and DC OUT 4) to be configured.

10.2Mapping alarms (discrete outputs)
The IOC4T card has four local relays. Alarm signals can be directly attributed to these relays
under software control. No hardware adjustments need to be made, with the exception of
placing jumpers on the IOC4T card to configure the relays as normally energised (NE) or
normally de-energised (NDE), as well as normally open (NO) or normally closed (NC). 

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on placing these jumpers.

If additional relays are needed, an RLC16 card containing 16 relays can be installed in the
VM600 MPS. An alarm signal is attributed to a relay on the RLC16 in two stages:
1- The alarm signal is mapped to a relay using the VM600 MPS1 software. The user can

choose whether the mapping takes place via the Open Collector Bus (OC Bus) or the
Raw Bus.

2- If the OC Bus is used, a jumper must be set on the RLC16 card to enable the OC Bus
line that is associated with that specific relay.
or

3- If the Raw Bus is used, a jumper must be set on the IOC4T card to select one of the four
Raw Bus line associated with that particular relay. Another jumper must be set on the
RLC16 card to connect the Raw Bus line chosen to the specific relay.

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on using the OC Bus and the Raw Bus to switch relays on the
RLC16.

Figure 10-1: Structure of the Output Mapping branch 
of the MPC4 configuration tree structure
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Alarms are mapped to specific relays on the IOC4T card or RLC16 card (via OC Bus lines or
Raw Bus lines) using the Discrete Outputs node in the Output Mapping branch of the
configuration tree structure. When this node is selected, a relay mapping window appears
(see Figure 10-2). This contains:
1- A Relay Mapping tree structure (left)
2- Three combo boxes for alarm selection. These fields have names which are context

sensitive. For example, it is possible to see the following together:
• Common, Group and Status (Figure 10-3) and
• Channel, Outputs and Status (Figure 10-4)

3- An Apply button.

To map an alarm to a relay:
1- Click a node (small box containing a “+” sign) in the tree structure to show more of the

hierarchy (Figure 10-3 shows the IOC Relays branch opened up).
Select the branches as follows:

Each line of a branch represents a relay. The numbers correspond to the relay numbers
found on the rear panel of the respective card (IOC4T or RLC16).

2- Click the appropriate line to select a specific relay.
3- Choose an entry from the top-most combo box. This allows the choice of one of the

speed channels, any single or dual channel, a logically combined alarm or a “common”
signal.

4- Choose an entry from the middle combo box, if appropriate.

NOTE: The middle and lower-most combo boxes are context sensitive, that is, the
options available in them depend on what is chosen in the top-most
combo box.

5- Choose an entry from the lower-most combo box, if appropriate.
6- Click the Apply button to attribute the alarm signal to the relay. The line now shows the

alarm designation (for example, in Figure 10-3, Relay 2 on the IOC4T is attributed to the
Common Alert alarm).

You cannot attribute the same alarm to two different relays. If this is attempted, an error
message appears asking if you want to delete the first mapping. Click Yes or No as
appropriate.

IOC Relays To select one of the 4 local relays on the IOC4T card.

RLC / OC Bus To select one of the 16 relays on the RLC16 card using
the OC Bus.

RLC / Raw Bus To select one of the 16 relays on the RLC16 card using
the Raw Bus.
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Figure 10-2: Relay Mapping tree structure (for MPC4 card)

Figure 10-3: Example of attributing Relay 3 on the IOC4T card 
to the “Common Danger” alarm

Figure 10-4: Example of attributing Relay 2 on the RLC16 card to the Danger+ alarm of
Output 2 of Measurement Channel 1. The OC Bus is used to route the alarm.
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10.3Configuring DC outputs (analog outputs)
The IOC4T has four analog outputs (named DC OUT 1, DC OUT 2, DC OUT 3 and
DC OUT 4). These can be configured individually to provide a voltage-based output (0 to
10 V) or a current-based output (4 to 20 mA). This choice is made by setting jumpers on the
IOC4T card. 

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on placing jumpers.

Specific signals may be attributed to each analog output by selecting the Output Mapping \
DC Outputs branch of the configuration tree structure. When this node is chosen, a DC
Output Configuration window appears (see Figure 10-5).

To configure a DC output:
1- Click the Setup combo box to show the list of signals that can be chosen (Figure 10-6).

Measurement channels, speed channels and OK values may be chosen.
2- Choose a signal from the list. The DC Output Channel Setup window appears

(Figure 10-7).
3- Click the appropriate button to select the desired channel. 

NOTE: For the IOC4T card, only DC Outputs 1 to 4 may be chosen. These
correspond to DC OUT 1, DC OUT 2, DC OUT 3 and DC OUT 4 respectively.

4- Enter values in the Minimum Level and Maximum Level fields.
In the example shown in Figure 10-7, 0 to 100 mm corresponds to 0 to 10 V or to
4 to 20 mA, depending on the hardware configuration.

5- Click OK to validate. The newly assigned analog output appears on the DC Output
Configuration window (see Figure 10-8).

To delete an existing routing
To delete an existing analog output routing:
1- Select the signal again from the Setup combo box (Figure 10-6).
2- Select the Not Used button on the DC Output Channel Setup window (Figure 10-7).
3- Click OK to validate.

Figure 10-5: DC Outputs configuration window (for MPC4 card)
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Figure 10-6: Setup combo box showing signals that can be chosen

Figure 10-7: DC Output Channel Setup window

Figure 10-8: DC Outputs configuration window
showing the newly defined DC output
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11 COMMUNICATIONS MENU (MPC4 AND MPC4 SIL)

11.1Introduction
This section describes the commands available in the Communications drop-down menu at
rack level and at MPC4 or MPC4 SIL card level (see 6 Main window menus and commands).
The structure of the menu is shown in Figure 11-1.

Note that at rack level (that is, when a rack is highlighted in the configuration tree structure),
selecting Read Configuration uploads the configuration of all cards from the rack and
selecting Send Configuration downloads the configuration of all cards to the rack.
See also 2.3.1.1 Safety (SIL) version of the MPC4 and 6.3.3 Sending a configuration to a
VM600 rack or card.

Figure 11-1: Communications drop-down menu
at rack level and at MPC4 card level

(a) Communications menu when a
rack is highlighted in the
configuration tree structure

(b) Communications menu when an
MPC4 card is highlighted in the 
configuration tree structure
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11.2Communication with a stand-alone rack (no CPUM present)
A stand-alone rack is defined as one that is not connected to a network via a CPUM card or
a CPUM / IOCN card pair. Communication with individual cards in a stand-alone rack is
possible using an RS-232 serial communications link.

11.2.1 Setup procedure
The following procedure allows communication to be established with cards in a stand-alone
rack:
1- Connect an RS-232 communication cable between the appropriate serial interface port

on the computer (COM1, COM2, COM3 or COM4) and the RS-232 connector (9-pin
D-sub) on the front panel of the appropriate MPC4 card.

2- Select the rack in the configuration tree structure and ensure that the CPU Present
check box is not selected (see Figure 11-2).

3- Select the appropriate MPC4 card in the configuration tree structure.
4- Select Serial Port Setup from the Communications drop-down menu, and choose the

appropriate interface port (COM1, COM2, COM3 or COM4).

Once communication has been established, the operator can use the menu commands to
perform more or less the same functions that are possible with a networked rack.
The only difference between a networked rack and a stand-alone rack is that with a
networked rack the configuration of all cards in the rack can be either downloaded or read in
one single operation (via the CPUM card).

Figure 11-2: VM600 MPS1 Configuration Editor main window at rack level
with CPU Present check box not selected

The CPU Present check box must not be selected
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With a stand-alone rack, you can only download or read the configuration of one card at a
time. To communicate with another card, the physical link (RS-232 communication cable)
must first be moved to that card.

11.2.2 Communicating with an MPC4 card in a stand-alone rack
It is possible to communicate with an MPC4 card in a stand-alone rack. This is illustrated by
the example shown in Figure 11-3. In this example, the VM600 MPS1 software is installed on
a computer with a COM1 serial port. COM1 is physically connected to the MPC4 card (in
slot 3) using an RS-232 cable.
In the VM600 MPS1 session, COM1 is selected, allowing the MPC4 card can be configured
and communicated with. 

COM1

Stand-alone VM600 rack

RS-232 serial cable

VM600 MPS1 software configured 
for communication over serial port 
COM1

Figure 11-3: Example of using an MPSx software session to communicate with an MPC4 card

MPC4 card
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11.3Communication with a networked rack (CPUM present)
A rack containing a CPUM card or a CPUM / IOCN card pair can be connected to a network.
This allows communication with the rack over an Ethernet link.

NOTE: Refer to the VM600 networking manual for further information on networking.

The following procedure allows communication to be established with cards in a networked
rack:
1- Select the rack in the configuration tree structure (see Figure 11-4).
2- Activate the CPU Present check box.
3- Drop down the Hostname list and select a host name (that is, rack name) that

corresponds to the rack in question (Figure 11-4).
Alternatively, type the IP address of the rack, in dot-decimal notation, directly in the
Hostname field (for example, 10.10.56.56).

Figure 11-4: Defining the hostname

Choose from the list the hostname that corresponds to the VM600 MPS rack 
in question.
(Alternatively, enter the IP address of the rack directly in the field)

Highlight
the rack
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11.4Downloading the configuration (Send Configuration)
See also 2.3.1.1 Safety (SIL) version of the MPC4 and 6.3.3 Sending a configuration to a
VM600 rack or card.

Networked rack
To download an entire rack configuration to a networked rack:
1- Activate the communications link (Ethernet or PPP) to the rack as described in

11.3 Communication with a networked rack (CPUM present).
2- From the configuration tree structure, select the rack you want to download the

configuration to.
This should be the same rack as in step 1 above.

3- Select Send Configuration from the Communications drop-down menu.

To download a single card’s configuration to a networked rack:
1- In the configuration tree structure, select the card you want to download.
2- Select Communications, To MPC, and Send Configuration.

Stand-alone rack
For a stand-alone rack, the configuration of each card can be downloaded one card at a time
as follows:
1- Activate the communications link (RS-232 serial link) to the card in question as described

in 11.2.1 Setup procedure.
2- From the configuration tree structure, select the card you want to download the

configuration to.
This should be the same card as in step 1 above.

3- Select To MPC from the Communications drop-down menu and choose the Send
Configuration command.

11.5Reading the configuration (Read Configuration)
When a new card is installed in a slot its configuration can be “uploaded” to the VM600 MPS1
software for analysis.
If required, the configuration can then be saved under a particular name by selecting Export
MPC Configuration from the File drop-down menu.

Networked rack
To upload the configuration of an individual card, or the entire rack, to the personal computer:
1- Activate the communications link (Ethernet or PPP) to the rack as described in

11.3 Communication with a networked rack (CPUM present).
2- From the configuration tree structure, select the card you want to upload the

configuration from.
You can also upload the configuration of the entire rack by selecting the rack in the
configuration tree structure.

3- Select Read Configuration from the Communications drop-down menu.
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Stand-alone rack
For a stand-alone rack, the configuration of each card can be uploaded one card at a time as
follows:
1- Activate the communications link (RS-232 serial link) to the card in question as described

in 11.2.1 Setup procedure.
2- From the configuration tree structure, select the card you want to upload the

configuration from.
This should be the same card as in step 1 above.

3- Select From MPC from the Communications drop-down menu and choose the Read
Configuration command.

11.6Testing the communications link (Read System Identification)
To test the communication link, select From MPC from the Communications menu and
choose the Read System Identification command. The System Identification window
appears, as shown in Figure 11-5.
In the case of a problem, this window contains information that can be communicated to
Meggitt customer support.

11.7The status latch (clearing and reading)
When an alarm or flag with the ability to be latched occurs, the event is noted on a “latched
event list”. This can be examined by selecting From MPC from the Communications menu
and then choosing the Read Status Latch Data command. A window with three tabs
resembling those shown in Figure 11-6 to Figure 11-8 appears.
This feature is useful for checking if an event has occurred over a certain period of time (that
is, since the last Clear Status Latch Data operation), when the operator cannot permanently
check the output data.
The latched data can be cleared at any moment by selecting To MPC from the
Communications menu and then choosing the Clear Status Latch Data command.

Figure 11-5: System Identification window (for MPC4 / IOC4T card pair)



Document reference MAMPS1-SW/E SOFTWARE MANUAL
Edition 12 - February 2021 VM600 MPS1 software

11 - 7

The status latch (clearing and reading)
COMMUNICATIONS MENU (MPC4 AND MPC4 SIL)

The colour convention used on the windows is as follows:

The status bar at the bottom of each window provides a summary of the status. The five
boxes are interpreted as shown in Table 11-1 below:

White No event (the bit is off).

Yellow Indicates an Alert condition (A+ or A− level) on any measurement
channel (single or dual), any speed channel.

Red Indicates a Danger condition (D+ or D− level) on any measurement
channel (single or dual).
Also used for flags on the Common and Diagnostics tab (except for
the controls).

Purple Indicates an OK Level error.

Blue Used to indicate that a control signal (TM, DB and AR) is active.

Table 11-1: Interpretation of indicators on the status bar

Label Colour
(if bit = 1) Number (shown inside box)

OK Purple Sum of OK failures for all channels

D Red Sum of Dangers for all channels

A Yellow Sum of Alerts for all channels

Diags Red Sum of Diagnostics flags, including PGA saturation errors

Ctrls Blue Sum of control signals (TM, DB or AR) active

Figure 11-6: Read Status Latch Data window
(Dynamic Channels tab)
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Figure 11-7: Read Status Latch Data window
(Speed & Dual Channels tab)

Figure 11-8: Read Status Latch Data window
(Common & Diagnostics tab)
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11.8The MPC outputs window (Read Outputs)
The MPC Outputs window (Figure 11-9) shows detailed information concerning measured
values, such as speed, vibration levels, alarms, hardware and software status. The window
is called up by selecting From MPC from the Communications menu and then choosing the
Read Outputs command.
Measurements can be obtained in two ways:
1- A single acquisition can be made, providing a “snapshot” of the machine status at a given

moment in time.
To do this, click the Get Outputs button (Figure 11-10). The button to the right of this one
should read Poll Outputs (indicating continuous acquisitions are presently disabled).

2- A continuous series of acquisitions can be made. The period between successive
acquisitions is fixed at 1.0 second.
To do this, click the Poll Outputs button (Figure 11-10). The text on the button changes
to “End Polling” when this is done. Click the End Polling button to stop acquiring data.

To end the session, click the Done button.

11.8.1 Explanation of fields
The MPC Outputs window can be broken down into the following areas for the purposes of
this explanation:
1- Fields concerning the two speed channels (see Figure 11-11)
2- Fields concerning the four single measurement channels (see Figure 11-12)
3- Fields concerning the two dual measurement channels (see Figure 11-13)
4- Fields concerning the basic and advanced logical combinations of alarms (see

Figure 11-14)
5- Fields concerning status information (see Figure 11-15)

The MPC Running indicator (see Figure 11-11) has the following behaviour:
• It flashes green/white alternately when the configuration is running.
• It is continually red when the configuration is not running.

When this occurs, it is often due to an incorrect configuration. It may also occur during
the MPC4 card's warm-up period.
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11.8.1.1 Fields concerning the two speed channels

The MPC Outputs window shows the measured values and alarm status for the two speed
channels (Figure 11-11).
The first column indicates the sensor tag entered for each channel.
The speed values are shown in the units selected. The following colour coding applies:
• Grey, indicating the value is within limits
• Red, indicating the full scale has been exceeded
• Purple, indicating the value is not valid due to a hardware/software error
• ??????, indicating the output is not configured.

Figure 11-9: Typical MPC Outputs window

Figure 11-10: Get Outputs and Poll Outputs buttons
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The Alert+ (A+) and Alert− (A−) alarm flags indicate when the speed is in/out of limits. The
following colour coding applies:
• Grey, indicating the value is within OK limits
• Yellow, indicating the value is out of OK limits.

The OK values (expressed in V or mA) are the DC values extracted from the signals. The
following colour coding applies to the OK values and the OK level flags:
• Green, indicating the value is within OK limits
• Red, indicating the value is out of OK limits.
The status flags have the following meaning:

Sol Speed out of limits.
Limits are 0.017 Hz to 1092 Hz.
This can be because the machine is really in an overspeed condition.
Another reason may be that the tacho signal is dirty and this causes
additional pulses which the MPC misinterprets as being due to a high
speed.

Err Channel error or failure.
This may be caused by a signal error or an MPC error for this channel.

Figure 11-11: Fields concerning the two speed channels

MPC Running indicator Measured speed values

Sensor tag for
Speed Chan. 2

Sensor tag for
Speed Chan. 1

Indicators for Alert+
and Alert− alarms OK level flag

OK value Status flags
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11.8.1.2 Fields concerning the four single measurement channels

The MPC Outputs window shows measured values and alarm status for the four single
measurement channels (Figure 11-12).
The first column indicates the sensor tag entered for each channel.
The measured values are shown in the units selected by the user. The following colour coding
applies:
• Grey, indicating the value is within limits
• Red, indicating the full scale has been exceeded
• Purple, indicating the value is not valid due to a hardware / software error
• ??????, indicating the output is not configured.

The Alert+ (A+) and Alert− (A−) alarm flags indicate when the measured value is in/out of
Alert limits. The following colour coding applies:
• Grey, indicating the value is within Alert limits
• Yellow, indicating the value is out of Alert limits.

The Danger+ (D+) and Danger− (D−) alarm flags indicate when the measured value is in/out
of Danger limits. The following colour coding applies:
• Grey, indicating the value is within Danger limits

(NB: The value may nevertheless be out of Alert limits)
• Red, indicating the value is out of Danger limits.

The OK values (expressed in V or mA) are the DC values extracted from the signals. The
following colour coding applies to the OK values and the OK level flags:
• Green, indicating the value is within OK limits
• Red, indicating the value is out of OK limits.

The status flags have the following meaning:
In the “Saturation” group:
CMR: Out of Common Mode Range (±50V)
This may happen if a sensor wire is cut, or if the EMC requirements are not fulfilled at the site
where the VM600 MPS is installed.
PGA: Saturation of programmable gain amplifier
In this case the signal dynamic and/or FSD must be increased when an integration (or double
integration) is required.
Input: Saturation at input amplifier (first stage)
This occurs if the signal contains spurious spikes or is in over-range (above ±20 V).
DSP: Saturation of calculation in the Digital Signal Processor
This is due to a configuration that isn't adapted to the signal. It may be remedied by increasing
the FSD as well as the input signal dynamic.
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In the “Tracking” group:

NOTE: The Tracking Ool and Tracking Lost flags are relevant only to Narrow Band
(Tracking) processing.

11.8.1.3 Fields concerning the two dual measurement channels

The MPC Outputs window shows measured values and alarm status for the two dual
measurement channels (Figure 11-13).
The measured values are shown in the units selected by the user. The following colour coding
applies:
• Grey, indicating the value is within limits
• Red, indicating the full scale has been exceeded
• Purple, indicating the value is not valid due to a hardware/software error
• ??????, indicating the output is not configured.

Figure 11-12: Fields concerning the four measurement channels

Measured values for Output 1
of Channel 4

Sensor tag for
Channel 4

OK level flag
(Channel 1)

Saturation
flags

Chan. 1

Chan. 2

Chan. 3

Chan. 4

Measured values for Output 2
of Channel 4

Tracking
indicators

Danger+ indicator
(red when alarm)

Alert+ indicator
(yellow when alarm)

OK value
(Channel 1)

Ool Tracking is out of limits. The tracking speed for this channel has
exceeded the range defined in the Narrow Band configuration.
This may be due to a dirty signal. Otherwise the range may be
increased (respecting the restrictions described in this manual).

Lost The tracking has been lost. This may occur if the speed is out of limits
or if the speed changes too quickly for the processing to follow it.
The tacho signal must be checked.
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The Alert+ (A+) and Alert− (A−) alarm flags indicate when the measured value is in/out of
Alert limits. The following colour coding applies:
• Grey, indicating the value is within Alert limits
• Yellow, indicating the value is out of Alert limits.

The Danger+ (D+) and Danger− (D−) alarm flags indicate when the measured value is in/out
of Danger limits. The following colour coding applies:
• Grey, indicating the value is within Danger limits

(NB: The value may nevertheless be out of Alert limits)
• Red, indicating the value is out of Danger limits.

The OK level flags have the following colour coding:
• Green, indicating the value is within OK limits
• Red, indicating the value is out of OK limits.

Figure 11-13: Fields concerning the two dual channels

Processing function OK level flag

Chan. 1&2

Chan. 3&4

Measured values

Danger+ indicator
(red when alarm)

Alert− indicator
(yellow when alarm)
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11.8.1.4 Fields concerning basic and advanced logical combinations of alarms

The MPC Outputs window shows the status of the 8 Basic and 4 Advanced logical
combinations of alarms (Figure 11-14).

In general, the alarm flags have the following colour coding:
• Green, indicating there is no alarm
• Red, indicating an alarm.
However, when a logical combination of alarms is used to display the status of an OK system
check (SOK) flag:
• The logical combination is show as red when the OK system check is OK (as the SOK

flag has a logical value of 1 when there is not a problem).
• The logical combination is show as green the OK system check is not OK (as the SOK

flag has a logical value of 0 when there is a problem).

11.8.1.5 Fields concerning status information

The MPC Outputs window shows information on common alarms as well as status
information for diagnostics purposes (see Figure 11-15).
Table 11-3 summarises the meaning of the flags in the "Common" group.

The Status Latch flag (see Figure 11-15 and 11.7 The status latch (clearing and reading))
has the following colour coding:
• Green, indicating no data has been latched since the last Clear Status Latch Data

operation
• Red, indicating data has been latched.

Figure 11-14: Fields concerning the basic and advanced logical combinations of alarms

Table 11-2: Flags in the “Common” group

Flag name Description Colour coding

Common OK Common OK level alarm Green: indicating no Common Alert, 
Common Danger or Common OK level 
alarm.

Red: indicating an alarm.

Common D Common Danger level 
alarm

Common A Common Alert level alarm

Common TM Trip Multiply indicator Green: indicating TM, DB or AR is not 
active.

Red: indicating TM, DB or AR is active.

Common DB Danger Bypass indicator

Common AR Alarm Reset indicator
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Table 11-3 summarises the meaning of the flags in the "Diagnostics" group. These all have
the following colour coding:
• Green, indicating no error/failure detected
• Red, indicating error/failure detected.

Figure 11-15: Fields concerning status information
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11.8.1.6 First Event Blink and Scan Rate

When activated, the First Event Blink feature allows the user to check which event occurred
first among several. It takes into consideration all MPC channels.
The feature is activated by clicking the First Event Blink button on the MPC Outputs window
(see Figure 11-14).

Table 11-3: Flags in the “Diagnostics” group

Flag name Description

On the “MPC4” line:

Fail
Common flag for monitoring failure.
The result is that at least one of the output values no longer generates 
alarms.

Err
Common flag for processing error.
This is due to any error in at least one of the channels.

DSP
Common flag for DSP saturation error.
The configuration must be checked, particularly the FSD and input signal 
dynamic.

On the "Signal" line:

CMR
Common flag for “Out of Common Mode Range” error.
See the description of "CMR" in 11.8.1.2 Fields concerning the four single 
measurement channels.

Err Common flag for input signal error.
Check the signal range and that there are no spikes on the signal.

Sat

Common flag for input saturation error.
This may be due to saturation of the input amplifier (first stage) or the 
programmable gain amplifier (PGA).
See the descriptions of “Input” and “PGA” in 11.8.1.2 Fields concerning the 
four single measurement channels.

On the “Spd & Trk” (Speed and Tracking) line:

Sol
Common flag for speed out of limits.
See the description of “Sol” in 11.8.1.1 Fields concerning the two speed 
channels.

Lost
Common flag for tracking lost.
See the description of “Lost” in 11.8.1.2 Fields concerning the four single 
measurement channels.

Ool
Common flag for tracking out of limits.
See the description of “Ool” in 11.8.1.2 Fields concerning the four single 
measurement channels.
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Users must bear in mind that an event which occurs between two scans and has a duration
of less than the period between successive scans will not be seen on the MPC Outputs
window. The time resolution (interval between successive scans) is fixed at 1.0 second. The
event is only detected if it creates a Status Latch event. In this case, the Status Latch indicator
on the MPC Outputs window (see Figure 11-15) becomes red. Further information on the
event can be obtained by performing a Read Status Latch Data operation (see Figure 11.7).

11.9Resetting alarms (Alarm Reset)
Alarms indicated by the status indicators (LEDs) on the front panel of the MPC4 card, or on
the MPC Outputs window, can be reset by selecting To MPC from the Communications
menu and then choosing the Alarm Reset command.

11.10Checking the card status (Read System Status)
This menu command is mainly provided for troubleshooting purposes. In case of problems
with a card, Meggitt customer support may ask you to pass on to them certain information
available from the VM600 MPS software (see Figure 11-16).
To view the card status, select From MPC from the Communications menu and then select
the Read System Status command.

Figure 11-16: Read System Status window
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11.11Inhibiting a channel (Channel Inhibits)

NOTE: The safety version of the MPC4 card (MPC4 SIL) does not does not support the
channel inhibit function.

The channel inhibit function allows individual MPC4 channels (measurement and speed) to
be temporarily bypassed, that is, it temporarily inhibits the protection offered by any
associated relays.
The channel inhibit function is intended to allow a component in a measurement system
front-end, such as a sensor/transducer or signal conditioner, to be replaced for an individual
channel while the other machinery monitoring channels and functions continue to operate as
normal.
This allows the machinery being monitored to continue to operate (if the protection offered by
the other machinery monitoring channels and functions is adequate). It also allows any
control system using the relays to avoid false trips during such maintenance activity.

The channel inhibit function is activated when one of the VM600 MPS software packages
(MPS1 or MPS2) is used to send channel inhibit commands to individual MPC4 channels.
Alternatively, Modbus can be used to control the channel inhibit function for a networked
VM600 machinery protection system (containing a CPUM card).

To activate the channel inhibit function for an MPC4 channel or channels:
1- Click Communications > To MPC > Channel Inhibits.
2- Use the Channel Inhibits dialog box that appears to select the Measurement Channels

and Speed Channels for which the channel inhibit function is required. Then click Send.
The channel inhibit function is activated for the selected channels.

When the channel inhibit function is activated for an MPC4 channel:
• The channel continues its processing as per its configuration – except for any associated

relay functionality, but any processing channels that depend on the channel are also
automatically bypassed.

• The sensor power supply output for the channel remains turned on, if enabled.
• Any DC output functionality associated with the channel continues, if enabled.
• Certain flags (bits) for the channel processing are forced to a known normal state in order

to help ensure the continued operation of the machinery monitoring system
(see 9.2 Defining a basic alarm function).

• The channel’s status indicator (LED) on the panel of the MPC4 card slowly blinks green
for the duration of the channel inhibit (approximately once per second).

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information.

• An Inhibit On event is recorded in the database.
• The MPC outputs window displays the channel information with an “Inhibited” label and

in grey coloured text (see 11.8 The MPC outputs window (Read Outputs).
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Also, clicking Communications > To MPC > Channel Inhibits again will display the Channel
Inhibits dialog box with the check boxes selected for each inhibited channel.

NOTE: When an MPC4 card is configured (for example, using Communications > To
MPC > Send Configuration), the channel inhibit function is automatically
de-activated for any channels where it is active.

To de-activate the channel inhibit function for an MPC4 channel or channels:
1- Click Communications > To MPC > Channel Inhibits.
2- Use the Channel Inhibits dialog box that appears to clear the Measurement Channels

and Speed Channels for which the channel inhibit function is no longer required. Then
click Send.
The channel inhibit function is de-activated for the cleared channels.

When the channel inhibit function is de-activated for an MPC4 channel:
• The MPC4 card waits 2 seconds for signal stabilisation, in addition to the OK system

check recovery time. This gives a total recovery time of 2.1 seconds for MPC4 cards
running firmware version 070 or earlier and of 12 seconds for MPC4 cards running
firmware version 071 or later.

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information.

• Any latched alarms are reset (cleared) and the processing channels that depend on the
channel resume normal operation.

• The flags for the channel processing return the true status of the machinery monitoring
system. The sensor bypassed (SBP) flag is also set inactive (=0).

• The channel’s status indicator (LED) on the panel of the MPC4 card indicates the
operational status of the card.

• An Inhibit Off event is recorded in the database.
• The MPC outputs window displays the channel information as usual (see 11.8 The MPC

outputs window (Read Outputs).

NOTE: Cards that support the channel inhibit function can coexist in a a VM600 rack with
cards (running older versions of firmware) that do not support this function.
For cards that do not support the channel inhibit function, the VM600 MPS software
will report the channel inhibit function as unavailable.
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12 CONFIGURING INPUTS AND PROCESSING FUNCTIONS 
(AMC8)

12.1Introduction
This section describes the Inputs / Processing branch of the configuration tree structure
that is visible when an AMC8 card is selected (see Figure 12-1). This branch allows sensor
characteristics for the eight single channels and four “multi-channels” to be configured. Signal
processing parameters and alarm levels are also defined here. 

Figure 12-1: Structure of the Inputs / Processing branch of the configuration tree
structure for an AMC8
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12.2Configuration of general parameters at card level
Select Card Level from the configuration tree structure to obtain a window resembling that
shown in Figure 12-2. 

12.2.1 General description
This window (Figure 12-2) contains the following fields:
1- Remote Channel Source #1 and #2

See 12.2.2 Using remote channels.
2- Global Channel OK Fail Mode

The setting of these radio buttons determines how measured data is presented on the
AMC Outputs window (see 15 Communications menu (AMC8)) in the event of a Global
Channel OK Fail.

• If Output Measured Value is selected, the actual measured value is displayed.

NOTE: Bear in mind that this value may be meaningless and maybe should not be
taken into consideration.

• If Output Zero is selected, a numerical value of 0 is displayed.
3- AC Frequency Rejection

This feature provides narrow-band rejection of signals at either 50 Hz or 60 Hz (to filter
out unwanted noise coming from the mains network). Click the applicable radio button to
select the frequency you want to reject. 

Figure 12-2: Window when Card Level is selected in the configuration tree structure
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12.2.2 Using remote channels
The Remote Channel Source feature allows a “cold junction” (CJ) temperature signal
(generally obtained using an RTD device) to be routed from one card to another in the rack.
Up to two remote channel sources can be defined for a given rack.

Configuration Example:
An AMC8 card in slot 6 of the rack is used to obtain two “cold junction” temperature signals,
using channels 7 and 8 of the card. The operator wants to define these signals as Remote
Channel Source #1 and Remote Channel Source #2, respectively. This information should
be entered on the Board Level window using the Slot Number and Channel Number fields,
as shown in Figure 12-2.

NOTE: When entering this information, the software does not actually check that there is
an AMC8 card installed in the slot (slot 6).
You should check that the slot really contains an AMC8 card (not an MPC4 card)
and that the channel number provides a meaningful temperature signal.

Once a remote channel source has been defined it can be used by other cards in the rack.
Continuing the example above, if the operator wants to use a remote signal for cold junction
compensation of channel 1 of the AMC8 card installed in slot 4 he should proceed as follows:
1- Select Channel 1 (RTD a) from the Inputs / Processing branch of the tree structure for

the AMC8 card in slot 4.
2- Select TC In the Sensor Family field.
3- Select Remote Channel 1 in the CJT Source field, as shown in Figure 12-3 

12.3Configuring single channels
A window resembling that shown in Figure 12-4 appears when one of the eight single
channels (Channel 1 to Channel 8) is selected in the configuration tree structure. The window
has three tabs:
• Input Configuration
• Non-linear Compensation
• Processing & Alarms.

Figure 12-3: Defining Remote Channel 1 as the CJT source
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12.3.1 The input configuration tab
The appearance of the Input Configuration tab (fields present) depends on what type of
sensor is selected in the Sensor Family field (see Figure 12-4, Figure 12-6 and Figure 12-8).

12.3.1.1 General

To configure a channel, see Figure 12-4 and proceed as follows:
1- Select the sensor type from the Sensor Family field. The choices are:

2- From the Input Sensor Range combo box, select the range that most closely matches
that delivered by your sensor.

3- For linear devices, click the Linear radio button under Sensor Compensation Type.
For non-linear devices, the Non-linear button must be clicked. This enables the user to
enter values on the Non-linear Compensation tab. See 12.3.2 The non-linear
compensation tab for further information.

NOTE: The Non-linear Compensation tab is unavailable (dimmed) when the Linear radio
button is selected.

4- Enter the sensor characteristics under Linear Compensation.
The value of the signal at a temperature of zero must be entered in the Offset field.
The offset and sensitivity can be entered as normal decimal numbers, but the software
displays them in scientific notation. For example:

Note that the “Converted range” text changes as a function of what is entered in the
Offset and Sensitivity fields.

5- Enter values in the OK Level Upper Value and OK Level Lower Value fields. The
equivalent temperatures are displayed (dimmed) to the right of these fields.

6- Enter a name for the sensor in the Tag field and set the Sensor Connected field to Yes.
7- Click the Save icon on the toolbar to save the configuration in memory. 

U for voltage-based sensors.

I for current-based sensors.

TC for thermocouples.

RTD for Resistance Temperature Devices.

−1 is displayed as −1.00000000E+00.

20 is displayed as 2.00000000E+01.
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12.3.1.2 Example for a voltage-based sensor

Assume that a sensor outputs a voltage according to the graph in Figure 12-5.
The output voltage is linear with temperature, so the Linear radio button must be selected.
The Linear Compensation area appears at the bottom of the tab when this is done
(Figure 12-4).
Set the Sensor Unit Multiplier field to “V” and the Input Unit field to “deg C” (giving a
sensitivity in units of °C/V).
The sensor outputs a voltage of 2.0 V at a temperature of 0°C. The Offset field should
therefore be set to 2.0 (this is displayed as 2.00000000E+00).
The sensitivity is 10°C/V, so the Sensitivity field should be set to 10 (this is displayed as
1.00000000E+01).
These settings lead to a converted range of −20 to 144°C (corresponding to 0 to 16.4 V)
Setting the OK levels to 1 V and 16 V means that temperatures in the range −10 to 140°C
are considered as valid.

Figure 12-4: Window when Input Configuration tab selected
(Sensor Family = U)

Calculated converted range based on the 
entered offset and sensitivity values
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The window setup for this example is shown in Figure 12-4. 

NOTE: The setup procedure for a linear current-based sensor is very similar to that
described in this section.

12.3.1.3 Configuration window for thermocouples

A window resembling Figure 12-6 appears when a thermocouple (TC) is selected in the
Sensor Family field.
Select the type of thermocouple in the Sensor Type field. Possible choices are “E”, “J”, “K”,
“T” or “User Defined”.
The Sensor Compensation Type is set to Non-linear by default. The linearising coefficients
can be examined in read-only mode (dimmed) by clicking the Non-linear Compensation tab
(see Figure 12-7). You should not set the Sensor Compensation Type to “Linear”.
If the Sensor Type field is set to User Defined, the data on the Non-linear Compensation tab
becomes editable. See 12.3.2 The non-linear compensation tab for information on
configuring this tab.
If cold junction compensation is required, the source device must be selected in the CJT
Source field. The source can be one of eight local channels (Local Channel 1 to Local
Channel 8) or one of two remote channels (Remote Channel 1 or Remote Channel 2).
See 12.2.2 Using remote channels for information on remote channels.

Sensor output 
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(°C)

−20

−10

140

21 16

Se
ns

or
 o

ut
pu

t c
on

si
de

re
d 

va
lid

144

16.4

Figure 12-5: Example of linear output from a voltage-based sensor

OK Level
Upper Value = 16 V

OK Level
Lower Value = 1 V

Sensitivity
= 10°C/V
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The other fields should be configured as described in 12.2.1 General description.
When setting the OK levels, the converted temperature value is replaced by a yellow box if
the voltage value lies outside the conversion range. The conversion range can be found on
the Non-linear Compensation tab as shown in Figure 12-7. 

Figure 12-6: Window when Input Configuration tab selected
(Sensor Family = TC)
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12.3.1.4 Configuration window for RTD devices

A window resembling Figure 12-8 appears when a RTD device is selected in the Sensor
Family field.
Select the type of RTD in the Sensor Type field. Possible choices are Pt100 (0.00385),
Pt100 (0.00392), Cu10 (0.00427), Ni120 (0.00672) or User Defined.
Select the hardware configuration (2-wire, 3-wire or 4-wire arrangement) in the Sensor
Connection Type field. 

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on hardware configurations.

The Sensor Compensation Type is set to Non-linear by default. The linearising coefficients
can be examined in read-only mode (dimmed) by clicking the Non-linear Compensation tab

Non-editable
(unavailable)

window

Figure 12-7: Non-linear Compensation tab showing
default settings for E-type thermocouple

Voltages (mV)
corresponding to

Temperature Range A
(−200 to 0°C).

Values depend on
sensor type chosen

Temperature Range A
defined as −200 to 0°C

Conversion
ranges
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(the resulting tab resembles somewhat that shown in Figure 12-7). You should not set the
Sensor Compensation Type to Linear.
If the Sensor Type field is set to “User Defined”, the data on the Non-linear Compensation
tab becomes editable. See 12.3.2 The non-linear compensation tab for information on
configuring this tab.
The other fields should be configured as described in 12.2.1 General description.
When setting the OK levels, the converted temperature value is replaced by a yellow box if
the resistance value lies outside the conversion range. The conversion range can be found
on the Non-linear Compensation tab (see Figure 12-7).

12.3.2 The non-linear compensation tab
The Non-linear Compensation tab (Figure 12-12) can be viewed but not edited when a
standard sensor type is chosen on the Input Configuration tab. This includes the following
configurations:
• Sensor Family = TC, with Sensor Type = E, J, K or T
• Sensor Family = RTD, with Sensor Type = Pt100, Cu10 or Ni120
To edit the Non-Linear Compensation tab you must first have one of the following set up on
the Input Configuration tab:
• The Sensor Family field set to U (voltage-based sensor) or I (current-based sensor) and

the Non-linear button selected under Sensor Compensation Type.
or

• The Sensor Family field set to TC (thermocouple) or RTD, the Sensor Type field set to
User Defined and the Non-linear button selected under Sensor Compensation Type.

Figure 12-8: Window when Input Configuration tab selected
(Sensor Family = RTD)
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12.3.2.1 Polynomial coefficients

The Non-linear Compensation tab allows a polynomial equation to be applied to a particular
range of the curve that defines the relationship between the input quantity (such as a voltage,
current or resistance value) and the output quantity (such as temperature).
The polynomial equation contains polynomial coefficients and has the following form:

y = p0 + p1.x + p2.x2 + p3.x3 ... + pn.xn

where
x = the input variable
y = the linearised and scaled output
pn = the polynomial coefficients (the value of “n” is the order of the polynomial)

Each polynomial has its set of coefficients, and each sensor (TC or RTD) has its own set of
polynomials.
The choice of polynomial order (the value of “n” in the equation above) has an influence on
the accuracy of the linearisation process and the computing power needed to perform the
calculation. The higher the order, the greater the temperature range over which the
polynomial equation can apply, but the longer it takes to calculate the value because of the
extra processing power required.
The entire measuring range can be split into two or more sub-ranges, where each sub-range
has its own polynomial equation (see Figure 12-9). This technique allows polynomials having
a lower order to be used.
A polynomial must only be used over its valid input variable range, otherwise significant
measurement errors can arise.
The point where polynomials change (for example, where Range A meets Range B in
Figure 12-9) should be chosen with care to avoid significant discontinuities in the calculated
value.

NOTE: Software packages for calculating the best polynomials and optimum number of
sub-ranges for your application are commercially available.
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12.3.2.2 Using the tab

A simple example is presented here to illustrate how the Non-linear Compensation tab should
be used.
Assume that a current-based sensor is connected to the channel. The Input Configuration tab
is set up as shown in Figure 12-10. Click the Non-linear radio button so that the Non-linear
Compensation tab becomes editable. A window resembling that shown in Figure 12-12
appears.

Input
signal

Calculated
temperature

Actual curve

Polynomial equation A
(Coefficients a0, a1, ... an)

Polynomial equation B
(Coefficients b0, b1, ... bn)

Range A Range B

Figure 12-9: Splitting the measuring range into two sub-ranges

Overall useful measuring range
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On the Non-linear Compensation tab, set the Polynome Input Unit to mA (as a
current-based sensor is connected) and Polynome Output Unit to deg C (the desired
temperature unit being °C).
In this example, it is known that the sensor has the following behaviour:
• The sensor outputs 0 mA at a temperature of 20°C
• Between 0 and 10 mA the sensitivity of the sensor is 25°C/mA
• Between 10 and 20 mA the sensitivity of the sensor is 15°C/mA.
The measuring range can be split into two parts: Range A for an output of 0 to 10 mA and
Range B for an output of 10 to 20 mA. This is illustrated in Figure 12-11. 
In Range A the offset is 20°C and the sensitivity is 25°C/mA.
In Range B the offset is 120°C and the sensitivity is 15°C/mA.
The two individual curves can be joined to form a composite curve (Figure 12-11) that does
not have any discontinuity at the point where Range A meets Range B.
In the polynomial equation described in 12.3.2.1 Polynomial coefficients, the coefficients p0
and p1 in fact have the following significance:
• p0 is the offset
• p1 is the sensitivity (determining the slope of the curve).

Figure 12-10: Example of setup for a current-based sensor
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The coefficients for the two ranges can therefore be entered into the table on the Non-linear
Compensation tab as seen in Table 12-1 below.

Enter the Start and Stop values (mA) for Range A and Range B as shown in Figure 12-12.
The conversion ranges can be read at the bottom of the window (Range A = 20 to 270°C and
Range B = 270 to 420°C).
The overall measuring range (20 to 420°C) can be seen on the Input Configuration tab in the
text that reads “Converted range...” (see Figure 12-10).
The OK levels can now be defined on the Input Configuration tab using the OK Level Upper
Value and OK Level Lower Value fields (see Figure 12-10).

Table 12-1: Polynomial coefficients needed for the example

Range A Range B

Coeff. 
name Value Displayed in 

software as
Coeff. 
name Value Displayed in 

software as

a0 20 2.00000000E+01 b0 120 1.20000000E+02

a1 25 2.50000000E+01 b1 15 1.50000000E+01
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Sensor Signal
(mA)

Temp. (°C)

Range A Range B

Figure 12-11: Example of forming a composite curve from two individual curves
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12.3.3 The Processing & Alarms tab

12.3.3.1 Context

This tab (Figure 12-13) allows a time-domain processing function and alarm parameters to
be configured for the selected channel.
Alarms detected by the software can be used to switch relays. To map an alarm to a specific
relay, select the Output Mapping \ Discrete outputs branch of the configuration tree
structure.

NOTE: See 14 Output mapping (AMC8) for further information.

If logical combinations of alarms are required, select the Alarm Logical Combination
branch of the configuration tree structure once alarms parameters have been defined for all
the individual channels of interest.

NOTE: See 13 Defining logical combinations of alarms (AMC8) for further information.

Figure 12-12: Non-linear Compensation tab for the example described

Currents (mA)
corresponding to

Temperature Range A

Temperature Range A
defined as 20 to  270°C

Conversion ranges
(C and D are not used)

Temperature Range B
defined as 270 to  420°C

Polynomial coefficients
defining the offset

Polynomial coefficients
defining the sensitivity

Buttons to select the
number of sub-ranges

used
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12.3.3.2 Explanation of fields

Time Domain Processing
The following options can be chosen:
• None : No additional processing is performed
• MIN : Calculates the minimum value measured during the time period entered in

the Time Parameter field
• MAX : Calculates the maximum value measured during the time period entered in

the Time Parameter field
• AVG : Calculates the average of the values measured during the time period

entered in the Time Parameter field.

Time Parameter
This field can be set to a value between 0.1 and 10.0 s (seconds). The value is used by the
Time Domain Processing function (see above).

Output Unit
The temperature unit can be set to:
• deg C degrees Celsius (°C)
• deg F degrees Fahrenheit (°F)
• K Kelvin.
The unit chosen here does not have to be the same as that used on the Input Configuration
and Non-linear Compensation tabs. If, for example, deg C was used on these two tabs and
deg F is chosen here, the relevant fields on the Processing & Alarms tab are automatically
converted to display in deg F.

Figure 12-13: Processing & Alarms tab
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Maximum (Minimum) Displayed Value
These two settings determine the scale of the display on the front panel of the CPUM card
(see Figure 12-14).

These values are not actually written on the CPUM card’s display. It is a good idea to choose
the two values so that, when the difference between them is divided by 10, the graduations
on the scale correspond to a temperature interval that is a round number (for example,
choosing a max. = 120°C and a min. = 20°C gives graduations at 30°C, 40°C and so on).
An error is signalled if you try to enter a value that is outside the range shown in the text on
the Input Configuration tab that reads “Converted range...” (see Figure 12-10).

Level
The values are expressed in the unit defined in the Output Unit field. They must be entered
in decreasing order from:
• Danger+ High to
• Alert+ High to
• Alert− Low to
• Danger− Low.

Hysteresis
The values are expressed in the unit defined in the Output Unit field.
The hysteresis value must always be positive. It is added to the A− and D− levels and
subtracted from the A+ and D+ levels internally, to give hysteresis capability to the system. It
is advised to set a hysteresis value of about 2 to 5% of the desired full scale for the output,
but the optimum value actually depends on the noise on the output.

Delay
The signal level must be over (or under, in the case of low-level alarms) the alarm level
(including the hysteresis value) for longer than the alarm delay time before an alarm is
generated.

NOTE: The range of alarm delay values supported by the measurement channels of an
AMC8 card is 0 to 60 seconds with a resolution of 0.1 second (100 milliseconds).
Correct operation cannot be guaranteed if a value outside the supported range of
alarm delay values is configured.

Scale with 10
graduations

Value is obtained from the
Maximum Displayed Value field

Figure 12-14: The display on the front panel of the CPUM card

Danger threshold

Alert threshold

Value is obtained from the
Minimum Displayed Value field
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Enabled
Selecting this check box means the alarm output is enabled, otherwise it is disabled.

Latch
Selecting this check box means the alarm output is latched, otherwise it is unlatched.

12.4Configuring “multi-channels”
A window resembling that shown in Figure 12-15 appears when one of the four
“multi-channels” (Multi-Channel 1 to Multi-Channel 4) is selected in the configuration tree
structure. The window has two tabs:
• Processing
• Alarms.

12.4.1 The Processing tab
In order to use this tab, two or more single channels on the same AMC8 card must already
have been configured. The Channel Used field on the Input Configuration tab (Figure 12-4)
of each single channel must be set to Used.
Select one of the following functions from the Processing Function combo box
(Figure 12-15):

MIN Outputs the lowest value measured by the selected channels.

MAX Outputs the highest value measured by the selected channels.

AVG Calculates the average of the values measured by the selected
channels.

DIFF Calculates the difference between the values measured by two
selected channels.
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The chosen function acts on the channels selected under Select Channels For Averaging. 

If DIFF is chosen in the Processing Function field, the window resembles that shown in
Figure 12-16. Choose the two channels under Difference Channel Selection. 

Figure 12-15:  Processing tab for configuring multi-channels

Figure 12-16: Using the DIFF processing function
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12.4.2 The Alarms tab
This tab (Figure 12-17) allows a time-domain processing function and alarm parameters to
be configured for the selected multi-channel. It is very similar in layout to the Processing and
Alarms tab for single channels (Figure 12-13). The fields have the same functionality on both
tabs.

NOTE: See 12.3.3.2 Explanation of fields for further information on the fields.

Figure 12-17: Alarms tab (for multi-channels)



Document reference MAMPS1-SW/E SOFTWARE MANUAL
Edition 12 - February 2021 VM600 MPS1 software

12 - 21

Copying card configurations
CONFIGURING INPUTS AND PROCESSING FUNCTIONS (AMC8)

12.5Copying card configurations
When configuring AMC8 cards, copy operations are supported that allow the Inputs and
Processings already configured for an AMC8 card to be re-used elsewhere on the same
AMC8 card.
Using the copy operations for AMC8 card configurations helps to make the management of
VM600 MPS Software configurations easier. For example, one channel of an AMC8 card
could be configured and then re-used as the basis for other similar channels on the same
card.
Drag-and-drop operations are available for use with the Inputs of an AMC8 card
(Channels 1 to 8 and Multi-Channels 1 to 4).
To use the drag-and-drop operations:
• Click on an AMC8 card’s channel level node (Channel or Multi-Channel) in the

configuration tree to select it, then click on the channel again and drag it to a different
channel (Channel or Multi-Channel).

NOTE: The copy operations for AMC8 card configurations are limited to the same AMC8
card (not between different AMC8 cards) and work on a channel basis, that is, the
configuration of a channel input can be copied to another channel input, and the
configuration of a multi-channel input can be copied to another multi-channel input.
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13 DEFINING LOGICAL COMBINATIONS OF ALARMS 
(AMC8)

13.1Introduction
This section describes the Alarm Logical Combination branch of the configuration tree
structure, visible when an AMC8 card is selected (see Figure 13-1). This branch allows
logical combinations of alarms to be defined. The VM600 MPS1 software allows 16 basic
functions and 8 advanced functions to be configured. 

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on logical combinations of alarms. 

Figure 13-1: Structure of the Alarm Logical Combination branch
of the AMC8 configuration tree structure
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13.2Defining a basic alarm function
A window resembling that shown in Figure 13-2 appears when one of the 16 Basic Functions
is selected from the Alarm Logical Combination branch of the configuration tree structure. All
operations can be done from this single window.
To define a basic function:
1- Determine which alarms have to be taken into consideration.

You can choose among the eight Single Channels, the four Multi-Channels and the
various Status flags (Alarm Reset, Danger Bypass and so on).
One or more alarms can be selected from a given channel (for example, it is possible to
select the Alert+ High and the Alert− Low alarms for Channel 1).

2- Use the mouse pointer to select each required alarm. Note that three states are possible:

3- Select the logical function (AND, OR, Voting Logic) by clicking the appropriate radio
button (Logical AND, Logical OR or Voting Logic).
If Voting Logic is selected, you must enter a number in the Majority Parameter field. In
the example shown in Figure 13-2, Basic Function 1 shows an alarm condition if four or
more of the eight constituent alarms are signalled.

4- The result of the logical function can be negated (inverted) if required by selecting the
Inverted radio button. Otherwise, select the Not Inverted button.
Alternatively, keep clicking the required alarm to cycle between the three states: inactive,
active and inverted.

The alarm is not taken into consideration

The alarm is taken into consideration

The negated (or inverted) state of the alarm is taken into consideration

Figure 13-2: Window to select alarms for basic alarm combinations
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Notes:
It is important to note that when the channel inhibit function is activated for an AMC8 channel,
the following flags (bits) for the channel processing are forced to a known state:
• The error bit (Err), OK system check (SOK), alarm (A+, A−) and danger (D+, D−) flags

are all forced to a normal state (which is false, that is =0).
• The sensor bypassed (SBP) flag and the global channel OK fail flags are also set active.

NOTE: The MPS1 and MPS2 software packages use the SBP (sensor bypassed) flag to
refer to the channel inhibit function.

When the channel inhibit function is de-activated for an AMC8 channel, there is an associated
recovery time to allow for signal stabilisation. Refer to the VM600 machinery protection
system (MPS) hardware manual for further information.



SOFTWARE MANUAL Document reference MAMPS1-SW/E
VM600 MPS1 software Edition 12 - February 2021
13 - 4

Defining an advanced alarm function
DEFINING LOGICAL COMBINATIONS OF ALARMS (AMC8)

13.3Defining an advanced alarm function
A window resembling that shown in Figure 13-3 appears when one of the eight Advanced
Functions is selected from the Alarm Logical Combination branch of the configuration tree
structure.
To define an advanced alarm function:
1- Determine which basic alarm functions have to be taken into consideration.
2- Use the mouse pointer to select each required Basic Function. Note that three states are

possible:

3- Select the logical function (AND, OR, Voting Logic) by clicking the appropriate radio
button (Logical AND, Logical OR or Voting Logic).
If Voting Logic is selected, you must enter a number in the Majority Parameter field.

4- The result of the logical function can be negated (inverted) if required by selecting the
Inverted radio button. Otherwise, select the Not Inverted button.
Alternatively, keep clicking the required alarm to cycle between the three states: inactive,
active and inverted.

The alarm is not taken into consideration

The alarm is taken into consideration

The negated (or inverted) state of the alarm is taken into consideration

Figure 13-3: Window to configure advanced alarm functions
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14 OUTPUT MAPPING (AMC8)

14.1Introduction
This section describes the Output Mapping branch of the configuration tree structure, visible
when an AMC8 card is selected (see Figure 14-1). 

The Output Mapping \ Discrete Outputs branch allows individual and logically combined
alarms to be attributed to specific relays on the IOC and RLC cards. 
The Output Mapping \ DC Outputs branch allows the eight DC outputs (DC OUT 1 to
DC OUT 8) to be configured.

14.2Mapping alarms (discrete outputs)
The IOC8T card has four local relays. Alarm signals can be directly attributed to these relays
under software control. No hardware adjustments need to be made, with the exception of the
micro-switches on the IOC8T card that are used to configure the card’s relays as normally
energised (NE) or normally de-energised (NDE).

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on using these micro-switches.

If additional relays are needed, an RLC16 card containing 16 relays can be installed in the
VM600 MPS. An alarm signal is attributed to a relay on the RLC16 in two stages:
1- The alarm signal is mapped to a relay using the VM600 MPS1 software. The user can

choose whether the mapping takes place via the Open Collector Bus (OC Bus) or the
Raw Bus.

2- If the OC Bus is used, a jumper must be set on the RLC16 card to enable the OC Bus
line that is associated with that specific relay.
or

3- If the Raw Bus is used, a jumper must be set on the IOC8T card to select one of the four
Raw Bus line associated with that particular relay. Another jumper must be set on the
RLC16 card to connect the Raw Bus line chosen to the specific relay.

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information on using the OC Bus and the Raw Bus to switch relays on the
RLC16.

Figure 14-1: Structure of the Output Mapping branch 
of the AMC8 configuration tree structure
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Alarms are mapped to specific relays on the IOC8T card or RLC16 card (via OC Bus lines or
Raw Bus lines) using the Discrete Outputs node in the Output Mapping branch of the
configuration tree structure. When this node is selected, a relay mapping window appears
(see Figure 14-2). This contains:
1- A Relay Mapping tree structure (left)
2- Combo boxes called Source and Type for selection of alarms
3- An Apply button.

To map an alarm to a relay:
1- Click a node (small box containing a “+” sign) in the tree structure to show more of the

tree (Figure 14-3 shows the IOC Relays branch opened up).
Select the branches as follows:

Each line of a branch represents a relay. The numbers correspond to the relay numbers
found on the rear panel of the respective card (IOC8T or RLC16).

2- Click the appropriate line to select a specific relay.
3- Choose an entry from the Source combo box. This allows the choice of any single

channel, multi-channel, logically combined alarm (basic function or advanced function)
or Common Status information.

4- Choose an entry from the Type combo box to precisely define the alarm.
5- Click the Apply button to attribute the alarm signal to the relay. The line now shows the

alarm designation (for example, in Figure 14-3, Relay 2 on the IOC8T is attributed to the
Channel 1 Alarm+ signal.

You cannot attribute the same alarm to two different relays. If this is attempted, an error
message appears asking if you want to delete the first mapping. Click Yes or No as
appropriate.

IOC Relays To select one of the 4 local relays on the IOC8T card.

RLC / OC Bus To select one of the 16 relays on the RLC16 card using the
OC Bus.

RLC / Raw Bus To select one of the 16 relays on the RLC16 card using the
Raw Bus.
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Figure 14-2: Relay Mapping tree structure (for AMC8 card)

Figure 14-3: Example of attributing Relay 2 on the IOC8T card 
to the “Channel 1, Alarm+” alarm

Figure 14-4: Example of attributing Relay 2 on the RLC16 card to Basic Function 3.
The OC Bus is used to route the alarm.
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14.3Configuring DC outputs (analog outputs)
The IOC8T has eight analog outputs named DC OUT 1 to DC OUT 8. These are configured
in the factory to provide a current-based output of 4 to 20 mA.

NOTE: On special request, these eight outputs can be configured to provide a
voltage-based output (0 to 10 V).
Contact your nearest Meggitt representative for further information on this option.

Specific signals may be attributed to each analog output by selecting the Output
Mapping\DC  Outputs branch of the configuration tree structure. When this node is chosen,
a DC Outputs configuration window appears (see Figure 14-5).

To configure a specific DC output:
1- Click the combo box in the left-most column (IOC DC Output) to show the list of signals

that can be chosen. 

NOTE: In the window, IOC DC Output 1 corresponds to the terminal called DC OUT 1
on the panel of the IOC8T card.
Similarly, IOC DC Output 2 corresponds to DC OUT 2, and so on.

In the example shown in Figure 14-5, the choices are Channel 1, Channel 2, Channel 3,
Multi-Channel 1 and Mult-Channel 4.
Note that these five channels are highlighted in blue in the Inputs \ Processing branch of
the configuration tree structure, indicating that for each of them the Channel Used field
on the Input Configuration tab is set to Used (see Figure 12-4).

2- Choose a signal from the list.
3- Enter a value in the Minimum Level column.

This value corresponds to an output of 4 mA (or 0 V if a voltage-based output is
configured)

4- Enter a value in the Maximum Level column.
This value corresponds to an output of 20 mA (or 10 V if a voltage-based output is
configured)

To delete an existing routing
If you want to delete an existing analog output definition:
1- Select the signal again from the combo box in the left-most column (IOC DC Output).
2- Select the Not Used option.
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Figure 14-5: DC Outputs configuration window (for AMC8 card)
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15 COMMUNICATIONS MENU (AMC8)

15.1Introduction
This section describes the commands available in the Communications drop-down menu at
rack level and at AMC8 card level (see 6 Main window menus and commands). The structure
of the menu is shown in Figure 15-1.

Note that at rack level (that is, when a rack is highlighted in the configuration tree structure),
selecting Read Configuration uploads the configuration of all cards from the rack and
selecting Send Configuration downloads the configuration of all cards to the rack.
See also 6.3.3 Sending a configuration to a VM600 rack or card.

Figure 15-1: Communications drop-down menu 
at rack level and at AMC8 card level

(a) Communications menu when a
rack is highlighted in the configuration
tree structure

(b) Communications menu when an
AMC8 card is highlighted in the configuration 
tree structure
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15.2Communication with a stand-alone rack (no CPUM present)
The procedure for a rack with AMC8 cards is the same as for a rack with MPC4 cards.

NOTE: See 11.2 Communication with a stand-alone rack (no CPUM present) for details.
Simply read “AMC8” for “MPC4” in the description.

15.3Communication with a networked rack (CPUM present)
The procedure for a rack with AMC8 cards is the same as for a rack with MPC4 cards. 

NOTE: See 11.3 Communication with a networked rack (CPUM present) for details.
Simply read “AMC8” for “MPC4” in the description.

15.4Downloading the configuration (Send Configuration)
See also 6.3.3 Sending a configuration to a VM600 rack or card.

Networked rack
To download an entire rack configuration to a networked rack:
1- Activate the communications link (Ethernet or PPP) to the rack as described in

11.3 Communication with a networked rack (CPUM present).
2- From the configuration tree structure, select the rack you want to download the

configuration to.
This should be the same rack as in step 1 above.

3- Select Send Configuration from the Communications drop-down menu.
To download a single card’s configuration to a networked rack:
1- In the configuration tree structure, select the card you want to download.
2- Select Communications, To AMC, and Send Configuration.

Stand-alone rack
For a stand-alone rack, the configuration of each card can be downloaded one card at a time
as follows:
1- Activate the communications link (RS-232 serial link) to the card in question as described

in 11.2.1 Setup procedure.
2- From the configuration tree structure, select the card you want to download the

configuration to.
This should be the same card as in step 1 above.

3- Select To AMC from the Communications drop-down menu and choose the Send
Configuration command.
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15.5Reading the configuration (Read Configuration)
When a new card is installed in a slot its configuration can be “uploaded” to the VM600 MPS1
software for analysis.
If required, the configuration can then be saved under a particular name by selecting Export
AMC Configuration from the File drop-down menu.

Networked rack
To upload the configuration of an individual card, or the entire rack, to the personal computer:
1- Activate the communications link (Ethernet or PPP) to the rack as described in

11.3 Communication with a networked rack (CPUM present).
2- From the configuration tree structure, select the card you want to upload the

configuration from.
You can also upload the configuration of the entire rack by selecting the rack in the
configuration tree structure.

3- Select Read Configuration from the Communications drop-down menu.

Stand-alone rack
For a stand-alone rack, the configuration of each card can be uploaded one card at a time as
follows:
1- Activate the communications link (RS-232 serial link) to the card in question as described

in 11.2.1 Setup procedure.
2- From the configuration tree structure, select the card you want to upload the

configuration from.
This should be the same card as in step 1 above.

3- Select From AMC from the Communications drop-down menu and choose the Read
Configuration command.

15.6Testing the communications link (Read System Identification)
To test the communication link, select From AMC from the Communications menu and
choose the Read System Identification command. The System Identification window
appears, as shown in Figure 15-2.
In the case of a problem, this window contains information that can be communicated to
Meggitt customer support.

Figure 15-2: System Identification window (for AMC8 / IOC8T card pair)
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15.7The status latch (clearing and reading)
When an alarm or flag with the ability to be latched occurs, the event is noted on a “latched
event list”. This can be examined by selecting From AMC from the Communications menu
and then choosing the Read Status Latch Data command. A window resembling that shown
in Figure 15-3 appears.
This feature is useful for checking if an event has occurred over a certain period of time (that
is, since the last Clear Status Latch Data operation), when the operator cannot permanently
check the output data.
The latched data can be cleared at any moment by selecting To AMC from the
Communications menu and then choosing the Clear Status Latch Data command.

Data Concerning Single Channels and Multi-Channels
Information on each channel is provided as a 32-bit value that is hexadecimal coded and
represented by eight bytes (the prefix “0x” indicates the data is in hexadecimal). If no
alarm/failure is present, the code 0x00000000 is returned. If an alarm/failure occurs, the code
is followed by text describing the problem (for example, Alarm+, Global Channel OK Fail).
The 32-bits are defined as shown in Table 15-1.

Data Concerning Common Status
Common Status information is provided as a 32-bit value that is hexadecimal coded and
represented by eight bytes. The code is followed by text describing the status (for example,
Status Latched).
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The 32-bits are defined as shown in Table 15-2. 

Figure 15-3: Read Status Latch Data window
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Table 15-1: Definition of bits for latch data concerning single channels and multi-channels

Bit Number Hex. Byte Definition

Bit 0

0 (LSB)

Alarm+ (boolean)

Bit 1 Alarm− (boolean)

Bit 2 Danger+ (boolean)

Bit 3 Danger− (boolean)

Bit 4

1

Global Channel OK fail (boolean)

Bit 5 A/D error set (boolean)

Bit 6 A/D standby set (boolean)

Bit 7 A/D PLL lock error (boolean)

Bit 8

2

A/D transmission error (boolean)

Bit 9 A/D dynamic configuration error (boolean)

Bit 10 BIT result fail (boolean)

Bit 11 No sample received (boolean)

Bit 12

3

OK Level fail (boolean)

Bit 13 Outside linearisation range error (boolean)

Bit 14 Cold junction temperature error (boolean)

Bit 15 Not used

Bits 16 to 19 4 Not used

Bits 20 to 23 5 Not used

Bits 24 to 27 6 Not used

Bits 28 to 31 7 (MSB) Not used

Status of bits:

Setting Definition

Bit set to 0 (false) normal / no Alarm / no Danger / flag not set / no error

Bit set to 1 (true) not normal / Alarm / Danger / flag set / error



Document reference MAMPS1-SW/E SOFTWARE MANUAL
Edition 12 - February 2021 VM600 MPS1 software

15 - 7

The AMC outputs window (Read Outputs)
COMMUNICATIONS MENU (AMC8)

15.8The AMC outputs window (Read Outputs)
The AMC Outputs window (Figure 15-4) show detailed information concerning measured
values, alarms, hardware and software status. The window is called up by selecting
From AMC from the Communications menu and then choosing the Read Outputs
command.
Measurements can be obtained in two ways:
1- A single acquisition can be made, providing a “snapshot” of the machine status at a given

moment in time.
To do this, click the Get Outputs button (Figure 15-5). The button to the right of this one
should read “Poll Outputs” (indicating continuous acquisitions are presently disabled).

2- A continuous series of acquisitions can be made. The period between successive
acquisitions is fixed at 1.0 second.
To do this, click the Poll Outputs button (Figure 15-5). The text on the button changes
to “End Polling” when this is done. Click the End Polling button to stop acquiring data.

To end the session, click the Done button.

Table 15-2: Definition of bits for latch data concerning common status

Bit Number Hex. 
Byte Definition

Bit 0

0 (LSB)

ACNR: AMC configuration not running (boolean)

Bit 1 AR: Alarm Reset (boolean)

Bit 2 DB: Danger Bypass (boolean)

Bit 3 SL: Status Latched (boolean)

Bits 4 to 7 1 Not used

Bits 8 to 11 2 Not used

Bits 12 to 15 3) Not used

Bits 16 to 19 4 Not used

Bits 20 to 23 5 Not used

Bits 24 to 27 6 Not used

Bits 28 to 31 7 (MSB) Not used

Status of bits:

Setting Definition

Bit set to 0 (false) Configuration running / no SL / no DB / no AR

Bit set to 1 (true) Not normal / Alarm / Danger / flag set / error
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15.8.1 Explanation of fields
The AMC Outputs window can be broken down into the following areas for the purposes of
this explanation:
1- Fields concerning the eight single channels (see Figure 15-6)
2- Fields concerning the four multi-channels (see Figure 15-8)
3- Fields concerning the basic and advanced logical combinations of alarms (see

Figure 15-9)
4- Fields concerning status information (see Figure 15-10)
The AMC Running indicator (see Figure 15-4) has the following behaviour:
• It flashes green/white alternately when the configuration is running.
• It is continually red when the configuration is not running.

When this occurs, it is often due to an incorrect configuration. It may also occur during
the AMC8 card's warm-up period.

Figure 15-4: Typical AMC Outputs window
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15.8.1.1 Fields concerning the eight single channels

The AMC Outputs window shows measured values and alarm status for the eight single
channels (see Figure 15-6).
A line appears dimmed (greyed out) if the Channel Used field on the Input Configuration tab
(see Figure 12-4) is set to Not Used (this is the case for Channel 8 in Figure 15-6).
The first column shows the channel number, followed in brackets by the sensor tag entered
for the channel. This tag is defined in the Tag field of the Input Configuration tab.
The second column shows the measured value. This is expressed in the units selected in the
Output Unit field of the Processing & Alarms tab (see Figure 12-13).

The Alert+ (A+) and Alert− (A−) alarm flags indicate when the measured value is in/out of
Alert limits. The following colour coding applies:
• Grey, indicating the value is within Alert limits
• Yellow, indicating the value is out of Alert limits.

The Danger+ (D+) and Danger− (D−) alarm flags indicate when the measured value is in/out
of Danger limits. The following colour coding applies:
• Grey, indicating the value is within Danger limits

(NB: The value may nevertheless be out of Alert limits)
• Red, indicating the value is out of Danger limits.

The Channel Status OK indicator shows at a glance whether there is a processing error for
the channel in question. The following colour coding applies:
• Green, indicating no channel failure
• Red, indicating channel failure.

More information on the channel status can be obtained by clicking the Details button. A
window resembling that shown in Figure 15-7 appears when this is done. In the absence of
a problem, every parameter is indicated as being “false”.

Figure 15-5: Get Outputs and Poll Outputs buttons
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15.8.1.2 Fields concerning the four multi-channels

The AMC Outputs window shows measured values and alarm status for the four
multi-channels (see Figure 15-8). The type of information shown, the colour-coding of alarms
and so on, is exactly as for the eight single channels. See 15.8.1.1 Fields concerning the
eight single channels for further information.

Figure 15-6: Fields concerning the eight single channels

Measured value for
Channel 7

Sensor tag for
Channel 7

Danger+ indicator
(red when alarm)

Alert+ indicator
(yellow when alarm)

Channel Status OK indicator
Green: no channel failure
Red: channel failure

AMC Running indicator

Figure 15-7: Window showing channel status details
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15.8.1.3 Fields concerning basic and advanced logical combinations of alarms

The AMC Outputs window shows the status of the 16 Basic and 8 Advanced logical
combinations of alarms (Figure 15-9).

However, when a logical combination of alarms is used to display the status of an OK system
check (SOK) flag:
• The logical combination is show as red when the OK system check is OK (as the SOK

flag has a logical value of 1 when there is not a problem).
• The logical combination is show as green the OK system check is not OK (as the SOK

flag has a logical value of 0 when there is a problem).

Figure 15-8: Fields concerning the four multi-channels

Measured value for
Multi-Channel 1

Sensor tag for
Multi-Channel 1

Danger+ indicator
(red when alarm)

Alert+ indicator
(yellow when alarm)

Channel Status OK indicator
Green: no channel failure
Red: channel failure

Figure 15-9: Fields concerning the basic and advanced 
logical combinations of alarms
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15.8.1.4 Fields concerning status information

The MPC Outputs window shows information on common alarms as well as status
information for diagnostics purposes. 

The Status Latch flag (Figure 15-10) has the following colour coding:
• Green, indicating no data has been latched since the last Clear Status Latch Data

operation
• Red, indicating data has been latched.
See also 15.7 The status latch (clearing and reading).

The DB and AR flags are summarised in Table 15-3.

15.9Resetting alarms (Alarm Reset)
Alarms indicated by the status indicators (LEDs) on the front panel of the AMC8 card, or on
the AMC Outputs window, can be reset by selecting To AMC from the Communications
menu and then choosing the Alarm Reset command.

15.10Checking LEDs on the AMC8 front panel (Lamp Test)
All the status indicators (LEDs) on the front panel of the AMC8 card can be tested by selecting
To AMC from the Communications menu and then choosing the Lamp Test command.
This action initiates a single test cycle that activates sequentially each possible colour of each
multi-colour LED.

15.11Checking the card status (Read System Status)
This menu command is mainly provided for troubleshooting purposes. In case of problems
with a card, Meggitt customer support may ask you to pass on to them certain information
available from the VM600 MPS software (see Figure 15-11).

Figure 15-10: Fields concerning status information

Table 15-3: Danger Bypass (DB) and Alarm Reset (AR) flags

Flag name Description Colour coding

DB Danger Bypass indicator Green: indicating DB or AR is not active
Red: indicating DB or AR is activeAR Alarm Reset indicator



Document reference MAMPS1-SW/E SOFTWARE MANUAL
Edition 12 - February 2021 VM600 MPS1 software

15 - 13

Checking the card status (Read System Status)
COMMUNICATIONS MENU (AMC8)

To view the card status, select From AMC from the Communications menu and then select
the Read System Status command.

Figure 15-11: Read System Status window (AMC8 / IOC8T card pair)
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15.12Inhibiting a channel (Channel Inhibits)
The channel inhibit function allows individual AMC8 channels to be temporarily bypassed,
that is, it temporarily inhibits the protection offered by any associated relays.
The channel inhibit function is intended to allow a component in a measurement system
front-end, such as a sensor/transducer or signal conditioner, to be replaced for an individual
channel while the other machinery monitoring channels and functions continue to operate as
normal.
This allows the machinery being monitored to continue to operate (if the protection offered by
the other machinery monitoring channels and functions is adequate). It also allows any
control system using the relays to avoid false trips during such maintenance activity.

The channel inhibit function is activated when one of the VM600 MPS software packages
(MPS1 or MPS2) is used to send channel inhibit commands to individual AMC8 channels.
Alternatively, Modbus can be used to control the channel inhibit function for a networked
VM600 machinery protection system (containing a CPUM card).

To activate the channel inhibit function for an AMC8 channel or channels:
1- Click Communications > To AMC > Channel Inhibits.
2- Use the Channel Inhibits dialog box that appears to select the Channels for which the

channel inhibit function is required. Then click Send.
The channel inhibit function is activated for the selected channels.

When the channel inhibit function is activated for an AMC8 channel:
• The channel continues its processing as per its configuration – except for any associated

relay functionality, but any processing channels that depend on the channel are also
automatically bypassed.

• Any DC output functionality associated with the channel continues, if enabled.
• Certain flags (bits) for the channel processing are forced to a known normal state in order

to help ensure the continued operation of the machinery monitoring system
(see 13.2 Defining a basic alarm function).

• The channel’s status indicator (LED) on the panel of the AMC8 card slowly blinks green
for the duration of the channel inhibit (approximately once per second).

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information.

• An Inhibit On event is recorded in the database.
• The AMC outputs window displays the channel information with an “Inhibited” label and

in grey coloured text (see 15.8 The AMC outputs window (Read Outputs).
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Also, clicking Communications > To AMC > Channel Inhibits again will display the
Channel Inhibits dialog box with the check boxes selected for each inhibited channel.

NOTE: When an AMC8 card is configured (for example, using Communications > To
AMC > Send Configuration), the channel inhibit function is automatically
de-activated for any channels where it is active.

To de-activate the channel inhibit function for an AMC8 channel or channels:
1- Click Communications > To AMC > Channel Inhibits.
2- Use the Channel Inhibits dialog box that appears to clear the Channels for which the

channel inhibit function is no longer required. Then click Send.
The channel inhibit function is de-activated for the cleared channels.

When the channel inhibit function is de-activated for an AMC8 channel:
• The AMC8 card waits 12 seconds for signal stabilisation (total recovery time).

NOTE: Refer to the VM600 machinery protection system (MPS) hardware manual for
further information.

• Any latched alarms are reset (cleared) and the processing channels that depend on the
channel resume normal operation.

• The flags for the channel processing return the true status of the machinery monitoring
system. The sensor bypassed (SBP) flag is also set inactive (=0).

• The channel’s status indicator (LED) on the front panel of the AMC8 card indicates the
operational status of the card.

• An Inhibit Off event is recorded in the database.
• The AMC outputs window displays the channel information as usual (see 15.8 The AMC

outputs window (Read Outputs).

NOTE: Cards that support the channel inhibit function can coexist in a a VM600 rack with
cards (running older versions of firmware) that do not support this function.
For cards that do not support the channel inhibit function, the VM600 MPS software
will report the channel inhibit function as unavailable.
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16 CONFIGURATION WINDOWS AT RACK LEVEL

16.1Introduction
This section is intended to help you navigate around the VM600 rack backplane. It describes
the five tabs seen at rack level, that is, when a rack is selected in the configuration tree
structure (see Figure 16-1):

General Information See 16.2 The general information tab.

Backplane Bus View See 16.3 The backplane bus view tab.

Backplane
Configuration

See 16.4 The backplane configuration tab.

IOC Jumper Matrix See 16.5 IOC jumper matrix and RLC jumper matrix tabs.

RLC Jumper Matrix See 16.5 IOC jumper matrix and RLC jumper matrix tabs.

Figure 16-1: Appearance of window at rack level (General Information tab)

See 6.3 Managing racks for information on these fields.

See 11.2 Communication with a stand-alone rack (no CPUM present) 
and 11.3 Communication with a networked rack (CPUM present) 
for information on the CPU Present check box and Hostname field.
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16.2The general information tab
This section describes the check boxes under Rack Rear Layout (see Figure 16-1 and
Figure 16-2). This area contains 18 check boxes. These represent slots 1 to 18 at the rear of
the VM600 rack. These slots are intended to house various types of input/output cards
(IOC4T, IOC8T) and relay cards (RLC16).
A slot number shown in red indicates that it is occupied by an MPC4 / IOC4T card pair (see
Figure 16-1 and Figure 16-2, where slots 3 and 5 contain this type of card pair).
A slot number shown in blue indicates that it is occupied by an AMC8 / IOC8T card pair (see
Figure 16-1 and Figure 16-2, where slots 7 and 9 contain this type of card pair).
Slots 1, 2, 15, 16, 17 and 18 (shown on a dark grey background) have special significance.
An RLC16 card housed in any one of these slots can be communicated with over the OC Bus
under certain conditions. For example, a card pair in slot 5 or 6 can switch relays on an
RLC16 card in slot 2 using the OC Bus. See Figure 16-3 and refer to the VM600 machinery
protection system (MPS) hardware manual for further information.

NOTE: It is very important to identify the slots that contain an RLC16 card by selecting
(clicking) the corresponding check boxes (for example, in Figure 16-2 slots 1, 2
and 4 contain an RLC16 card).

Figure 16-2: Rack Rear Layout area of the General Information tab
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16.3The backplane bus view tab
This read-only tab (Figure 16-4) provides information at a glance on the VM600 rack’s three
internal buses. This section shows how this tab relates to information entered on other
windows. 

RLC16
locations

IOC4T, IOC8T, IRC4 or RLC16
locations

IRC4 or RLC16
locations

IOCN
location

OC Bus F

OC Bus E

OC Bus D

OC Bus C

OC Bus B

OC Bus A

1718 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

IRC4 or RLC16
location

Raw Bus

Figure 16-3: Rear view of rack showing the six dedicated OC Buses
and the Raw Bus (top)

Notes:
OC Bus A allows a card pair in slot 3 or 4 to communicate with an RLC16 in slot 1.
OC Bus B allows a card pair in slot 5 or 6 to communicate with an RLC16 in slot 2.
And so on.

Figure 16-4: Backplane Bus View showing the three buses
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16.3.1 The Tacho Bus branch
Speed signals can be put onto a Tacho Bus line by selecting a destination in the Tachometer
Output field. This is visible when a speed channel is selected in the configuration tree
structure. See the example in Figure 16-5 (a).
A speed signal can be picked off a Tacho Bus line using the Sensor Connected field. This
is visible when a speed channel is selected in the configuration tree structure. See the
example in Figure 16-5 (b).
The routing of speed signals over the Tacho Bus is summarised in the Backplane Bus View,
as shown in Figure 16-5 (c).
Unused bus lines are shown in green. 
Tacho Bus lines 7 and 8 are reserved for routing cold-junction compensation (CJC) signals
between AMC8 cards in the rack and cannot be used for speed signals.
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Figure 16-5: Signals on the Tacho Bus

a. Placing the signal obtained on Speed Channel 2 (TACHO 2) of the MPC4 card in
slot 5 of Rack A onto Tacho Channel 3 (that is, line 3 of the Tacho Bus)

a. Using the signal on Remote
Channel 3 (that is, line 3 of
the Tacho Bus) as the
speed input for Channel 2
of the MPC4 card in slot 3 of
Rack A

a. How this configuration
is represented on the
Backplane Bus View
tab
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16.3.2 The OC Bus branch
Signals can be put on to the OC Bus by selecting the Output Mapping \ Discrete Outputs
branch of the configuration tree structure, as shown in Figure 16-6 (a). The software
automatically selects the appropriate OC Bus among the six that exist (OC Bus A to
OC Bus F). For example, in Figure 16-6, OC Bus A is selected because the signal originates
on the card pair in slot 3. This links slot 3 to the RLC16 card in slot 1 (see Figure 16-3).
The Backplane Bus View allows you to see which of the 16 OC Bus lines are free. These are
indicated in green, as shown in Figure 16-6 (b).
Choose a free OC Bus line for the signal. There is a direct correspondence between the line
chosen and the number of the relay on the target RLC16 card. In this example, choosing
OC Bus line 2 allows Relay 2 on the RLC16 card in slot 1 to be controlled by the signal.
Figure 16-6 (a) shows how to attribute the alarm signal “Measurement Channel 1, Output 1,
Danger+ High” to line 2. This setting can be checked on the Backplane Bus View tab as
shown in Figure 16-6 (b). This shows that Relay 2 is controlled by the signal having the code
“V11D+”.
See Table 16-1 for the definition of all codes that can be found on this tab. The table shows
how the fields were set up when the Output Mapping \ Discrete Outputs branch of the
configuration tree structure was selected (see Figure 16-6 (a)).
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Figure 16-6: Signals on the OC Bus

a. Attributing the alarm signal “Measurement Channel 1, Output 1, Danger+ High”
to line 2 on the OC Bus (OC Bus A, which links slots 3 and 4 to the RLC card in
slot 1)

a. Typical configuration on the Backplane Bus View tab

See Table 16-1 for definitions 
of codes
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Table 16-1: Definition of codes seen in the OC Bus branch of the backplane bus view (Part 1 of 3)

Code in Bus 
View

Card 
type

Configuration of fields when
Output Mapping \ Discrete Outputs branch selected

AFn MPC4 Combination Advanced 
Function Number n  (n = 1 to 4)

AFn AMC8 Advanced Logical 
Combination Function n  (n = 1 to 8)

Alarm Reset AMC8 Common Status Alarm Reset

AMC Not 
Running AMC8 Common Status AMC Configuration Not 

Running

AR MPC4 Common Controls Alarm Reset

BFn MPC4 Combination Basic Function Number n  (n = 1 to 8)

BFn AMC8 Basic Logical Combination Function n  (n = 1 to 16)

CA MPC4 Common Channels Alert

CCME MPC4 Common Signal 
Diagnostics Common Mode Overflow

CD MPC4 Common Channels Danger

CDSE MPC4 Common MPC Diagnostics DSP Saturation Error

CHn A− AMC8 Channel n  (n = 1 to 8) Alarm−

CHn A+ AMC8 Channel n  (n = 1 to 8) Alarm+

CHn D− AMC8 Channel n  (n = 1 to 8) Danger−

CHn D+ AMC8 Channel n  (n = 1 to 8) Danger+

CHn Global 
OK Fail AMC8 Channel n  (n = 1 to 8) Global Channel OK Fail

CIE MPC4 Common Signal 
Diagnostics Input Signal Error

CISE MPC4 Common Signal 
Diagnostics Input Saturation Error

CMF MPC4 Common MPC Diagnostics Monitoring Failure

COF MPC4 Common Channels Sensor OK Failure

CPE MPC4 Common MPC Diagnostics Processing Error

CSOL MPC4 Common Track/Speed 
Diagnostics Speed out of Limit

CTL MPC4 Common Track/Speed 
Diagnostics Track Lost

CTOR MPC4 Common Track/Speed 
Diagnostics Track out of Limit
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D12A− MPC4 (Dual) Measurement 
Channel 1 & 2 Output 1 Alert− Low

D12A+ MPC4 (Dual) Measurement 
Channel 1 & 2 Output 1 Alert+ High

D12D− MPC4 (Dual) Measurement 
Channel 1 & 2 Output 1 Danger− Low

D12D+ MPC4 (Dual) Measurement 
Channel 1 & 2 Output 1 Danger+ High

D12ERR MPC4 (Dual) Measurement 
Channel 1 & 2 Output 1 Invalid

D12PGA MPC4 (Dual) Measurement 
Channel 1 & 2 PGA Saturation Error

D12SOK MPC4 (Dual) Measurement 
Channel 1 & 2 SOK Level

D34… MPC4 (Dual) Measurement 
Channel 3 & 4 Output 1 … (as for Dual Channel 

1 & 2)

Danger 
Bypass AMC8 Common Status Danger Bypass

DBP MPC4 Common Controls Danger Bypass

DTM MPC4 Common Controls Direct Trip Multiply

MCHn Global 
OK Fail AMC8 Multi-Channel n

(n = 1 to 4) Global Channel OK Fail

MCHn A− AMC8 Multi-Channel n
(n = 1 to 4) Alarm−

MCHn A+ AMC8 Multi-Channel n
(n = 1 to 4) Alarm+

MCHn D− AMC8 Multi-Channel n
(n = 1 to 4) Danger−

MCHn D+ AMC8 Multi-Channel n
(n = 1 to 4) Danger+

MCR MPC4 Common MPC Diagnostics MPC Card Running

S1A− MPC4 Speed Channel 1 Alert− Low

S1A+ MPC4 Speed Channel 1 Alert+ High

S1ERR MPC4 Speed Channel 1 Invalid

S1SOK MPC4 Speed Channel 1 SOK Level

Table 16-1: Definition of codes seen in the OC Bus branch of the backplane bus view (Part 2 of 3)

Code in Bus 
View

Card 
type

Configuration of fields when
Output Mapping \ Discrete Outputs branch selected
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S2… MPC4 Speed Channel 2 …  (as for Speed 
Channel 1)

SL MPC4 Common MPC Diagnostics Status Latch / Error Log

Status 
Latched AMC8 Common Status Status Latched

V11A− MPC4 Measurement Channel 1 Output 1 Alert− Low

V11A+ MPC4 Measurement Channel 1 Output 1 Alert+ High

V11D− MPC4 Measurement Channel 1 Output 1 Danger− Low

V11D+ MPC4 Measurement Channel 1 Output 1 Danger+ High

V11ERR MPC4 Measurement Channel 1 Output 1 Invalid

VnPGA MPC4 Measurement Channel n
(n = 1 to 4) PGA Saturation Error

VnSOK MPC4 Measurement Channel n
(n = 1 to 4) SOK Level

V12… MPC4 Measurement Channel 1 Output 2  … (as for Channel 1, 
Output 1)

V21… MPC4 Measurement Channel 2 Output 1  … (as for Channel 1, 
Output 1)

V22… MPC4 Measurement Channel 2 Output 2  … (as for Channel 1, 
Output 1)

V31… MPC4 Measurement Channel 3 Output 1  … (as for Channel 1, 
Output 1)

V32… MPC4 Measurement Channel 3 Output 2  … (as for Channel 1, 
Output 1)

V41… MPC4 Measurement Channel 4 Output 1  … (as for Channel 1, 
Output 1)

V42… MPC4 Measurement Channel 4 Output 2  … (as for Channel 1, 
Output 1)

Table 16-1: Definition of codes seen in the OC Bus branch of the backplane bus view (Part 3 of 3)

Code in Bus 
View

Card 
type

Configuration of fields when
Output Mapping \ Discrete Outputs branch selected
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16.3.3 The Raw Bus branch
The raw signal entering each channel of an MPC4 / IOC4T card pair can be placed on the
Raw Bus for use by other cards in the VM600 rack.
The Raw Bus contains 32 pairs of lines for this purpose. These pairs have one line defined
as “High” and the other as “Low”.
To attribute a pair of lines to a particular card and channel:
1- Select the rack in the configuration tree structure as shown in Figure 16-7 (a).
2- Select the Backplane Configuration tab.
3- Select the slot number and channel number from the Raw Signals / Raw Bus branch of

the tree structure.
4- Pick a pair of lines from those proposed in the Raw Signal Attribution Lines combo

box. The software automatically displays only the possibilities that are allowed by the
hardware configuration.

5- Click the Apply button.
Figure 16-7 (a) shows how the raw signal on Channel 2 of the card pair in slot 5 can be placed
on Raw Bus line pair “37 - 5”.
Figure 16-7 (b) shows how this appears on the Backplane Bus View tab. Lines 5 and 37 are
identified as Raw Signal Low and Raw Signal High, respectively.
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Figure 16-7: Signals on the Raw Bus

a. Attributing the signal on Channel 2 of the card in slot 5 to
the Raw Bus line pair “37 - 5”

b. How this configuration appears on the Backplane
Bus View tab
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16.4The backplane configuration tab

16.4.1 The Tacho Bus branch
This read-only branch of the tree structure shows the signals on the Tacho Bus.
Figure 16-8 shows the appearance of the Tacho Bus branch if the software is configured as
described in the example given in Figure 16-5.

16.4.2 The OC Bus branch
Figure 16-9 shows the appearance of the OC Bus branch if the software is configured as
described in the example given in Figure 16-6.
This branch of the tree structure allows the polarity of a relay on an RLC16 card to be set, as
follows:
1- Select a signal from the OC Bus branch of the tree structure.

The example in Figure 16-9 shows how to select the signal driving Relay 2 on the RLC16
card in slot 1.

2- Select the desired polarity from the Relay Polarity combo box:
• NDE = Relay normally de-energised
• NE = Relay normally energised.

3- Click the Apply button.

Figure 16-8: Tacho Bus branch
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The setting of each relay is shown in brackets at the end of each line.

16.4.3 The discrete information / Raw Bus branch
Relays on an RLC16 card can be controlled over the Raw Bus, as well as over the OC Bus
as previously described.
To place a relay control signal on the Raw Bus:
1- Select the Output Mapping / Discrete Outputs branch of the configuration tree structure,

as shown on the left of Figure 16-10 (a).
2- Open the Relay Mapping / RLC / Raw Bus branch of the tree structure appearing on the

right of the window.
This branch lists 16 bus lines, identified as #1 to #16. There is a direct correspondence
between the line number and the number of the relay on the target RLC16 card.

3- Select the line that corresponds to the number of the relay you want to switch, for
example select line #3 for Relay 3.

4- Attribute a signal to the line using the combo boxes on the right of the window.
5- Click the Apply button.

To configure the relay control signal:
1- Select the rack in the main configuration tree structure, as shown in Figure 16-10 (b).
2- Select the Backplane Configuration tab and open up the Discrete Information / Raw Bus

branch of the tree structure.
3- Select the line corresponding to the relay control signal. These signals are identified by

a code such as “V32A+” (see Table 16-1 for a definition of all possible codes).
4- Select the target RLC16 card from the RLC Destination Slots combo box. This lists the

slot numbers of all RLC16 cards defined for the rack. For example, if the Rack Rear

Figure 16-9: Defining relay characteristics for signals using the OC Bus
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Layout check boxes are set up as shown in Figure 16-2, only slots 1, 2 and 4 are shown
in the list.

5- Select a bus line from the Discrete Info Attribution Line combo box. The software
automatically proposes only the bus lines that are relevant to the relay number in
question, but care must be taken to avoid putting conflicting signals on the same bus line.
See 16.4.3.1 Avoiding signal conflicts on the same bus line below.

6- Select the desired polarity from the Relay Polarity combo box:
• NDE = Relay normally de-energised
• NE = Relay normally energised.

7- Click the Apply button.

Figure 16-10: Signals on the OC Bus

a. Attributing the alarm signal “Measurement Channel 3, Output 2, Alert+ High” to line 3 on 
the Raw Bus. This allows Relay 3 to be controlled on a given RLC16 card. 

b. Typical configuration on the Backplane Configuration tab
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16.4.3.1 Avoiding signal conflicts on the same bus line

It is important to avoid creating signal conflicts on the same bus line. An example is shown in
Figure 16-11.
As seen in Figure 16-11 (a), line 41 is already used to switch Relay 3 on the RLC16 card in
slot 4. The control signal has the code “V32A+” and it originates in slot 3.
The control signal “V41A+”, which originates in slot 5, is intended to switch Relay 3 on the
RLC16 card in slot 1.
When the RLC Destination Slots field is set to “1”, the first entry in the Discrete Info
Attribution Line field shows “41”. This value must not be applied as it will cause a signal
conflict on bus line 41. You must select an alternative value (49 or 57) from the combo box
as shown in Figure 16-11 (b).

16.4.4 The raw signals / Raw Bus branch
See 16.3.3 The Raw Bus branch for a description of this branch.

Figure 16-11: Avoiding signal conflicts on the same Raw Bus line

a. Configuring the signal “V41A+” to switch Relay 3 on the card in slot 1.
Line 41 is proposed, but this line is already used for the signal “V32A+”.

b. Select an alternative line (49 or 57) from the combo box.



Document reference MAMPS1-SW/E SOFTWARE MANUAL
Edition 12 - February 2021 VM600 MPS1 software

16 - 17

IOC jumper matrix and RLC jumper matrix tabs
CONFIGURATION WINDOWS AT RACK LEVEL

16.5IOC jumper matrix and RLC jumper matrix tabs
These tabs provide a pictorial representation of how jumpers should be set on the IOC4T,
IOC8T and RLC16 cards in the rack. See the examples shown in Figure 16-13 to
Figure 16-15. A tab is present for each IOC and RLC card installed in the rack.

16.5.1 Using the shortcut menu
Place the mouse pointer over the jumper matrix diagram and click the right mouse button to
obtain the shortcut menu shown in Figure 16-12. 

This menu has the following three commands:

Print Prints out the diagram that is displayed on the screen.

Printer Setup Allows you to choose a printer and set up the printer properties.

Jumper
Information

Opens a relay map summary window. See 16.5.2 Jumper information
(Relay Map Summary).

Figure 16-12: shortcut menu for jumper matrix windows
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Figure 16-13: Typical jumper matrix for an IOC4T card
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Figure 16-14: Typical jumper matrix for an IOC8T card
(also showing the shortcut menu to print the diagram)
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Figure 16-15: Typical jumper matrix for an RLC16 card
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16.5.2 Jumper information (Relay Map Summary)
A Relay Map Summary window appears when the Jumper Information command is chosen
from the shortcut menu. A typical example for an IOC4T card is shown in Figure 16-16.

Figure 16-16: Typical Relay Map Summary windows

Toolbar

Print the information appearing on the screen

a. Summary 
window for 
IOC4T card 

b. Summary 
window for 
RLC16 card

Save the information as a text document (.txt extension)
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17 SERVICE AND SUPPORT

17.1Contacting us
Meggitt’s worldwide customer support network offers a range of support, including
17.2 Technical support and 17.3 Sales and repairs support. For customer support, contact
your local Meggitt representative. Alternatively, contact our main office:

Customer support department
Meggitt SA

Route de Moncor 4
Case postale
1701 Fribourg
Switzerland

Telephone: +41 26 407 11 11
Email: energysupport@ch.meggitt.com

Website: www.meggittsensing.com/energy

17.2Technical support
Meggitt’s technical support team provide both pre-sales and post-sales technical support,
including:
• General advice
• Technical advice
• Troubleshooting
• Site visits.

NOTE: For further information, contact your local Meggitt representative or Meggitt SA
(see 17.1 Contacting us).

http://www.meggittsensing.com/energy
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17.3Sales and repairs support
Meggitt’s sales team provide both pre-sales and post-sales support, including advice on:
• New products
• Spare parts
• Repairs.

NOTE: If a product has to be returned for repairs, then it should be accompanied by a
completed Energy product return form, included on page 17-4.

17.4Customer feedback
As part of our continuing commitment to improving customer service, we warmly welcome
your opinions. To provide feedback, complete the Energy customer feedback form on
page 17-7 and return it to Meggitt SA’s main office (see 17.1 Contacting us).
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REPAIRS AND RETURNS

Energy product return procedure

If a Meggitt vibro-meter® Energy product needs to be returned to Meggitt SA, please use the
online product return procedure on the Meggitt vibro-meter® Energy website at:
www.meggittsensing.com/energy/service-and-support/repair

As described on the website, the product return procedure is as follows:
1- Complete and submit online the Energy product return form that is available on the

website (note: * indicates a required field).
For each Energy product to be returned, a separate Energy product return form must be
completed and submitted online.
When an Energy product return form is submitted online, an acknowledgement email
including an Energy product return reference number, will be sent by return to confirm
that the form was received by Meggitt SA.
Please use the Energy product return reference number in all future communications
regarding your product return.

2- Complete and include an end-user certificate.
For each Energy product to be returned, an associated end-user certificate is also
required.
The single-use end-user certificate is recommended for smaller organisations that
handle few products and the annual end-user certificate is recommended for larger
organisations that handle many products.
Either end-user certificate can be used to cover multiple products.

NOTE: Visit the website or contact our Customer support department
(see 17.1 Contacting us) to obtain the appropriate end-user certificate form.

3- Send the Energy product together with printed copies of the acknowledgement email (or
emails) and the end-user certificate (or certificates) to Meggitt SA at:
Energy Repairs, Meggitt SA, Route de Moncor 4, Case postale, 1701 Fribourg,
Switzerland.
A separate acknowledgement email (printed copy) is required for each product to be
returned, although a single end-user certificate (printed copy) can be used for multiple
products.

4- In addition, a purchase order (PO) with a value of CHF 0.00 must also be sent to Meggitt
Switzerland, in order to support the initial problem diagnosis.

NOTE: The Energy product return form reproduced below is included to support the
gathering of information required for completion and submission online.

www.meggittsensing.com/energy/service-and-support/repair
www.meggittsensing.com/energy/service-and-support/repair
www.meggittsensing.com/energy/service-and-support/repair
www.meggittsensing.com/energy/service-and-support/repair
www.meggittsensing.com/energy/service-and-support/repair
www.meggittsensing.com/energy/service-and-support/repair
www.meggittsensing.com/energy/service-and-support/repair
www.meggittsensing.com/energy/service-and-support/repair
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Energy product return form

Contact information

First name:* Last name:*

Job title: Company:*

Address:*

Country:* Email:*

Telephone:* Fax:

Product information

Product type:* Part number (PNR):*

Serial number (SER):

Note: Enter “Unknown” if the serial number (SER) is not known.

Ex product: SIL product:*

 Yes  Yes

 No  No

Meggitt SA purchase order number: Date of purchase (dd.mm.yyyy):

Product under warranty: Site where installed:

 Yes

 No

 Don’t know

End user:
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Return information

Reason for return:*

 Repair

 Out-of-box failure

If the reason for return is “Repair”, please answer the following questions:*

Type of failure: How long was the operating time before failure?

 Continuous

 Intermittent

 Temperature dependent

Description of failure:

Please provide a detailed description in order to help with problem diagnosis.

If the reason for return is “Out-of-box failure”, please answer the following questions:*

Type of out-of-box failure:

 Product damaged

 Incorrect product configuration

 Incorrect product delivered

 Problem with documentation / labelling

 Product dead-on-arrival

Additional information:

Please provide as much information as possible in order to help with problem diagnosis.
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Ex product information – additional information required for Ex products only

Is the product installed in a hazardous area (potentially explosive atmosphere)?:

 Yes

 No

If the product is installed in a hazardous area, please answer the following questions:

How long was the operating time before failure?:

Additional information:

SIL product information – additional information required for SIL products only*
Note: For SIL products used in functional safety contexts/systems, this SIL product information section must be completed.

Is the product installed in a safety-related system?:*

 Yes

 No

If the product is installed in a safety-related system, please answer the following questions:*

Did the system fail** in a safe mode?:* (That is, the safety relay operated but the trip was spurious.)

 Yes

 No

 Not applicable

Did the system fail** in a dangerous state?:* (That is, the failure did not result in the safe state.)

 Yes

 No

 Not applicable

How long was the operating time before failure (in hours)?:*

Additional information:

** A faulty indicator LED is considered as a cosmetic failure.
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FEEDBACK

Energy customer feedback form

Manual information

Title of manual:

VM600 MPS1 configuration software for VM600 machinery protection systems (MPSs)
software manual

Reference: MAMPS1-SW/E Version: Edition 12

Date of issue: February 2021

Customer contact information

First name:* Last name:*

Job title: Company:*

Address:*

Country:* Email:*

Telephone:* Fax:
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Feedback – general

Please answer the following questions:

Is the document well organised?  Yes  No

Is the information technically accurate?  Yes  No

Is more technical detail required?  Yes  No

Are the instructions clear and complete?  Yes  No

Are the descriptions easy to understand?  Yes  No

Are the examples and diagrams/photos helpful?  Yes  No

Are there enough examples and diagrams/photos?  Yes  No

Is the style/wording easy to read?  Yes  No

Is any information not included?  Yes  No

Please include any additional information in the “Feedback – additional” section below.

Feedback – additional

Additional information:

Please provide as much feedback as possible in order to help us improve our product documentation.
Continue on a separate sheet if necessary … 
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